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1 Work with this tutorial

This tutorial is intended to form your skills of making typical simulations using the FlowVision software.; the
tutorial contains the following parts:

1. the first part ("Detailed description of a simplest model") contains a detailed description of all steps of
specifying a project, of carrying out the computation and analysis of the simulation's results. As a
simplest example we selected simulation of a laminar flow in a tube.

2. the second part ("Physical processes") illustrates use of different basic physical processes.
3. the third part ("Advanced modules") illustrates use of additional features.

The most efficient way to learn FlowVision is doing successive exercises (examples) from the tutorial. The
tutorial, using these successive examples, familiarizes you with all main and additional features of FlowVision.

It is highly recommended to start your learning from the section "Quick start" from the "User's guide"
document; then do the successive exercises from the tutorial's sections "Detailed description of a simplest
model" and "Physical processes".

We also recommend you to do all exercises from the section "Advanced modules" or at least those, which are
most close to problems from your field.

For each example use the following materials:
· description of the problem in the tutorial, see appropriate sections of the tutorial
· files with the geometry, which are included in the distribution package of FlowVision (they locates in the

folder Tutorial\Samples\Geom if standard location settings have been used).

· files of client part of the project, which are also included in the distribution package of FlowVision (they
locates in appropriate subfolder in the folder Tutorial\Samples\EnuProjects if standard location

settings have been used).

In exercise projects delivered along with the program sequence of boundary conditions in the project
tree and their colors might differ from those given in the tutorial.

Before you start the exercises, make sure that:
· client and server FlowVision modules have been installed
· License Manager is installed
· the license is obtained and registered
· all settings of License Manager and Solver-Agent are tuned
· Solver-Agent and License Manager are running
· directories for server parts and client parts of projects have been created
· the Solver-Agent's user have been created

(see details in  the "User's guide" document).

Date and time of the document's creation: 12/15/2022, 3:41 PM.
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2 Notation

Notation Quantity Name in FlowVision Dimension

a Sonic speed m s-1

b Initial or entrance flow turbulization Pulsation

CFL Courant number CFL

pC Specific heat capacity m2 s-2 K-1

D Diameter of a tube m

f A scalar variable

k Turbulent energy TurbEnergy m2 s-2

L Length of a tube m

l Initial or entrance turbulence length scale Turbulent length scale,
m

m

a/UM 

The Mach number MachNumber

m Mass of a body kg

p Relative static pressure Pressure N m-2

Pr Molecular Prandtl number

tPr
Turbulent Prandtl number Prandtl







UD
Re

Reynolds number

tSc
Turbulent Schmidt number Schmidt

T Temperature Temperature K

U Characteristic velocity m s-1



u
Friction velocity m s-1

inlV
Entrance flow velocity m s-1

iniV
Initial flow velocity m s-1

y Distance to the nearest wall DistanceToWall m









yu
y Dimensionless distance to the nearest wall Y_plus



Dissipation rate of turbulent energy TurbDissipation m2 s-3



Molecular heat conductivity kg m s-3 K-1



Molecular dynamic viscosity kg m-1s-1

t

Turbulent dynamic viscosity TurbViscosity kg m-1s-1

 / Molecular kinematic viscosity m2 s-1

 /tt
Turbulent kinematic viscosity m2 s-1



Density Density kg m-3

2u




Viscous stress at a wall Shear Stress N m-2
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Notation Quantity Name in FlowVision Dimension



Time step s

kβ

ε
ω

*


Specific dissipation rate of turbulent energy TurbDissipation s-1
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3 Detailed description of a simplest model

This chapter describes in detail all the steps in specifying a FlowVision project, performing calculations, and 
analyzing results. The control settings are defined in Preprocessor, the analysis tools are presented in
Postprocessor.

It is recommended to start your work with this example.
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3.1 Laminar flow in a tube

This exercise teaches you how to create a project, start computations, and analyze results.

A laminar flow of a viscous fluid in a cylindrical tube is considered. 

The laminar flow is characterized by the Reynolds number Re, when it is lower then 103.

Dimensions: 

Length of the tube L = 2 [m]

Diameter of the tube D = 0.1 [m]

Inflow parameters

Velocity on the inlet: V
inl

 = 0.001 [m×s-1]

Substance properties:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1 
×s-1]

Reynolds number: 2inl 10
0.001

10000.10.001

μ

DρV
Re 





Geometry: Tube.wrl

Project: Lam_tube

3.1.1 Computational domain

The geometrical model of the computational domain is created in one of CAD systems and imported into
FlowVision.

The geometric model of the computational domain must satisfy the following requirements:
1. volumes that form the geometric model must be closed
2. volumes are nested in one another and do not intersect

The geometric model is transferred to FlowVision using one by one of the following standard formats:
1. surface mesh: VRML, STL, MESH (internal format)
2. volume mesh, based on which in FlowVision a corresponding surface mesh is built: ANSYS, NASTRAN,

ABAQUS

Fully prepared and painted the geometry of the computational domain is stored in the file Tube.wrl.
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3.1.2 Creating a project

To load the geometry model into FlowVision, apply the File > Create command from the main menu.

The New project dialog box will open:

In this dialog box click the  (Open geometric model) button. A standard operating system's dialog box
for selecting a file will open where you have to select the file, which contains the geometry model  of the
computational domain. Select the Tube.wrl file there.

After that the geometric model will appear in the View window of Pre-Postprocessor, and appropriate
SubRegions will appear in the Project window, in the Preprocessor tab.
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The program loads the geometry of the surface as a set of triangles. After loading the geometry, the triangles
are automatically merged into geometric group.

In order to show Groups in the project tree, specify using the menu command File > Preferences:
Display

Show all groups = Yes



20FlowVision Help

 

List of Group is displayed in a tree in the Preprocessor tab in the folder Region > Subregions >
SubRegion#0 > Geometry > Region - Surface #0.
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The number and boundaries of the groups depend on the geometry format and settings of Pre-Postprocessor.
If geometry format supports color information (eg .wrl), then the triangles of the same color will be merged into

a single group. If the format does not support color information (eg, STL), then the triangles are arranged in
groups according to the magnitude of the Grouping angle. If the angle between the triangles is less than the
Grouping angle, they are combined into one group. This angle is specified by the parameter File >
Preferences > Geometry import > Grouping angle.
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Save the project on the disk using the File > Save command from the main menu or press Ctrl+S on the
keyboard. The Saving the project window where you have to specify the project's name in the New folder
name field and location of the folder with the project's files in the Project location field; then click OK:

The folder with the project's files will be created.

3.1.3 Defining a physical model

To specify a physical model, it is necessary to define:
· Substance
· Phase
· Model
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3.1.3.1 Substance

In this example, a water flow is simulated, so we have to define one substance - water.
In order to specify a new substance, perform the following steps:
· In the Preprocessor tab in the context menu of the Substances folder, select Create.

This will create the Substance #0 folder with appropriate parameters.

· In the Properties window of Substance #0 in the Aggregative state field select Liquid:

· In the folder Substance #0 in the list of the physical properties of the substance you have to specify:

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1 s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

We do not have to specify other parameters, so you can leave them with their default values.
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Note:

The aggregative state determines the list of physical properties, the sonic speed, and the equation of state.

3.1.3.2 Phase

To define the Phase, do the following:
· From the context menu of the folder Phases select Create continuous.

· In Phase #0 in the folder Substances load a previously created substance:
o From the context menu of the Substances folder select Add/Remove

o Select Substance #0 from the list and add it to the phase:
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· In the folder Physical processes in the Properties window select the simulated processes. In this task the
following physical processes are required:
Motion Navier-Stokes model
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3.1.3.3 Model

In order to specify the Model select Create from the context menu of the Models folder.

This will create the Model #0 folder and its subfolders Phases and Phase interaction. In this exercise we
need only one phase. In order to add it to the Model you need in the context menu select Add/Remove and
select Phase #0 from the list.

3.1.4 Defining boundary conditions

Before setting the boundary conditions, it is necessary to specify the model for computational subdomain.
Specify in the Properties window of SubRegion #0 the following parameters:

Model = Model #0
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Boundary conditions are specified for every calculated variable.

In general, the procedure for setting the boundary conditions includes the following steps:

1. Creation boundary conditions

2. Assigning the boundary conditions

3. Setting parameters of the boundary conditions

The initial geometry for this problem was painted during its creation and stored in the .wrl format, which

supports color information. Therefore, when loading the geometry, the program automatically created and
specify the boundary conditions on the surfaces of different colors. By default, all the boundary conditions are of
type Wall.

Changing the properties of boundary conditions is done in the Properties windows of elements of the folder
Boundary conditions in the Preprocessor tab of the project tree: Subregions > SubRegion #N > Boundary
conditions > B. Cond. #N.
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Specify the following parameters in the Properties windows of the boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity (Phase #0) = No slip

Boundary 2

Name = Outlet

Type = Free Outlet

Variables

Velocity (Phase #0) = Pressure

Value = 0

Boundary 3

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity (Phase #0) = Normal mass velocity

Specify the numerical value of the Mass velocity:

Velocity (Phase #0)
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Mass velocity = 1 [kg m-2 s-1]

3.1.5 Defining initial conditions

Initial conditions are intended to define the values ​​of the variables (Init. data) at the initial time in a certain part
of the computational domain (in/on some Object). Specifying Initial conditions in most cases does not affect
the final result of the calculations, but allows faster convergence of the solution and prevents some
disturbances occurring in the process of computation.

The process of creating Initial conditions consists of three stages:

· specifying Initial data

· specifying an Object in/on which the Initial data would be applied

· assigning a correspondence between the Object and the Initial data

Initial condition #0 are always presented in the computational domain, they are the default correspondence
between Init. data #0 and Computational space. Values ​​of all variables in the Init. data #0 are equal to 0.
Therefore, in order to specify the initial conditions corresponding to the undisturbed flow in the whole space, it is
enough to specify Init. data #0 (in the Model #0) with some velocity along the Z axis.

· In the folder Models > Model #0 > Init. data > Init. data #0, in the element Velocity(Phase #0), define the
initial velocity along the axis Z:
Value

Z 0.001

.
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3.1.6 Generation of initial computational grid

The next necessary step is defining of the computational grid.

Computational grid used in FlowVision is:
1. rectangular

2. adaptive local refined 1)

3. with a subgrid resolution of the geometry 2)

Specifying the computational grid in FlowVision is divided into specifying of the Initial grid (the entry level
grid) and the grid adaptation (on a surface and/or in a volume).

In this example, we need to specify a uniform computational grid 20x20x50. To do this, in the project tree in the
Preprocessor tab specify the properties of the element Computational grid > Initial grid:

nX = 20

nY = 20

nZ = 50
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In the Properties window of the Initial grid click Apply.

After you have specified the initial grid, it is displayed in the View window:

Notes:
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1) The adaptation enables resolution of small geometry details of the computational domain and high gradients
of the computed values.

2) geometry resolution allows approximation of curvilinear boundaries on a rectangular grid.

3.1.7 Adaptation of computational grid

Adaptation is splitting or merging of cells of the computational grid up to the specified level in a volume or on a
surface. Splitting up n-th level includes halving the initial grid cells in each direction n times. Merging to the n-th
level involves merging the cells previously split to a level m (where m>n), to the level n.

Adaptation can be specified on the surface of some Boundary condition,as well as on a surface or in a
volume of some Object.

In this exercise, you must specify an adaptation on the boundary condition Wall. To do this, start with creation
the element Adaptation #0 in the folder Computational grid > Adaptation by right-clicking on the element
Computational grid > Adaptation and selecting the Create command from the context menu, which opens:

For the element Adaptation #0 the following information is to be specified:
· a Subregion where the adaptation will act (in our case, the program, for your convenience, will

automatically set use of the adaptation in Subregion #0 because the project contains this Subregion
only)

· and Boundary conditions, on which and near which the adaptation will act.
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If the program does not select the desired Subregion automatically, where the Adaptation will act,
select the Subregion manually. To do this, right-click the element Adaptation > Adaptation #0 >
Subregions and select the Add/Remove command from the context menu, which opens. The Select
Subregions dialog box will open, in which you have to place the desired Subregion into the pane
Selected (using the Add button) and then click OK:

To select Boundary conditions you have (with right-click) open the context menu of the element Adaptation
> Adaptation #0 > Objects and select there the Add/Remove Boundary Conditions command. In the
Select boundary conditions dialog box, which opens, place the boundary condition Subregion #0 : Wall
into the pane Selected and click OK:
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In the Properties window of the element Adaptation > Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 4
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Note:

In order to see the computational grid with adaptation, create a layer Computational grid on the
Computational space. The layer will be displayed after the calculation is done.

3.1.8 Defining control parameters of computation

The final step in the preparation of the project is definition of Simulation controls (parameters that control the
computation).

These settings include: time step, the selection of the scheme for approximation of the equations in space and
in time, the frequency of autosave, etc.

These parameters are specified in the Solver tab of the project tree.

It is assumed that for most problems (except of specially specified) the user does not need to change the
standard Advanced settings. The only thing that you need to specify is the Time step. In FlowVision There
are two ways of specifying the time step: In seconds and Via CFL number (CFL number is the Courant-
Friedrichs-Levy number). In our exercise you can specify the time step in seconds as the constant time step
chosen by the user. In this exercise the characteristic dimension is length of the tube L. The transit time is the
time required for a hypothetical particle moving with the mean flow velocity V, to pass the characteristic
dimension :

200c
0.001

2
*0.1

V

L
*0.1τown 
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3.1.9 Stopping conditions

Stop the computation can be done in two ways:

1. Manually using the  (Stop computation) button 
2. Specifying some Stopping conditions

Stopping conditions are specified prior to the computation in the Solver tab. You can define stop by:
1. At the specified moment of time.
2. After the specified number of iterations.
3. By values of residuals of calculated variables.
4. By values of residuals of user variables (global user values or values from Characteristics).

Residuals characterize the rate of changing the values over time. The smaller are the residuals, the less
is the change of the evaluated values.

The Characteristics element provides access to information about integral values of variables in the volume or
on the surface of an Object. We will use Characteristics to watch the evolution of average pressure on the
inlet and automatically stop the computation at the moment when the average pressure stops changing.

To specify the Characteristics, you have firstly to create an Object for visualization (based on the Inlet
boundary condition). To do this, select, in the Preprocessor tab, in the context menu of the boundary
conditions Inlet, the Create supergroup > In Preprocessor command:
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Then in the folder Objects in the context menu of the created Supergroup select the Create characteristics
command, and then, in the Create new characteristics block dialog box, which opens, click OK:
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By default, no variable is specified on the Characteristics and so the Characteristics do not contain the main
body of data. In order to fill the Characteristics with information, specify a variable in properties of
Characteristics #0:

Variable > Variable = Pressure
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In order to specify the stopping conditions:

· in the Solver tab, from the context menu of the folder Stopping conditions > User values, select Create:

· in the Properties window of the new just created Stop criterion #0 specify:

Level = 0.00001

Object = Characteristics #0 (Supergroup on "Inlet")

Variable*) = <f surf.>

*) This field will appear after you specify Object = Characteristics #0 (Supergroup on "Inlet").

The <f surf.> value equals to the average value of the Variable selected in the Characteristics at the surface
or in the volume of the Object, on which the Characteristics was created. In this exercise <f surf.> is the
average Pressure on the surface of the Supergroup, which was created in the boundary condition Inlet.

The Level value is the threshold value of the residual for the selected user value (<f surf.>). When the residual
of the user value becomes less then the specified Level, the computation stops.

Note:
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In many further exercises stopping conditions are not set. In such cases the computation is stopped manually
at any desired time by the user's decision.

3.1.10 Starting the computation

You can start the project's computation from Pre-Postprocessor or fromTerminal.

In this exercise, start from Pre-Postprocessor is described. Solver-Agent and license server are to be
running.

To start the computation, you have to authorize on Solver-Agent (see details in the user documentation of
FlowVision in the section "Connection to Solver-Agent and user authentication on Solver-Agent"). This
authentication can be done automatically by the program at start of Pre-Postprocessor; in the case if the
authentication was not done automatically, follow these steps:

· Click the  (Solver agent log in) screen button in the Network toolbar.

· If the required Configuration for connection to Solver-Agent has not been set yet, set it as described in the
user documentation of FlowVision in the section "Connection to Solver-Agent and user authentication on
Solver-Agent". If no Configuration is set, an empty Solver agent connection configurations dialog box
will open immediately:

In this dialog box you have to create at least one Configuration. Enter data into fields (the Password field
can be left blank), select the Use by default checkbox, and then click the Save screen button:
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Then click OK.

For Configuration, which will be used most frequently, we recommend to select the Use by default
checkbox to enable automatic authentication on Solver-Agent at each start of Pre-Postprocessor.

If saving the password is undesired (when you need manual entering the password at each
authentication on Solver-Agent), leave the Password field blank.

· The Solver agent connection dialog box will open where you have to select a Configuration for connection
to Solver-Agent, and then click OK:

To connect to a Solver, you have to:

· Click the button  (Open solver selection window) in the Network toolbar. The Select solver dialog
box will open:
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· In this dialog box click the  Start computation screen button in the New solver launch group of
interface elements.

· The program will prompt you to upload your project on the Solver:

Project files will be located in two directories: Client and Server. The Client directory contains the client part
of the projects - the parts, which are opened in Pre-Postprocessor. The Server directory contains the server
part of the project - the parts, which are loaded on the solver. The client part of the project appears when you
create a project in Pre-Postprocessor. At the same time the client directory is determined. The server part of
the project appears in the Server directory after the first upload of the project to the solver. The server
directory is specified when a user is registered on Solver-Agent.

If necessary, you can open the dialog box with the Solver-Agent's registration information, using the button 
 (Edit solver agent user information) in the Network toolbar after authorization on Solver-Agent.
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Client and Server directories must not:
· be the same
· be nested to each other
· be the same as the installation directory
· be nested to the installation directory.

The computed results are stored in server part of the project. You can see the results of the computation in
Pre-Postprocessor only if the project is opened in Pre-Postprocessor, Pre-Postprocessor is connected to a
Solver synchronized with the Solver. 

If necessary, the Server directory can be changed. However, you should remember that after that change all
the results of computations that were in the old Server directory will no longer be available after connection of
Pre-Postprocessor to Solver unless you have manually copied them to new directory.

Then the Starting solve dialog box will open:

Click there OK, this will start the project's computation.

After this you can stop and resume the computation using buttons  (Stop computation) and  (Start
computation) in the Network toolbar.

Before starting the computation we recommended that you specify Visualization to see the results of
computation in dynamics.

3.1.11 Visualization

Visualization of the results of the computation is performed in Postprocessor.

Visualization of the computation results are only available if the project is opened in Pre-Postprocessor and
loaded on a Solver.

Pre-Postprocessor and Solver must have connection between them.
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Postprocessor provides the user with the following capabilities:
1. A set of standard methods of flow visualization in the View window
2. Interactive tuning of visualization parameters
3. Displaying integral values of variables in the View window
4. Indication of the visualization method in a separate Information window

To display the results of computation in Postprocessor you have to:
· create and configure the corresponding object
· create a layer or characteristics of required type on the object
· select a variable and define the necessary settings of the layer or characteristics

Elements for visualization the results of the computation should be chosen depending on the type of data,
which are to be displayed:

Data Type Name of the element

Integral values:

Value of a variable on a surface and in a volume Characteristics

Local values:

Local values of a scalar variable along a line Plot along line

Plot along curve

Plot along ellipse

Local values of a scalar variable at a surface Color contours

Local values of a scalar variable in a volume Isosurface

Local values and directions of vector variable on a surface or in
a volume

Vectors

Streamlines

For long-term computations we always recommend you to visualize data during the computation, as in this
case you can permanently control over the process of convergence of the solution and, if necessary, intervene
in the process of computation when the solution becomes numerically unstable.

3.1.11.1 Charachteristics (pressure variation)

To display information about the value of the pressure on inlet, you can use the element Characteristics,
created earlier to define a Stop criterion. Information from Characteristics is displayed in the Info window and
recorded into a text file. Recording the information into a text file allows you to monitor changing the variable
over time.

In order to record the contents of the Characteristics into the file, open the tab Postprocessor and specify in
the Properties window of Characteristics #0:

Save to file

Type = Automatic

After the computation is done, the Characteristics become informative.

To open the Info window, select Characteristics #0 in the project tree in Pre-Postprocessor and click on the

button  (Show info window for selected object) in the Work modes toolbar*).

All data from the Info window is stored in a text glo-file, which can be exported into Excel to plot the dynamics

of values variation. By default the glo-file is saved into project directory in the server directory of the user. In

order to download the glo-file from the server directory to the client directory, do the following: 

· in the File menu, select Download additional files

· in the Project download window, which opens, select GLO files
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To start Windows Explorer, which opens the client directory of the current project, use the menu command File
> Open Explorer.

In order to plot the variation of the pressure on inlet over time in any third-party graphics editor (Microsoft Excel,
Grapher, etc.), do the following steps:

· open or import the recorded glo-file in the appropriate graphical editor

· plot variation of Avg*) over Time



46FlowVision Help

 

Since a Stop criterion was created based on the <f surf.> *) variable, its variation can be displayed directly in
Plot tab of the Monitor window of Pre-Postprocessor:

Note:

*) Variable <f surf.> in the Info window and in the Stop criterion and variable Avg in the glo-file correspond to

the average value of Pressure on Inlet.

3.1.11.2 Plot along line (pressure distribution)

The layer Plot along line allows you to display the distribution of the scalar variable along the selected line as
a plot.

In this exercise, we will use the layer Plot along line on a Line object to visualize the distribution of pressures
along the tube axis.

Create in Postprocessor a Line object for visualization:

· from the context menu of the folder Objects in Postprocessor select Create

· the Create new object dialog box will open, select there Object type = Line
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In the Properties window of the created object Line #0 specify:

Object

Reference point

X 0

Y 0

Z 0.001

Direction

X 0

Y 0

Z 1

Create in Postprocessor a layer Plot along line on Line #0:

· in the context menu of Line #0 select Create layer

· specify Layer type = Plot along line
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In the Properties window of the layer Plot along line, specify:

Variable

Variable Pressure

In order to increase the number of points on which the plot is built, specify:

Number of points = 100
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3.1.11.3 Vectors (velocity distribution)

The layer Vectors visualize a vector field. The direction of the vector coincides with the direction of the vector
field at the starting point of the vector and the vector length is proportional to the modulus of the field at this
point.

In this exercise, we will use the layer Vectors on a Plane in order to visualize the vector field of velocity in the
plane of the flow.

In order to the layer do not obscure the geometry, specify:

· in properties of Plane #0 in the Postprocessor specify:

Clipping object = Yes

· in properties of the layer Solids specify:

Clipped = Yes

Create a layer Vectors in the Plane #0:

· in the context menu of the Plane #0 select Create layer

· at creating the Layer, specify Layer type = Vectors

In theProperties window the program will automatically specify, what a variable will be used to build the Layer:

Variable > Variable = Velocity

In the View window a visualization of the velocity distribution in the plane of the flow will appear:

To increase number of vectors in the direction along the tube, specify in properties of the layer: Grid > Size 2 =
50.

(by default, in properties of the layer the following parameters were set: Grid > Size 1 = 11 and Grid > Size 2
= 11)

To paint the vectors with their absolute values and display the legend to this palette, specify in properties of the
layer:

Coloring > Variable > Variable = Velocity
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Coloring > Palette > Appearance > Enabled = Yes
Coloring > Palette > Appearance > Style = Style 1

3.1.11.4 Color contours (distribution of velocity's modulus)

The Color contours layer visualizes the distribution of a scalar variable using color transitions.

This example illustrates use of a layer Color contours for visualization of the value of velocity in the plane of
the circular cross section of the tube.

In Postprocessor create a Plane for visualization:

· from the context menu of the folder Objects in Postprocessor select Create

· in the Create new object dialog box select Type = Plane

In the Properties window of the new just created Plane #1, click on the button  to direct the plane's normal
along axis Z.

Create a layer Color contours on the Plane #1:

· in the context menu of the Plane select Create layer

· specify Layer type = Color contours

In properties of the new Color contours layer specify:
Variable > Variable = Velocity
Palette > Appearance > Enabled = Yes
Palette > Appearance > Style = Style 1
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Note:

If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus:
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4 Physical processes

The examples of this chapter demonstrate how to model:

· Motion of fluid

· Heat transfer

· Turbulence

· Mass transfer

· Free surface

· Dispersed media

· Radiation

· Electrodynamics
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4.1 Motion of fluid

In order to simulate the laminar flow of the liquid, it is necessary:

· In properties of the Substance specify Aggregative state = Liquid.

· In properties of the Substance you have to specify values of the Molar mass, Density, Specific heat
capacity and, if necessary, the Viscosity.

· Enable computations of equations of Motion.

· Specify the appropriate initial and boundary conditions for the velocity and pressure.

In order to simulate the laminar flow of gas at Mach number less than 0.3, it is necessary:

· In properties of the Substance specify Aggregative state = Gas.

· In properties of the Substance you have to specify values of the Molar mass, Density, Specific heat
capacity and, if necessary, the Viscosity.

· Enable computations of equations of Motion.

· Specify the appropriate initial and boundary conditions for the velocity and pressure.

In order to simulate the laminar flow of gas at Mach number greater than 0.3, it is necessary:

· In properties of the Substance specify Aggregative state = Gas.

· In properties of the Substance you have to specify the computation of the Density by the ideal gas law, the
Molar mass and Specific heat capacity, and, if necessary, the values of Viscosity and Thermal
conductivity.

· Enable calculation equations of Motion and Heat transfer.

· Specify the appropriate initial and boundary conditions for the velocity and pressure. In the simulation of flow
around bluff bodies it is desirable to specify some initial conditions around them corresponding to the
parameters of flow deceleration.

· When simulating movement at Mach numbers greater than 1 it is recommended to specify constraints for the
computation.

4.1.1 Laminar flow around circular cylinder

In this exercise we consider an external flow around a cylinder by a laminar flow. As we are interested in
parameters of the flow in the cross section only, let us assume that length of the cylinder is infinite. Using this
approach, it is possible to simulate the problem in a 2D setting.
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Dimensions:

Cylinder diameter d = 0.02 [m]

Flow parameters:

Velocity V = 0.008 [m×s-1]

Substance properties:

Density r = 1.25 [kg m-3]

Viscosity m = 2 10-5 [kg m-1 
×s-1]

Reynolds number:
10

μ

Vdρ
Re 

Geometry: Cylinder_lam.wrl

Project: Cylinder_lam

4.1.1.1 Computational domain

The geometry model for simulating external flow is a limited spatial area around a material body. Sizes of the
area are specified depending on specifics of the problem. For example, when external subsonic (the Mach
number is below 1, M<1) flow around a material body is simulated, it is recommended to place outer
boundaries of the computational domain at a distance at least 10 times more then specific body size so that
flow disturbances, which appear near the body, do not reach limits of the computational domain.
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Computation in FlowVision is always carried out in three-dimensional geometry space. So you can specify
some small thickness of the geometry model to simulate the problem in 2D setting. To do so when you prepare
the geometry in a CAD system, you have to:

1. create a two-dimensional sketch of the geometry of the computational domain in the plane XY
2. specify a constant thickness of the geometry in the direction Z (apply extending along this direction).

The geometry model of the computational domain, which is fully prepared to the further work, is stored in the file
Cylinder_lam.wrl.

4.1.1.2 Physical model

Specifying the physical model (Substances, Phases, and Models) is done in the Preprocessor tab. Follow
these steps there:

In the folder Substances:

· Create Substance #0

· Specify the following properties of the Substance #0:

Aggregative state = Gas *) 

Molar mass

Value = 0.0289 [kg mole-1]

Density

Value = 1.25 [kg m-3]

Viscosity

Value = 2e-5 [kg m-1 s-1]

Specific heat

Value = 1009 [J kg-1 K-1]
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In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0

· Add Phase #0 into subfolder Model #0 > Phases

· Specify in the folder Init. data > Init. data #0:

Velocity ​​(Phase #0)

Value > X = 0.008 [m s-1]

Note:

*) A gas moving with speed V < 0.17 M (which has the Mach number less then 0.17), behaves as an
incompressible liquid with constant density, so the simulation of its motion can be defined with either
Aggregative state = Gas or Aggregative state =  Liquid.

4.1.1.3 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:
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Boundary 1

Name = Wall

Type = Wall

Variables

Velocity ​​(Phase #0) = No slip

Boundary 2

Name = Symmetry

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

Boundary 3

Name = Outlet

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

Boundary 4

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Specify the numerical value of the Mass velocity:

Velocity (Phase #0)

Mass velocity = 0.01 [kg m-2 s-1]

4.1.1.4 Initial grid

In this example, in order to better resolve the flow near the cylinder, it is necessary to specify a two-
dimensional non-uniform initial computational grid, condensed near surface of the cylinder. To build such grid,

use the Initial grid editor, which is called by the  button from the Properties window of the element
Computational grid > Initial grid of the project tree:
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As simulating of the flow will be done in a 2D setting, parameters of the flow are calculated only in two
directions (X and Y), and along the third direction (Z) the computational domain will be resolved only by one cell
and parameters of flow will not change along Z.

Creating a non-uniform grid with condensing

To specify in the Initial grid editor a non-uniform computational grid for OX, follow these steps:

· Specify the following values in the group of settings Grid parameters 1) :

h_max = 0.03 [m]
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h_min = 0.001 [m]

· Insert the reference line with the coordinate x = -0.015 [m]:

o In the Add reference line group of settings, specify Position = -0.015.

o Click the button  (Add a reference line with the selected position). After this the new

reference line will appear in the graphical pane of the Initial grid editor and in the Position field in
the Add reference line group of settings the default value -0.1075 will appear, which would be used
for another reference line, in the case if it would be added.

· Specify parameters of reference lines 2) :

o in the graphical pane of the Initial grid editor select the line with coordinate x =-0.2 [m] (the leftmost line)

o in the group of settings Reference line parameters specify:

h = 0.03 [m]

(don't change h if it already has this value)

o in the graphical pane of the Initial grid editor select the line with coordinate x =-0.015 [m] (the middle line)

o in the group of settings Reference line parameters specify:

h = 0.001 [m]

kh- = 1

kh+ = 0.9

o in the graphical pane of the Initial grid editor select the line with coordinate x =0.4 [m] (the rightmost line)

o in the group of settings Reference line parameters specify:

h = 0.03 [m]

(don't change h if it already has this value)

kh- = 0.5
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To specify in the Initial grid editor a non-uniform computational grid for OY, follow these steps:

· Click the button , to switch the editor to defining the grid across the Y axis.

Specify the following values in the group of settings Grid parameters 1):

h_max = 0.03 [m]

h_min = 0.001 [m]

· Insert the reference line with the coordinate y = 0 [m]:

o set Insert = 0

o click on the Insert button

o In the Add reference line group of settings, specify Position = 0. (don't change Position if it already

has this value)

o Click the button  (Add a reference line with the selected position). After this the new

reference line will appear in the graphical pane of the Initial grid editor and in the Position field in
the Add reference line group of settings the default value -0.1 will appear, which would be used for
another reference line, in the case if it would be added.

· Specify parameters of reference lines 2) :

o in the graphical pane of the Initial grid editor select the line with coordinate y =-0.2 [m] (the leftmost line)

o in the group of settings Reference line parameters specify:

h = 0.03 [m]

(don't change h if it already has this value)

kh+ = 1.5

o in the graphical pane of the Initial grid editor select the line with coordinate y = 0 [m] (the middle line)

o in the group of settings Reference line parameters specify:

h = 0.001 [m]

kh- = 1.2
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kh+ = 0.8

o in the graphical pane of the Initial grid editor select the line with coordinate y = 0.2 [m] (the rightmost line)

o in the group of settings Reference line parameters specify:

h = 0.03 [m]

(don't change h if it already has this value)

kh- = 0.5

Then click the OK button.

Note:

1) Entering a value into a numerical field occurs when you press the Enter key on the keyboard, when the

cursor locates in the field, or also when you relocate the cursor into another input field.

Transforming the 3D grid to a 2D grid

When you finish your work with the Initial grid editor, the program will create a uniform grid in the direction OZ
consisting of 11 lines by default (with 10 cells). To create the required 2D setting, you have to specify the OZ
direction as non-computational. To do so, in properties of the specify in Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

After this, a locked nZ=1 value will be automatically set in properties of the Initial grid. For so long as Grid
structure = 2D and Plane = XY are specified, the value of the nZ parameter is 1 and cannot be changed.

Specifying Grid structure = 2D and Plane = XY prevents applying of adaptation in the direction OZ (when the
grid is 3D, i.e. when Grid structure = 3D, adaptation splits the cells to 8 portions, into halves along each
direction OX, OY, OZ). When Grid structure = 2D and Plane = XY, the grid will become non-computational
along axis OZ (it will always have only one cell along this axis).

Specifying a non-computational direction blocks adaptation of cells along this direction so this allows to
substantially economize the number of computational cells.

Visualization of the Initial grid
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The resulting Initial grid is displayed:
· in Preprocessor, when the Computational grid > Initial grid element is selected in the project tree
· in Postprocessor by the Initial grid layer. The Initial grid layer is created automatically at creating the

initial grid in Preprocessor.

To color the grid lines in black, specify Lines > Color = Black in properties of the Initial grid layer in
Postprocessor.

4.1.1.5 Adaptation of the computational grid

In this example, you have to solve the boundary layer around the cylinder and a vortex shedding zone behind
the cylinder. For this it is necessary to make an adaptation of the grid in the volume of a box around the
cylinder (see details in sections "Splitting and merging cells of grid" and "Adaptation" in the documentation of
FlowVision.).

Specifying grid adaptation in an object consists of two steps:
1. Specifying the object of adaptation
2. Specifying the adaptation criteria

To specify the object of adaptation, follow these steps:

· In Preprocessor tab, in the context menu of the Objects folder, select Create

· In the Create new object window select Object type = Box
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· In the Properties window of the Box #0 specify:

Location

Reference point

X = 0.01 [m]

Y = 0 [m]

Z = 0.005 [m]

Size

X = 0.05 [m]

Y = 0.04 [m]

Z = 0.01 [m]

Create the element Adaptation #0 and specify its parameters:

· From the context menu of the folder Computational grid > Adaptation, select the Create command:

· From the context menu of the element Computational grid > Adaptation > Adaptation #0 > Objects
select the command Add/Remove Objects and in the Select objects dialog box, which opens, place Box
#0 into the pane Selected and click OK:
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· In the Properties window of the new created element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Split/Merge = Split

Layers

Layers for Level N = 4

Note, that in the Properties window of the element Computational grid > Adaptation > Adaptation #0 >
Objects > Box #0 it is set Parts > Select = Volume, which means adaptation within the volume of the
geometry object Box #0.

As in this exercise there is only one Subregion, you don't have to add SubRegion #0 into the folder
Computational grid > Adaptation > Adaptation #0 > Subregions using the  Add/Remove
command from the context menu; SubRegion #0 is added to this folder automatically at creation of
Adaptation #0.
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In order to see the computational grid with adaptation, create a layer Computational grid on the
Computational space. The layer is displayed after its computation is done.

4.1.1.6 Parameters of calculation

Specify the properties of the time step in the Solver tab of the Project window (Solver > Time step):

Method = In seconds

Constant step = 0.25 [s]

4.1.1.7 Stopping conditions

In this example we recommend that you specify stopping condition based on the X-component of the force
acting on the surface of the cylinder.

Create Characteristics:

· In the Preprocessor tab, create a Supergroup on the surface of the boundary condition Wall using the
command Create supergroup > In Preprocessor from the context menu of the boundary condition's item in
the project tree.

· Create Characteristics on the new just created Supergroup on "Wall".

· In properties of Characteristics #0 specify: Variable > Variable = Pressure.

Specify a Stop criterion:

· in the Solver tab, from the context menu of the folder Stopping conditions > User values, select Create.

· In the Properties window of the new just created Stop criterion #0 specify:

Level = 1e-6

Object = Characteristics #0 (Supergroup on "Wall")

Variable = F fluid

Component = X

4.1.1.8 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. The dynamics of the X-component of the force, which acts on the cylinder's surface.

2. Velocity distribution in the plane of the flow.

3. Pressure distribution on the surface of the cylinder.
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4.1.1.8.1  Force variation

View the dynamics of X-component of the force acting on the cylinder, on the Plot tab in the Monitor window.

4.1.1.8.2  Velocity distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1
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(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· On Plane #0 create a Vectors layer and in its properties specify:

Grid

Size 1 = 100

Size 2 = 100

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 0.01

Min = 0

Palette

Appearance

Enabled = Yes

Color = Black

Note, that the program will automatically specify in the Properties window the variable, which is used to
build the vectors, Variable > Variable = Velocity.

4.1.1.8.3  Pressure distribution

· Create a layer Color contours on Supergroup on "Wall".

· In the Properties window of the new Color contours layer, specify:

Variable
Variable = Pressure

Shift = 0.0001
Value range

Mode = Manual
Max = 6.5e-5
Min = -4.5e-5



68FlowVision Help

 

Palette
Appearance

Enabled = Yes

Note: If you wish to hide some layers or objects displayed in the View window, use the Hide command from
their context menus.

4.1.2 Time-varying flow in a tube

Axi-symmetric laminar water flow with variable inlet velocity is considered in the given example.

Dimensions: 

Length of the tube L = 0.5 [m]

Diameter of the
tube

D = 0.04 [m]

Inflow parameters:

Velocity on inlet:




























1000

t2
sin2005.0Vinl

[m s-1]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1 s-1]

Reynolds number:
004

0.001

10000.040.01

μ

DρV
Re inl







Geometry: a sector of a cylinder that will be created by means of FlowViwion

Project: Tube_VarMassFlow

4.1.2.1 Computational domain
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In order to simulate the axisymmetric flow you should create a computational domain consisting of a sector

with a small opening angle (e.g., 1-2 degrees)*).

There are the following methods of specifying the computational domain in FlowVision:
· Loading parametric geometry models created in external CAD software (this method is used in previous

exercises)
· Creating a geometry model immediately in FlowVision (this method is used in this exercises) either in the

Preprocessor tab (as described below in this exercise) or in the Geometry tab (as described in the Natural
convection exercise).

Create an empty FlowVision project using the File > Create command from the main menu.

The New project dialog box will open:

In this dialog box click the  (Create empty project) button. An empty project will be created with the
Geometry tab opened.

To create the computational domain, follow these steps in the project tree in the Preprocessor tab:

· In the Objects folder create Cone/cylinder #0 (select Create from the context menu of the folder
Objects and in the Create new object dialog box set Object type = Cone/cylinder).

· In properties of Cone/cylinder #0 specify:

Parameters

Height = 0.5 [m]

Radius 1 = 0.02 [m]

Radius 2 = 0.02 [m]

Base ratio = 1

Sector

      Arc start = -1 [degree]

      Arc angle = 2 [degree]

Approximation

Subdivisions = 9

Per sector = Yes

· Click Apply in the Properties window of Cone/cylinder #0.

· In the project tree open the context menu of Cone/cylinder #0 and select there the command Build
into the main geometry:
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After this SubRegion #0 will appear in the folder Subregions. Geometry of SubRegion #0 presents a

sector of the tube with opening angle of 2 degrees and symmetrical relating to the plane XY (1 degree
to the left and 1 degree to the right from the plane XY).

Notes:

*) Further, when specifying the project you have to:

1. When you specify Boundary conditions on the surfaces of the planes of symmetry, specify boundary
conditions Symmetry.

2. When you form the Initial grid, specify a non-computational direction as Z.

The computational domain can also be set in the Geometry tab, see description in the exercise
Natural convection, section Creating the computational domain in the "Geometry" tab.

4.1.2.2 Physical model

Do the following steps in the tree of the Preprocessor tab:

In the folder Substances:

· Create Substance #0

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1 s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· Add Substance #0 into the folder Phase #0 > Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0
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· Add Phase #0 into the folder Model #0 > Phases

· Specify in the folder Model #0 > Init. data > Init. data #0:

Velocity ​​(Phase #0)

X = 0.01 [m s-1]

4.1.2.3 Boundary conditions

In the Properties window of the SubRegion #0 specify:

Model = Model #0

When after your import of geometry the amount or arrangement of boundary conditions differ from those
desired, you should to specify the boundary conditions manually. Definition of boundary conditions consists of
3 steps:

1. Create boundary conditions

2. Place the boundary conditions

3. Specify parameters of the boundary conditions

To create a new boundary condition, select Create in the context menu of the Boundary conditions folder:

The Boundary conditions are placed on Groups. There are two ways of placing the Boundary conditions:

1. either in the View window

2. or in the Geometry folder

In order to place a Boundary condition on a Group in the View window do the following:

· switch to the Selection mode by clicking on button 
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· select the appropriate Group in the View window

· in its context menu select a Boundary condition > B. Cond. #N

In order to place a Boundary condition on a Group in the Geometry folder do the following steps:

· apply the menu command File > Preferences and specify:
Display

Show all groups = Yes

· in the Properties of the respective Group in the folder Geometry > Region - Surface #0 specify:
Boundary condition =B. Cond. #i

In this project, set the following boundary conditions:

Boundary 1

Name = Wall
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Type = Wall

Variables

Velocity ​​(Phase #0) = No slip

Boundary 2

Name = Symmetry

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

Boundary 3

Name = Outlet

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

Boundary 4

Name = Inlet

Type = Inlet/Outlet

Variables

      Velocity ​​(Phase #0) = Normal mass velocity

To set the Velocity variable on the Inlet do the following steps:

· In the Properties window of the boundary conditions for Velocity on Inlet change the type of entered value
from Constant to Formula:

· Click on the button , which opens the Formula editor:
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· Make an identification of the variable Time:

o In group of settings Variables & constants (on the tab All) expand item Integral > Internal

characteristics > Current time and double click on it.

o In the Variable identification window that appears, specify the name of the variable as "Time".
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· Make an identification of the constant PI:

o In group of settings Variables & constants (on the tab Constants) select Pi number and double

click on it.

o In the Constant identification window that appears, specify the name of the variable as "PI".

· In the Formula editor, specify the formula in the Formula pane:



























1000

Time*PI*2
sin2*5
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· In the Formula editor click Accept.

· In the Properties window of the boundary conditions for Velocity on Inlet click Apply.
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4.1.2.4 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 100

nY = 20

In the Properties window of the Initial grid click Apply.
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To use a sectoral axially symmetric geometry model in 2D setting, the model is to meet the following
requirements:

· The geometry model is to be symmetrical relating to the plane that is perpendicular to the non-
computational direction.

· The sector's angle β is to be ≤10 degrees.
· On the faces, which are oriented across the non-computational direction, boundary conditions of

types Symmetry or Connected are to be set.

4.1.2.5 Parameters of calculation

In the Solver tab, in properties of the Time step element, specify:

Method = In seconds

Constant step = 10 [s]

If you specified the non-computational direction not by using parameter Grid structure (or parameter
2D direction in versions FlowVision 3.12.02 - 3.12.04) but by specifying the number of cells as 1
along the non-computational axis instead (as it was practiced in FlowVision 3.11.01 and earlier
versions), you should have to use the relative criterion of small cells (specify Small Cells > Criterion
= Relative in properties of the element Limiters > Limiters for calculation > Phase Limiters >
Phase #N in the project tree, in the Solver tab).

In versions FlowVision 3.11.02 and higher, when a non-computational direction is set for simulations
in narrow sectors, you should not change the default (Absolute) criterion of small cells. 

4.1.2.6 Stopping conditions

You can use Stop criteria to visualize variation of a variable:
· in the Plot tab of the Monitor window
· and/or in the textual title in the View window (this is set in the Postprocessor tab, in properties of the root

folder 3D-scene by the Title > User values > [N] > User stopper parameter).

In cases when a Stop criterion is used for visualization only, you should not change the default zero
value of its Level parameter.

A Stop criterion, for which Level=0 is set, will never come into action and will not stop the project's
computation but nevertheless it can be used for visualization.

In this exercise we will create Stop criteria to visualize dynamics of:
· Mass flow rate at the outlet (at the current step)
· Total mass flow at the outlet (for all the time of the computation)

Mass flow rate at the outlet at the current step
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Let's start from creating Characteristics on the boundary conditions Outlet:
· In the project tree, in the Preprocessor tab, right-click the Subregions > SubRegion #0 > Boundary

conditions > Outlet element.
· From the context menu that opens, select Create supergroup > In Preprocessor. A new object,

Supergroup on "Outlet" will be created in the Objects folder.
· Open the context menu of Supergroup on "Outlet" and select there the Create characteristics

command there. Create a new block of characteristics by the Velocity variable.

Create a Stop criterion:
· In the Solver tab open the context menu of the folder Stopping conditions > User values and select the

Create command. A new element, Stop criterion #0 will appear in this folder.
· In properties of the just created Stop criterion #0 specify:

Object = Characteristics #0 (Supergroup on "Outlet")

Variable = Mass flow-

Sign in the name of the Mass flow variable (either "-" or "+") is specified based on direction of the normal to the
surface of the Outlet boundary condition. The positive direction of the normal is directed inside the
computational domain, so the mass flow that flows outside from the computational domain corresponds to the
Mass flow- variable.

Total mass flow at the outlet (for all the time of the computation)

To provide time integrating of the mass flow on the outlet we will create two global User variables.

One of these User variables will store the total mass flow from the previous time step, and the other User
variable will be used to calculate the cumulative mass flow.

Qi = prev(Q)+ qiτi = Q i-1
 + qiτi

where:

qi is the mass flow, [kg/s], that flows outside the tube at the computational step i 

τi is duration, [s], of the time step at the computational step i 

Qi is the integrated (cumulative) mass flow, [kg], at the computational step i 

In the Preprocessor tab:
· Open the context menu of the folder User variables > Global and select the Create > Scalar command.

A new scalar variable UGV #0 will appear in the folder User variables > Global.
· Similarly create another global scalar value, UGV #1.
· Rename the variables UGV #0 and UGV #1 as prev_massflow and sum_massflow.
· Specify values of the variables prev_massflow and sum_massflow in the Formula editor:
o The variable prev_massflow specify by the formula prev(sum_massflow).

o The variable sum_massflow specify by the formula MassFlowN0*TimeStep+prev_massflow.
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Specifying the formula for prev_massflow
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Specifying the formula for sum_massflow

Create Stop criterion #1 by selecting the Create command from the context menu of the folder Stopping
conditions > User values and in properties of the Stop criterion specify:

Object = sum_massflow

4.1.2.7 Visualization

Viewing dynamics of the solution during the computation is described in sections below:
· Plots of mass flow
· Displaying text in the View window
· Velocity distribution in the plane of the flow.

4.1.2.7.1  Plots of mass flow

When the project is running, you can watch, in the Plot tab in the Monitor window, plots of Stop criteria that
were created before:

· Stop criterion #0 corresponds to the mass flow rate at the outlet at the current step.
· Stop criterion #1 corresponds to the total mass flow at the outlet calculated cumulatively for all the time of

the computation.

When the  screen button is pressed, these plots will be displayed in logarithmic scale for ordinates.
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Plots of dynamics of Stop criterion #0 and Stop criterion #1 in the Monitor window

Plots of the same Stop criteria displayed in logarithmic scale for ordinates (the  button is pressed)

4.1.2.7.2  Displaying text in the View window

In dynamic simulations, to display the calculated results as texts in the View window in the real-time mode,
you can use group of parameters Title > ... in properties of the root element 3D-scene in the Postprocessor
tab of the project tree.

In properties of the root element 3D-scene specify:

Show title = Yes

Title*)

     Text = Time-varying flow in a tube

     Show time = Yes
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     Show step number = Yes
*) Parameters Title > ... will be available after specifying Show title = Yes.

Short description of the project, time and step number will appear in the View window.

Also specify displaying in the Title values of mass flow on the outlet on the current time and cumulative mass
flow. These values will be taken from Stop criteria that were created before.

For displaying dynamic values of Stop criterion #0 and Stop criterion #1 create two elements in the User
values array. To do so, select in the Properties window of the 3D-scene root folder the Title > User values

line and click twice there the screen button  (Append item to the array). Child groups of parameters [0]
and [1] will appear in the User values array.

Specify parameters in the Title > User values > [0] group:

Line begin = Mass flow at the outlet

User stopper = Stop criterion #0

Line end = kg/sec

Specify parameters in the Title > User values > [1] group:

Line begin = Cumulative mass flow at the outlet

User stopper = Stop criterion #1

Line end = kg

You can move the Title within the View window. Change location of the Title by specifying in properties of the
3D-scene root folder:

Title > Location > Horiz. shift = 0.25

Here is an example of the Title when the project is running:

4.1.2.7.3  Velocity distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0

· In the Properties window of the Vectors specify:

Grid

Size 1 = 50

Size 2 = 11

Coloring

Variable

Variable = Velocity
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Palette

Appearance

    Enabled = Yes

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

During the computation, the View window will display distribution of velocities at the current time moment. As
the flow is non-stationary, so the displayed distribution does not correspond to the flow at other time moments.
The View window will also contain a legend with matching the coloring to values of velocity and a title, which
has been specified before, with information about the current mass flow.

4.1.3 Flow in clearance - use of the Gap model

In this example we consider simulating of flow in a narrow two-dimensional channel using the Gap model.

The Gap model is used in conjunction with a given model of the flow and is designed for taking into account
the resistance created by a narrow channel. The Gap model avoids resolution of the narrow channel by the
grid. The Gap model is only applied in cells of the gap. The gap cells are cells, which locate between two 'gap-
bounding' surfaces. Surfaces are 'gap-bounding' when the distance between them does not exceed the
specified maximal gap clearance. The gap cells are identified by FlowVision automatically.
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Geometry Gap_Channel.wrl

Project Gap_Channel

4.1.3.1 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value = 0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· Specify in the Properties window of Model #0:

Use Gap model = Standard Gap model
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4.1.3.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundaries 1 and 2
(You have to create two different boundary conditions, both of them has type "Wall")
Boundary 1 is the upper wall, and boundary 2 is the lower wall.

Type = Wall

Variables

Velocity ​​(Phase #0) = No slip

Boundary 3 (set on the large side faces)

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

Boundary 4 (input)

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Specify the numerical value of the Mass velocity:

Velocity (Phase #0)

Mass velocity = 10 [kg m-2 s-1]

Boundary 5 (outlet)

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]
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4.1.3.3 Initial grid

In this example in order to better resolve the flow in the channel area, it is necessary to specify a two-
dimensional non-uniform computational grid, condensed near the channel.

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.00025 [m]

h_min = 0.00005 [m]

Insert reference lines with coordinates:

x1 = 0.0035 [m]

x2 = 0.0045 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.00025 [m]

Specify Reference line parameters for the reference line with coordinate x=0.0035:

h = 0.00005 [m]

Specify Reference line parameters for the reference line with coordinate x=0.0045:

h = 0.00005 [m]

Specify Reference line parameters for the reference line with coordinate x=0.008:

h = 0.00025 [m]

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nY = 8

If we used adaptation of the computational grid in this exercise, then the settings Grid structure = 2D and
Plane = XY would prevent the adaptation along the axis Z (these settings mean that the grid will always
contain only one cell along Z). As no adaptation is used in this exercise, you can just set nZ=1.

In the Properties window of the Initial grid click Apply.

4.1.3.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.001 [s]
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4.1.3.5 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Distribution of gap cells

2. Velocity distribution in the plane of the flow

4.1.3.5.1  Distribution of gap cells

· Create a layer Cell set on the Computational space

· In the Properties window of this layer Cell set specify:

Type = Gap

Appearance

Mode = Lines

4.1.3.5.2  Velocity distribution
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· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0

· In theProperties window of the layer Vectors specify:

On regular grid = No

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 0.2

Min = 0

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

4.1.4 Flow of crude oil in a petroleum reservoir

A model of the movement of oil in the reservoir with influence of gravity. From a wellbore with radius r oil is
pumped at a speed V. The upper layer with thickness h1 has larger resistance D1 and almost does not allow
the oil to go through. The lower layer has thickness h2 and lower resistance D2 and has a better capacity.

Dimensions:

Radius of the wellbore r = 1 [m]
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Thickness of the upper layer h1 = 6 [m]

Thickness of the lower layer h2 = 5 [m]

Velocity of the flow in the wellbore:

Velocity: V = 0.1 [m s-1]

Parameters of the substance:

Density r = 1000 [kg m-3]

Viscosity m = 0.01 [kg m-1s-1]

Geometry: Oil.STL

Project: Oil

4.1.4.1 Physical model

In this problem, motion of the fluid in a gravitational field is simulated. Therefore, you have to specify the gravity
vector. Also, problems in which the motion of the fluid in a gravitational field is simulated, it is possible to count
the pressure in the computational domain not from the reference pressure, but from the equilibrium hydrostatic
pressure. This allows you to improve the accuracy of the computation and specify in the initial and boundary
conditions not the pressure with hydrostatic column, but the difference between the real pressure and the
equilibrium pressure. For this the hydrostatic parameters are to be specified.

Do the following steps in the project tree in the Preprocessor tab.

In properties of the General settings specify:

Gravity vector

X = 0 [m s-2]

Y = -9.8 [m s-2]

Z = 0 [m s-2]

g-Point

X = 0 [m]

Y = 0 [m]

Z = 0 [m]

g-Density = 1000 [kg m-3]

In the folder Substances:

· Create Substance #0

· Specify the following properties of the Substance #0:
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Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

Viscosity

Value = 0.01 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

To simulate the oil, we use in this example a Substance with properties of water except much larger
viscosity.

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0

· Add Phase #0 into subfolder Model #0 > Phases

4.1.4.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:
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Boundary 1

Name = Symmetry

Type = Symmetry *)

Variables

Velocity ​​(Phase #0) = Slip

Boundary 2

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Total pressure

Value = 0 [Pa]

Boundary 3

Name = Outlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Specify the numerical value of the Mass velocity:

Velocity (Phase #0)

Mass velocity = -100 [kg m-2 s-1]

Note:

*) In order to set the boundary condition on the boundary corresponding to the slip without leakage, use the
Symmetry type of the boundary condition.



93FlowVision Help

 

4.1.4.3 Modifiers

Modifiers are Subregion's elements that allow modifying the geometry and/or the solution in the area of their
application. In particular, you can use modifiers to specify a volume force, resistance, heat sources, etc.

The process of specifying a Modifier consists of two stages:

· specifying the area where the Modifier is applied

· specifying the Modifier on/in this area

In this example, we need two resistances and, accordingly, we will specify two Modifiers.

In order to set the modifier, which corresponds to the main resistance of the wellbore do the following steps:

· In SubRegion #0 in the context menu of folder Modifiers, select Create.

· In the Create new modifier window, which opens, select:

Modifier type = Resistance

Objects = Computational space

· In properties of the new modifier Resistance #0 specify:

Activation

Type = Permanent

Resistance coef. = 5

In order to set the modifier, which corresponds to the resistance of the reservoir in the middle of the
computational domain, it is necessary to create not only the modifier properties, but also an Object on which
the modifier will be applied. 
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To specify the Object do the following:

· From the context menu of the folder Objects, select Create.

· In the Create new object window that appears, select Box.

· In the Properties window of the Box #0 specify:

Location

Reference point

X = -5 [m]

Y = -3 [m]

Z = 0 [m]

Size

X = 10 [m]

Y = 6 [m]

Z = 0.35 [m]

In the View window an image of Box #0 will appear.
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To create a Resistance inside of the created Object do the following:

· In SubRegion #0, from the context menu of the folder Modifiers, select Create.

· In the Create new modifier window, which opens, specify:

Modifier type = Resistance

Objects = Box #0

· In properties of the new modifier Resistance #1, which appears in the project tree, specify:

Activation

Type = Permanent

Resistance coef. = 500

To specify absence of the resistance in the borewell itself, create a modifier with zero resistance on an Object,
which corresponds to the borewell.

To specify the Object do the following:

· From the context menu of the folder Objects, select Create.

· In the Create new object window that appears, select Box.

· In the Properties window of Box #1 specify:

Location

Reference point

X = -0.5 [m]

Y = -6 [m]

Z = 0 [m]

Size

X = 1 [m]

Y = 10 [m]

Z = 0.35 [m]

In the View window an image of Box #1 will appear.
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To create a Resistance inside the created Object do:

· In SubRegion #0 in the context menu of the Modifiers folder, select Create.

· In the Create new modifier window, which appears, specify:

Modifier type = Resistance

Objects = Box #1

· In properties of the new modifier Resistance #2, which appears in the project tree, specify:

Activation

Type = Permanent

Resistance coef. = 0

Modifiers of the same type are applied sequentially in order of their location in the folder Modifiers. Priority of a
Modifier is higher when it is located lower in the list. Thus, in the area, which is the set-theoretic intersection
of Box #0, Box #1, and SubRegion #0, the Modifier is applied, which is specified in Box #1.
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4.1.4.4 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 100

nY = 100

In the Properties window of the Initial grid click Apply.

4.1.4.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Diffusive CFL = 1

4.1.4.6 Stopping conditions

In this exercise, we recommend that you define the stopping condition by the static pressure at the outlet.

Create Characteristics:

· In the Preprocessor tab, create a Supergroup on the surface of selecting the boundary condition Outlet
using the command Create supergroup > In Preprocessor from the context menu of the boundary
condition.

· Create Characteristics for the just created Supergroup on "Outlet".

· In the Properties window of Characteristics #0 specify:

Variable

Variable = Pressure

Specify the stopping criterion:

· in the Solver tab, create Stop criterion #0 in the folder Stopping conditions > User values (select Create
from the folder's context menu).
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· In the Properties window of the new just created Stop criterion #0 set:

Level = 1e-6

Averaging = By period

Period

     Type = By time

    Number of seconds = 100

Object = Characteristics #0 (Supergroup on "Outlet")

Variable = <f surf>

4.1.4.7 Visualization

Specify visualization of:
1. Pressure distribution in the plane of the flow
2. Pressure distribution with hydrostatic taken into account in the plane of the flow

4.1.4.7.1  Pressure distribution

Visualization of pressure distribution when the step number is near 500:

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of Color contours #0 specify:

Variable

Variable = Pressure

Value range

Mode = Manual
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Max = 0

Min = -9

Palette

Appearance

Enabled = Yes

Style = Style 1

Note:

When hydrostatic is set, the Pressure variable corresponds to the deviation from the equilibrium hydrostatic
pressure. To display pressure distribution relative to the reference pressure, without deduction of the equilibrium
hydrostatic pressure, you have to display pressure distribution with hydrostatic taken into account.

4.1.4.7.2  Pressure distribution with hydrostatics taken into account

· Create a layer Color contours on Plane #0.

· In the Properties window of Color contours #1 specify:

Variable

Variable = Pressure (+ hydrostatic)

Value range

Mode = Manual

Max = 100000

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1
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4.1.5 Transonic flow in Laval nozzle

An one-dimensional transonic flow of inviscid zero-conductivity gas in the Laval nozzle is considered in the
given example.

Parameters of the fluid:

Density: r

inl
= 1.29 [kg m-3]

Viscosity: m = 0 [kg m-1s-1]

Thermal conductivity l = 0 [W m-1K-1]

Specific heat c
p

= 1009 [J (kg K)-1]

Sonic speed a = 331.6 [m s-1]

Inlet parameters:

Total pressure on the inlet P =6895 [Pa]

Total temperature on the inlet T =125 [K]

Outlet parameters

Pressure on the outlet P
st

= 5171 [Pa]

Geometry: Nozzle.STL

Project: Nozzle

This project can require substantial computational resources and time.

4.1.5.1 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the Properties window of the element General settings specify:

· Specify the following parameters:

Reference values

Temperature = 125 [K]

Pressure = 6895 [Pa]

In the folder Substances:

· Create Substance #0

· Specify the following properties of Substance #0 *):

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]

Density = Ideal gas law

Specific heat

Value = 1009 [J kg-1 K-1]

In the folder Phases:
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· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes *):

Motion = Navier-Stokes model

Heat transfer = Heat transfer via H

In the folder Models:

· Create Model #0

· Add Phase #0 into subfolder Model #0 > Phases

Note:

*) When simulating the gas flow at Mach > 0.15 is necessary to consider the dependency of density on
pressure. To do this:

1. In properties of the Substance you have to specify Aggregative state = Gas, the dependency of
Density by Ideal gas law and values of Molar mass and Specific heat.

2. In Physical processes enable computation of the Heat transfer equations (select the Heat transfer
via H option).

4.1.5.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Symmetry

Type = Symmetry *) 

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

Boundary 2

Name = Outlet

Type = Inlet/Outlet

Variables
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Temperature(Phase #0) = Total temperature

Value = 0 [K]

 Velocity​​(Phase #0) = Total pressure

Total pressure = 0 [Pa]

Boundary 3

Name = Inlet

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = -10 [K]

Velocity​​(Phase #0) = Inlet pressure

Pressure = -1724 [Pa]

Note:

*) In order to set on a boundary a boundary condition corresponding to the slip without leakage, you have to use
the Symmetry type of boundary condition.

4.1.5.3 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 1D

Direction = X

nX = 1000

If we used adaptation of the computational grid in this exercise, then adaptation along the non-computational
directions Y and Z would not be done, and the grid would always have only one cell along these directions.

As no adaptation is used here, you can just set nY=1 and nZ=1.

In the Properties window of the Initial grid click Apply.

4.1.5.4 Parameters of calculation

Specify in the Solver tab of the Project window:

· In the Properties window of the element Time step specify:

Method = Via CFL number
Convective CFL = 10
Max step = 0.001 [s]

· In the Properties window of the element Advanced settings specify:

Numerical method > Type of scheme = Implicit
Numerical method > Use SGA = No
Numerical method > Pressure gradient = With velocity consideration

· In the Properties window of the element Limiters > Limiters for calculation > Phase Limiters > Phase
#0 specify:

Limiter > Density, min. = 0.001 [kg m-3]
Limiter > Temperature abs, min. = 10 [K]
Limiter > Temperature abs, max. = 1000 [K]
Limiter > Velocity, max. = 1000 [m/s]
Limiter > Pressure abs, min. = 0 [Pa]
Limiter > Pressure abs, max. = 10000 [Pa]

Note:
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For simulations with high gradients of velocity, temperature and pressure it is recommended to use phase
limiters. The limiters help to avoid the divergence of the solution.Also, for one-dimensional simulations and
simulations, which use the gap model, it is recommended to specify Numerical method > Pressure gradient
= With velocity consideration.

4.1.5.5 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Mach Number distribution in the plane of the flow.

2. Pressure distribution in the plane of the flow.

4.1.5.5.1  Mach Number distribution

Visualization of the Mach Number distribution when the step number is near 1300:

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on the Plane.

· In the Properties window specify:

Variable

Variable MachNumber

Value range

Mode = Manual

Max = 1.6
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Min = 0.2

· Load the thermal palette from the file heat.fvpal:

o In the Properties window of the Layer click button Palette > Operations >  (Load palette from

file)
o In the operation system's window, which appears, select the file heat.fvpal (this file locates in the

directory where FlowVision is installed).

4.1.5.5.2  Pressure distribution

· Create a layer Color contours on the plane.

· In the Properties window specify:

Variable

Variable Pressure

Value range

Mode = Manual

Max = 0

Min = -5500

· Load thermal palette from the file heat.fvpal (this file locates in the directory where FlowVision is

installed).
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4.1.6 Supersonic flow past wedge

In this example a supersonic flow around a 15-degree wedge in two-dimensional channel is simulated.

Dimensions:

Angle: a = 15 [degree]

Dimensions of the computational domain 6 × 2 × 1 [m × m × m]

Parameters of the substance:

Molar mass: M = 0.0289 [kg mole-1]

Viscosity: m = 1.82 10-5 [kg m-1s-1]

Thermal conductivity l = 0.026 [W m-1K-1]

Specific heat capacity c
p

= 1009 [J (kg K)-1]

Sonic speed: a = 331.6 [m s-1]

Parameters on inlet:

Static pressure P = 101000 [Pa]

Temperature at infinity T = 273 [K]

Velocity on inlet V
inl

= 600 [m s-1]

Mach number M = 1.8

Geometry: Wedge.wrl

Project: Wedge

4.1.6.1 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the folder Substances:

· Create Substance #0.

· In properties of Substance #0 specify:

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]
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Density = Ideal gas law

Viscosity

Value = 1.82e-5 *) [kg m-1s-1]

Thermal conductivity

Value = 0.026 [W (m K)-1]

Specific heat

Value = 1009 [J kg-1 K-1]

*) 1.82e-5 is notation for 1.82x10-5.

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes:

Motion = Navier-Stokes model

Heat transfer = Heat transfer via H

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· Specify in the folder Models > Model #0 > Init. data > Init. data #0:

Velocity ​​(Phase #0)

X = 600 [m s-1]

4.1.6.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0
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Specify the following boundary conditions:

Boundary 1

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

Boundary 2

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value =0 [K]

Velocity​​(Phase #0) Normal velocity with pressure

Velocity =600 [m s-1]

Pressure =0 [Pa]

Boundary 3

Type = Free Outlet

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Pressure

Pressure =0 [Pa]

4.1.6.3 Initial grid

Specify properties of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 75

nY = 25

In the Properties window of the Initial grid click Apply.
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4.1.6.4 Adaptation of the computational grid

In this project it is necessary to solve the grid in the area of pressure surges. To provide this, specify adaptation
by the gradient of pressure.

Specify the adaptation by the maximal gradient of pressure:

· In the folder Computational grid > Adaptation to solution specify:

Activation

Type = Repetitive by step

Start in steps = 400

Duration in steps = 1

Period in steps = 50

Cell number = 8000

· Create in the subfolder Computational grid > Adaptation to solution an element Adaptation to solution
#0.

· In the Properties window of the just created element Adaptation to solution #0 specify Max level N = 2:
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As in this exercise there is only one Subregion, you don't have to add SubRegion #0 into the folder
Computational grid > Adaptation to solution > Adaptation to solution #0 > Subregions using the 
Add/Remove command from the context menu; SubRegion #0 is added to this folder automatically at
creation of Adaptation to solution #0.

· From the context menu of the subfolder Computational grid > Adaptation to solution > Adaptation to
solution #0 > Objects select the Add/Remove Objects command and in the Select objects dialog box,
which opens, place Computational space to the Selected pane and click OK:

· In the Properties window of the element Computational grid > Adaptation to solution > Adaptation to
solution #0 > (none) To value specify:

Variable

Variable = Pressure

Value/Gradient = To gradient
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After this the child element in the subfolder Computational grid > Adaptation to solution > Adaptation to
solution #0 > Conditions > Conditions will be presented in the project tree as Pressure To gradient.

During the simulation at the 600th time step the following computational grid will be formed:

4.1.6.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Max step = 0.0001 [s]

4.1.6.6 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of
Pressure distribution in the plane of the flow before the start of computation.

4.1.6.6.1  Pressure distribution

· In the Properties window of Plane #0 specify:
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Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on the plane.

· In the Properties window of the layer specify:

Variable

Variable = Pressure

Value range

Mode = Manual

Max = 2.5e5

Min = 0

Method = Isolines

Palette

Appearance

Enabled = Yes

Style = Style 1

Notes:

· In order to view the computational grid with the adaptation, create a Computational grid section layer on a
Plane, which goes along the computational domain. The layer will be displayed after at least one step of
computation is done.

· To obtain this result, the program will require more then 3000 steps of the computation.

4.1.7 Hypersonic flow around sphere

In this example an external hypersonic flow around a sphere is simulated.

Dimensions:

Radius of the sphere: R = 0.016 [m]

Substance: Air

Flow Settings:

Static pressure: P = 100000 [Pa]

Temperature at infinity: T = 273 [K]

Velocity at infinity: V =3830 [m s-1]

Mach number at infinity: M = 11.2



112FlowVision Help

 

Geometry: Sphere.STL

Project: Sphere

Note:

Computation of this project may require long time and significant amount of computing resources.

4.1.7.1 Computational domain

This problem require simulation of an axisymmetric external hypersonic flow. Therefore, you have to create a
computational domain, which is a region with flow around a streamlined body, which is a sector with a small
degree (eg 1-2 degrees). When the gas flows at a velocity corresponding to the Mach number > 0.1 it is
possible to use non-reflecting boundary conditions. They make less disturbance to the flow, so the distance
from the body to the limits of the region, in many cases, can be set less than 10 × characteristic body size.

You can find fully prepared geometry of the computational domain is in the file Sphere.STL.

4.1.7.2 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)
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In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify properties of Physical processes:

Motion = Navier-Stokes model

Heat transfer = Heat transfer via H

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases
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4.1.7.3 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

Boundary 2

Type = Non-reflecting

Variables

Temperature(Phase #0) = Non-reflect.

Value = 0 [K]

Velocity​​(Phase #0) = Non-reflect.

Velocity at inf. [m s-1]

X = 3830

Y = 0

Z = 0

Pressure at inf. = 0 [Pa]

Boundary 3

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient
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Velocity​​(Phase #0) = No slip

4.1.7.4 Initial conditions

In supersonic and hypersonic external flow around bluff bodies we recommend to specify near the body initial
values of variables, corresponding to the parameters of flow deceleration, and in the rest of the domain specify
initial conditions, which are relevant to parameters of the undisturbed flow.

To set initial conditions, which are relevant to parameters of the undisturbed flow, in properties of the element
Model #0 > Init. data > Init. data #0 specify:

Velocity​​(Phase #0)

X = 3830 [m s-1]

To set initial conditions corresponding to the deceleration of the flow near the body, you have to:

1. Specify Initial data corresponding to the parameters of flow deceleration.

2. Specify an Object corresponding to the region around the sphere.

3. Specify Initial conditions, establishing correspondence between the Object and the Initial data.

Specify the Initial data:

· From the context menu of the folder Model #0 > Init. data, select Create.

· In properties of the new just created element Init. data #1 specify:

Temperature (Phase #0) = 7300 [K]

Pressure (Phase #0) = 1.65e7 *) [Pa]

*) 1.65e7 is notation for 1.65x107.

Specify the Object:

· From the context menu of the folder Objects, select Create.
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· In the dialog box Create new object, which opens, select Ellipsoid/sphere.

· In the Properties window of Ellipsoid/sphere #0 specify:

Location

Reference point

X = 0.003 [m]

Y = 0 [m]

Z = 0 [m]

Parameters

Radius = 0.02 [m]

In the View window an image of Ellipsoid/sphere #0 will appear:

To define a correspondence between the Object and the Initial data:

· In SubRegion #0, from the context menu of the folder Initial conditions, select Create:
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· In the Properties window of Init. condition #1 specify:

Object = Ellipsoid/sphere #0

Init. data = Init. data #1

The initial conditions are applied sequentially in the order they appear in the folder Initial conditions. Priority of

an Initial condition is higher when the item is lower in the list1). Thus, in the set-theoretic intersection of
Ellipsoid/spheres #0 and SubRegion #0, in the initial moment time parameters of flow deceleration are set,
and parameters of the undisturbed flow are set in the rest of the domain .

Note: 

1) You can change priority of an Init. conditions element moving it in the list up and down using the context
menu commands Move Up and Move Down.

4.1.7.5 Initial grid

To better solving the flow near the sphere in this example, specify a two-dimensional non-uniform computational
grid, condensed near the sphere.

In the Properties window, click the Initial grid button  to call the Initial grid editor.



118FlowVision Help

 

In the Initial grid editor specify:

for axis OX

Grid parameters

h_max = 0.01 [m]

h_min = 0.0002 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-0.112:

h = 0.01 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0:

h =0.0002 [m]

kh- = 1.07

kh+ = 0.97

Specify Reference line parameters for the reference line with coordinate x=0.208:

h = 0.01 [m]

kh- = 1

for axis OY (click the button )

Grid parameters

h_max = 0.01 [m]

h_min = 0.0002 [m]

Specify Reference line parameters for the reference line with coordinate y=0:

h =0.0002 [m]

kh+ = 0.95

Specify Reference line parameters for the reference line with coordinate y=0.112:

h = 0.01 [m]

kh- = 1

Click OK to close the Initial grid editor with saving the entered data.

In properties of the Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

4.1.7.6 Parameters of calculation

Specify in the Solver tab:

· In properties of the Time step element specify:

Method = Via CFL number

Convective CFL = 1

Max step = 0.0001 [s]

· In the Properties window of the Limiters > Limiters for calculation > Phase limiters > Phase #0 element
specify:

Limiter

Density, min. = 0.001 [kg m-3]

Temperature abs, min. = 10 [K]

Temperature abs, max. = 1e+5 **) [K]
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Velocity, max. = 1e+5 **) [m s-1]

Pressure abs, min. = 100 [Pa]

Pressure abs, max. = 1e+8 *) [Pa]

*) 1e+8  is notation for 108.

**) 1e+5  is notation for 105.

4.1.7.7 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Mach Number distribution in the plane of the flow.

2. Pressure distribution in the plane of the flow.

4.1.7.7.1  Mach Number distribution

Visualization of the Mach Number distribution when the step number is near 7000:

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on the Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Mach number

Value range

Mode = Manual

Max = 12

Min = 0
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Palette

Appearance

Enabled = Yes

4.1.7.7.2  Pressure distribution

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Pressure

Value range

Mode = Manual

Max = 2e7

Min = 0

Palette

Appearance

Enabled = Yes
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4.2 Heat transfer

In FlowVision a convection-diffusion model for heat transfer is implemented.

In order to simulate the convection-diffusion heat transfer, you have to:
· In properties of the Substance it is required to specify values of Density and Specific heat capacity, and,

if necessary, the value of the Thermal conductivity.
· Enable calculation of the equation of Heat transfer.
· Specify the appropriate initial and boundary conditions for the Temperature.

4.2.1 Heat transfer in a solid body

Heat transfer in a solid body by means of conduction is considered in the given example.

Parameters of the problem setting

Dimensions:

The length of the bar l = 1 [m]

Parameters of the substance

Density r = 7900 [kg m-3]

Thermal conductivity l = 46 [W m-1K-1]

Specific heat c
p

= 457 [J kg-1 K-1]

Inlet parameters:

Temperature on the hot wall T
h

= 100 [K]

Heat flux from the cold wall q
c

= -4600 [W m-2]

Geometry: Conduct.STL

Project: Conduct

4.2.1.1 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the folder Substances:

· Create Substance #0.

· In properties of Substance #0 specify:

Aggregative state = Solid

Molar mass

Value = 0.056 [kg mole-1]

Density
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Value = 7900 [kg m-3]

Thermal conductivity

Value = 46 [W m-1K-1]

Specific heat

Value = 457 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In the folder Phase #0 > Substances load Substance #0.

· In the Properties window of the folder Phase #0 > Physical processes specify:

Heat transfer = Heat transfer via h

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

4.2.1.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 100 [K]

Boundary 2

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Boundary 3

Type = Wall

Variables

Temperature(Phase #0) = Flux

Value = -4600 [W m-2]
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4.2.1.3 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 1D

Direction = X

nX = 100

If we used adaptation of the computational grid in this exercise, then adaptation along the non-computational
directions Y and Z would not be done, and the grid would always have only one cell along these directions.

As no adaptation is used here, you can just set nY=1 and nZ=1.

In the Properties window of the Initial grid click Apply.

4.2.1.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 10000 [s]

4.2.1.5 Visualization

To view the dynamics of the solution during the computation, specify visualization of Temperature distribution
along the length of the bar before the start of computation.

4.2.1.5.1  Temperature distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1
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(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on the Plane.

· In the Properties window of the layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 100

Min = 0

Palette

Appearance

     Enabled = Yes

     Horiz. alignment = Right

     Vert. alignment = Bottom

4.2.2 Forced convection

Consider the simulation of laminar flow of cold water in a tube with a hot wall.

Parameters of the problem setting

Dimensions:

Length of the tube L = 2 [m]

Diameter of the tube D = 0.1 [m]

Inflow parameters:

Velocity on inlet: V
inl

 = 0.001 [m s-1]

Temperature on inlet T
inl

 = 0 [oC]

The wall temperature T
w

= 90 [oC]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 10-3 [kg m-1s-1]

Thermal conductivity l = 0.6 [W m-1K-1]

Specific heat c
p

= 4217 [J kg-1 K-1]
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Reynolds number:
2inl 10

0.001

10000.10.001

μ

DρV
Re 





Geometry: Tube.wrl 

Project: ForceConvection

4.2.2.1 Physical model

Do the following steps in the project tree in the Preprocessor tab.

In the folder Substances:

· Create Substance #0.

· In properties of Substance #0 specify:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Thermal conductivity

Value = 0.6 [W m-1K-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity(Phase #0)

X = 0 [m s-1]

Y = 0 [m s-1]

Z = 0.001 [m s-1]

4.2.2.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0
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Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 90 [K]

Velocity​​(Phase #0) = No slip

Boundary 2

Type = Free Outlet

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

Boundary 3

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 0 [K]

Velocity​​(Phase #0) = Normal mass velocity

Specify the numerical value of the Mass velocity:

Velocity (Phase #0)

Mass velocity = 1 [kg m-2 s-1]



127FlowVision Help

 

4.2.2.3 Initial grid

Specify in the Properties window of the Initial grid:

nX = 20

nY = 20

nZ = 50

In the Properties window of the Initial grid click Apply.

4.2.2.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 20 [s]

4.2.2.5 Visualization

To view the dynamics of the solution during the computation, specify visualization of temperature distribution
in the plane of the flow before the start of computation.
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4.2.2.5.1  Temperature distribution

· Create a Color contours layer on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 90

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1

4.2.3 Natural convection

In this example, the simulation of laminar air flow in a rectangular cavity, vertical walls are maintained at
different temperatures (one cold and one hot), while the horizontal walls are insulated. Under the influence of
buoyancy due to a temperature difference arises dimensional convective motion.
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Parameters of the problem setting

Dimensions of the region: a × b = 0.03 × 0.09 [m × m]

Inflow parameters:

The temperature of the hot wall: T = 50 [oC]

The temperature of the cold wall: T = 20 [oC]

Parameters of the gas:

Molar mass M = 0.0289 [kg mole-1]

Viscosity m = 1.82×10-5 [kg m-1s-1]

Thermal conductivity l = 0.026 [W (m K)-1]

Specific heat c
p

= 1009 [J kg-1 K-1]

Prandtl number: Pr = 0.71

Rayleigh number: Ra = 105

Geometry: a box that will be created by means of FlowVision

Project: Natur_Convect

4.2.3.1 Creating the computational domain in the "Geometry" tab

The computational domain can be created by means of FlowVision without using files created in external CAD
software.

In the exercise Time-varying flow in a tube the computational domain was created in the Preprocessor tub,
while here we will learn how to create the computational domain in the Geometry tab.
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Create an empty FlowVision project using the File > Create command from the main menu.

The New project dialog box will open; click there the  (Create empty project) button. An empty project
will be created with the Geometry tab opened.

In the Geometry tab follow the steps listed below.
· In the folder Initial geom. models create Box #0 (select Create from the context menu of the folder

Initial geom. models and in the Create new analytical object dialog box, which opens, select
Object type = Box). Click OK.

· In properties of Box #0 specify:

Object

Location

Reference point

X = 0.015 [m]

Y = 0.045 [m]

Z = -0.005 [m]

Size

X = 0.03 [m]

Y = 0.09 [m]

Z = 0.01 [m]
· Click the Apply screen button.
· Open the context menu of Box #0 and select the command Create consistent mesh. The

Approximation parameters dialog box will open where you can specify number of segments along
coordinate axes (the more is number of segments, the more precisely the object's geometry will be
resolved and the smaller the facets will be). Don't change the default settings and click OK:

· The Initial geom. models > Box #0 > mesh will appear in the project tree. Open its context menu and
select the command Use in SubRegion Composer:
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· The SubRegion Composer > Objects > Box #0 - mesh element will appear in the project tree. This
element corresponds to the geometry model, which is being created.

· Open the context menu of the element SubRegion Composer > Composed subregions (icon of the
element is faded now) and select the command Compose:

· The SubRegion Composer > Composed subregions > Box #0 - mesh element will appear in the
project tree.

· Open again the context menu of the element SubRegion Composer > Composed subregions and
select the command Use as Region main geometry:

· The Preprocessor tab will open automatically. The just created geometry model of the computational

domain will be loaded there.

4.2.3.2 Physical model

In the Properties window of the element General settings specify:

Reference values

Temperature = 293 [K]

Gravity vector

X = 0 [m s-2]

Y = -9.8 [m s-2]
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Z = 0 [m s-2]

g-Density = 1.224 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify properties of Substance #0:

Aggregative state = Gas

Properties of child elements in the project tree:

Molar mass

Value = 0.0289 [kg mole-1]

Density = Ideal gas law

Viscosity

Value = 1.82 × 10-5 [kg m-1s-1]

Thermal conductivity

Value = 0.026 [W m-1K-1]

Specific heat

Value = 1009 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of Phase #0 > Physical processes:

Motion = Navier-Stokes model

Heat transfer = Heat transfer via h

In the folder Models:
· Create Model #0.
· Add Phase #0 into subfolder Model #0 > Phases.
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4.2.3.3 Boundary conditions

In the Properties window of the subregion Box #0 - mesh, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 30 [K]

Velocity​​(Phase #0) = No slip

Boundary 2

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

Boundary 3

Type = Wall

Variables

Temperature(Phase #0) = Temperature
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Value = 0 [K]

Velocity​​(Phase #0) = No slip

Boundary 4

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = No slip

4.2.3.4 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.
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Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.00125 [m]

h_min = 0.0004 [m]

Insert reference lines with coordinates:

x1 = 0.005 [m]

x2 = 0.025 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.0004 [m]

Specify Reference line parameters for the reference line with coordinate x=0.005:

h = 0.00125 [m]

Specify Reference line parameters for the reference line with coordinate x=0.025:

h = 0.00125 [m]

Specify Reference line parameters for the reference line with coordinate x=0.03:

h = 0.0004 [m]

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nY = 73

In the Properties window of the Initial grid click Apply.

4.2.3.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.2 [s]

4.2.3.6 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Velocity distribution in the plane of the flow

2. Temperature distribution in the plane of the flow
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4.2.3.6.1  Velocity distribution

· In the Properties window of Plane #0 specify:

Object

Reference point

Z = -0.005

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.
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· In the Properties window of the layer specify:

Grid

Size 1 = 50

Size 2 = 50

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 0.075

Min = 0

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

Note:

To display the palette, which is used for coloring the layer (in our case this is coloring the vectors by their
absolute values), you can use the Info window or, in properties of the layer, set Appearance > Enabled =

Yes. To open the Info window, you have to select the layer in the tree of Postprocessor and click the 
 button.
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4.2.3.6.2  Temperature distribution

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 30

Min = 0

Method = Isolines

Notes:

· To display the palette, which is used for coloring the layer, you can use the Info window or, in properties of
the layer, set Appearance > Enabled = Yes. To open the Info window, you have to select the layer in the

tree of Postprocessor and click the  button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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4.3 Turbulence

FlowVision mainly uses the following turbulence models:

1. The standard k-ε model

2. Low-Reynolds k-ε model AKN 

3. Quadratic k-ε model

4. SST model

5. SA model

In order to simulate the turbulent motion of the liquid or gas:

· In a Substance specify Aggregative state = Liquid or Gas.

· In properties of the Substance specify values of Density and Viscosity.

· Enable computation of equations of the Motion and the corresponding Turbulence model.

· Specify the appropriate initial and boundary conditions for the parameters of the turbulence.

· When using the Low-Reynolds k-ε model we recommend you to run a preliminary computation using the
standard k-ε model.

· If high gradients of the variables or divergence of the equations of turbulent transport appear in the process of
computation, we recommend to set a limiter on the maximum value of the turbulent viscosity, and also
specify non-zero background values of turbulent variables in initial conditions and boundary conditions.

4.3.1 Turbulent flow in a tube

The standard k-ε turbulence model is intended for simulation of flows with values of y+ > 3 and small pressure
gradients.

 

Consider an application of the k-ε turbulence model in an example of simulation of turbulent flow in a tube.

A turbulent flow is characterized by the Reynolds number (Re) more then 104.

Parameters of the problem setting

Dimensions: 

Length of the tube L = 2 [m]

Diameter of the tube D = 0.1 [m]

Inflow parameters:

Velocity on inlet: V
inl

 = 10 [m s-1]
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Parameters of the substance:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Reynolds number: 6inl 10
0.001

10000.110

μ

DρV
Re 





Geometry: Tube.wrl

Project: Tube_turb

4.3.1.1 Physical model

In the Properties window of the element General settings specify:

Reference values

Temperature = 298 [K]

Pressure = 100000 [Pa]

In the folder Substances:

· Create Substance #0.

· Specify properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity ​​(Phase #0)

Z = 10 [m s-1]
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4.3.1.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Name = Outlet

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy (Phase #0) = Zero gradient

TurbDissipation (Phase #0) = Zero gradient

Boundary 3

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Mass velocity = 10000 [kg m-2 s-1]

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]
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4.3.1.3 Initial grid

Specify in the Properties window of the Initial grid:

nX = 20

nY = 20

nZ = 50

In the Properties window of the Initial grid click Apply.

4.3.1.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.01 [s]

4.3.1.5 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Pressure variation on inlet

2. Turbulent viscosity distribution in the plane of the flow

3. Velocity distribution in the plane of the flow

4. Pressure distribution along the axis of the tube

4.3.1.5.1  Pressure variation on inlet

We consider below two methods of displaying a plot the pressure variation on inlet. The first steps of these
methods are same:

· On the BC Inlet create a Supergroup in Preprocessor (use in the context menu the command Create
supergroup > In Preprocessor).

· Create Characteristics on this Supergroup.
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· In properties of the created element Characteristics > Characteristics #0 (Supergroup on "Inlet") specify:

Variable

Variable = Pressure

Displaying the plot in the Monitor window

In the Solver tab, in the folder Stopping conditions > User values create a user Stop criterion #0 and in its
properties specify:

Object = Characteristics #0 (Supergroup on "Inlet")

Variable = <f surf.>

Run the computation and view dynamics of the pressure variation on inlet in the Plot tab of the Monitor window
(select the Stop criterion #0 in the right pane and set parameters of the plot if necessary):

Displaying the plot in an external program

· In the Postprocessor tab, in properties of the element Characteristics > Characteristics #0 (Supergroup
on "Inlet"), specify:

Save to file

Type = Automatic
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· After the computation is finished, open the glo-file, which is specified in properties of the element

Characteristics #0 (Supergroup on "Inlet"), by an external program (for example, by Excel) and plot the
dependency of Avg by Time.

4.3.1.5.2  Turbulent viscosity distribution

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = TurbViscosity

Value range

Mode = Manual
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Max = 0.9

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1

4.3.1.5.3  Velocity distribution

· Create a layer Vectors on Plane #0.

· In the Properties window of the layer specify:

Grid

Size 1 = 10

Size 2 = 40

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 11.2

Min = 8.2

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

Notes:

· To display the palette, which is used for coloring the layer (in our case this is coloring the vectors by their
absolute values), you can use the Info window or, in properties of the layer, set Appearance > Enabled =

Yes. To open the Info window, you have to select the layer in the tree of Postprocessor and click the 
 button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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4.3.1.5.4  Pressure distribution

· Create Line #0.

· In the Properties window of Line #0, specify:

Object

Reference point

X 0

Y 0

Z 0.001

Direction

X 0

Y 0

Z 1

· Create a layer Plot along line on Line #0.

· In the Properties window of the layer specify:

Variable

Variable = Pressure

Value range

Mode = Manual

Max = 13000

Min = 0

Notes:

· To display information about a layer, open the Info window. Select an item in the Postprocessor tab of

project tree and then click on the  button in the toolbar.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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4.3.2 Turbulent flow over a plate

The Low-Reynolds k-ε turbulence model (AKN) with equilibrium wall functions can be used for simulation of
flows with small gradients at y+>3 and with no wall functions at y+<3. In settings without wall functions you
have also specify values of parameters of turbulence of the approach flow.

Consider the use of the Low-Reynolds turbulence model without wall functions for simulating the dynamic and
the thermal boundary layers on a plate.

Parameters of the problem setting

Dimensions

Length of the computational
domain

= 2 [m]

Width of the computational
domain

= 1 [m]

Length of the plate L = 1 [m]

Inflow parameters:

Plate temperature T = 20 [K]
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Velocity on inlet V = 1 [m s-1]

Temperature on inlet T = 0 [K]

Parameters of the substance:

Density r= 1000 [kg m-3]

Viscosity m= 0.001 [kg m-1 s-1]

Thermal conductivity l= 0.6 [W m-1 K-1]

Specific heat capacity c
p
= 4217 [J kg-1 K-1]

Reynolds number 610
0.001

100011

μ

VLρ
Re 





Geometry: Plate.wrl 

Project: Plate

4.3.2.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of the Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Thermal conductivity

Value = 0.6 [W m-1K-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

Turbulence = KES *)

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity ​​(Phase #0)

X = 0 [m s-1]

Y = 1 [m s-1]
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Z = 0 [m s-1]

Pulsations (Phase #0)

Value = 0.0001

Turbulent scale (Phase #0)

Value = 0.001 [m]

Note:

*) Before applying the Low-Reynolds k-ε turbulence model (AKN), you need to carry out a preliminary
computation using the Standard k-ε turbulence model (KES) with wall functions.

4.3.2.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:
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Boundary 1

Name = Wall

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 20 [K]

Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Boundary 2

Name = Symmetry

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry

TurbDissipation(Phase #0) = Symmetry

Boundary 3

Name = Inlet

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 0 [K]

Velocity​​(Phase #0) = Normal mass velocity

Mass velocity = 1000 [kg m-2s-1]

TurbEnergy(Phase #0) = Pulsations 

Value = 0.0001

TurbDissipation(Phase #0) = Turbulent scale 

Value = 0.001 [m]

(Here values of values of parameters of turbulence of the approach flow are set because it is planned to do

computation using the low-Reynolds k-ε turbulence model (AKN) without wall functions)

Boundary 4

Name = Outlet

Type = Free Outlet

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy(Phase #0) = Zero gradient  

TurbDissipation(Phase #0) = Zero gradient  
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4.3.2.3 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.1 [m]

h_min = 0.0001 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.0001 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=1:

h = 0.1 [m]

kh- = 0.5

for axis OY (click the button )
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Grid parameters

h_max = 0.125 [m]

h_min = 0.002 [m]

Insert reference lines with coordinates:

y1 = -0.5 [m]

y2 = 0.5 [m]

Specify Reference line parameters for the reference line with coordinate y=-1:

h = 0.125 [m]

Specify Reference line parameters for the reference line with coordinate y=-0.5:

h =0.002 [m]

kh- = 0.9

kh+ = 1.1

Specify Reference line parameters for the reference line with coordinate y=0.5:

h =0.002 [m]

kh- = 0.9

kh+ = 1.1

Specify Reference line parameters for the reference line with coordinate y=1:

h = 0.125 [m]

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

4.3.2.4 Parameters of calculation

In the Solver tab:

In properties of the Time step element, specify:

Method = In seconds

Constant step = 0.01 [s]

In properties of the Stopping conditions > Time steps element specify Number = 100. This setting will
automatically stop the preliminary computation.

4.3.2.5 Preliminary computation

Do a preliminary computation using the Standard k-ε turbulence model (KES) of turbulence:

· Run the project on computation.

· When the program makes 100 iterations the computation will stop (as you have specified in parameters of
calculation Number = 100 in properties of the element Stopping conditions > Time steps).

Change the turbulence model to Low-Reynolds k-ε model AKN.

· In properties of the folder Phase #0 > Physical processes specify:

Turbulence = KEAKN

· In properties of the boundary condition Wall specify:

Wall interaction

Phase #0 = No wall functions *)
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· In the Solver tab, in properties of the element Stopping conditions > Time steps, specify Number =
1000000 and run the project on computation for continuation.

Notes:

*) When y+ < 3 over most of the surface of the wall, it is recommended to specify the Wall interaction= No
wall functions.

4.3.2.6 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Y+ distribution on a surface of the wall

2. Viscous friction distribution along the plate

4.3.2.6.1  Y+ distribution

Visualization of Y+ distribution when the step number is near 350:

· Create a Supergroup on the BC Wall using the Create supergroup > In Postprocessor command from
the context menu.

· Create a layer Color contours on this Supergroup.
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· In the Properties window of the layer specify:

Variable

Variable = Y_plus

Value range

Mode = Manual

Max = 3

Min = 1.5

4.3.2.6.2  Viscous friction distribution

Visualization of distribution of the viscous friction over the plate when the step number is near 350:

· In the Properties window of Plane #0 specify:

Object

Reference point

X = 0.01

Y = -0.51

Z = 0.05

Normal
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X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Plot along curve on the plane.

· In the Properties window of the Plot along curve, specify:

Variable

Variable = Shear stress

Number of points = 1000

Rotation angle = 180

4.3.3 Turbulent flow around a backward facing step

The Quadratic k-ε turbulence model is intended for simulation of flows with values 30<y+<300 and recirculation
zones.

Consider the use of the k-ε quadratic turbulence model in the example of a flow over an opposite facing step.

Dimensions:

Step height D = 1 [m]

Inflow parameters:

Velocity on inlet: V
inl

 = 1.76 [m s-1]

Parameters of the substance:

Density r = 1 [kg m-3]

Viscosity m =1.82e-5 [kg m-1s-1]

Reynolds number: 5
5

inl 10
101.82

111.76

μ

DρV
Re 









Geometry: BackwardFacingStep.wrl

Project: BackwardFacingStep
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4.3.3.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of the Substance #0:

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]

Density

Value = 1 [kg m-3]

Viscosity

Value = 2e-5 [kg m-1s-1]

Specific heat

Value = 1009 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KENL

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity ​​(Phase #0)

X = 1.76 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Pulsations (Phase #0) = 0.095

Turbulent scale (Phase #0) = 0.05 [m]

4.3.3.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0
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Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2 (two lateral surfaces and the upper surface)

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

TurbEnergy (Phase #0) =Symmetry

TurbDissipation (Phase #0) =Symmetry

Boundary 3

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Mass velocity = 1.76 [kg m-2 s-1]

TurbEnergy (Phase #0) = Pulsations

Value = 0.095

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.05 [m]

Boundary 4

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]
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TurbEnergy (Phase #0) = Zero gradient

TurbDissipation (Phase #0) = Zero gradient

4.3.3.3 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 120

nY = 25

In the Properties window of the Initial grid click Apply.

4.3.3.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 100

Max step = 1 [s]

4.3.3.5 Visualization

To view the dynamics of the solution during the computation, specify visualization of Velocity distribution in
the plane of the flow before the start of computation.

4.3.3.5.1  Velocity distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.
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· In the Properties window of the layer specify:

On regular grid = No

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 1.8

Min = 0

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

Note:

To display the palette, which is used for coloring the layer (in our case this is coloring the vectors by their
absolute values), you can use the Info window or, in properties of the layer, set Appearance > Enabled =

Yes. To open the Info window, you have to select the layer in the tree of Postprocessor and click the 
 button.

4.3.4 Turbulent flow around a box

The turbulence model SST is used for simulation of flows with a high degree of turbulence, with recirculation
zones and large back pressure gradients, and it also provides good results for free flows and flows with small
pressure gradients.

Consider the use of the SST turbulence model in the example of a turbulent flow around a cube.

Dimensions:

Side of the cube d = 0.0254 [m]

Length of the computational domain 17.6d = 0.447 [m]

Width of the computational domain 11.6d = 0.294 [m]

Inflow parameters:
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Velocity on inlet V
inl

= 7.65 [m s-1]

Parameters of the substance:

Density r = 1.226 [kg m-3]

Viscosity m =1.8325e-5 [kg m-1s-1]

Reynolds number: 4
5

inl 101.3
101.8325

1.2260.02547.65

μ

dρV
Re 









Geometry: Box.STL

Project: Box

4.3.4.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of the Substance #0:

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]

Density

Value = 1.226 [kg m-3]

Viscosity

Value = 1.82e-5 *) [kg m-1s-1]

Specific heat

Value = 1009 [J kg-1 K-1]

*) 1.82e-5 is notation for 1.82x10-5.

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = SST

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity ​​(Phase #0)

X = 7.65 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Pulsations (Phase #0) = 0.05

Turbulent scale (Phase #0) = 0.00254 [m]
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4.3.4.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Type = Wall

Wall interaction

Phase #0 =No wall functions

Variables

Velocity ​​(Phase #0) = No slip

TurbEnergy (Phase #0) = Fixed value

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

TurbEnergy (Phase #0) =Symmetry

TurbDissipation (Phase #0) =Symmetry
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Boundary 3

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Mass velocity = 9.38 [kg m-2 s-1]

TurbEnergy (Phase #0) = Pulsations

Value = 0.05

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.00254 [m]

(Here values of values of parameters of turbulence of the approach flow are set because it is planned to do

computation using the SST turbulence model without wall functions)

Boundary 4

Type = Free Outlet

Variables

Velocity = Pressure

Value = 0 [Pa]

TurbEnergy = Zero gradient

TurbDissipation = Zero gradient

4.3.4.3 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX
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Grid parameters

h_max = 0.03 [m]

h_min = 0.00075 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-0.147:

h = 0.03 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

h =0.00075 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0.3:

h = 0.03 [m]

for axis OY (click the button )

Grid parameters

h_max = 0.03 [m]

h_min = 0.00075 [m]

Insert a reference line with coordinate y=0 [m].

Specify Reference line parameters for the reference line with coordinate y=-0.147:

h = 0.03 [m]

Specify Reference line parameters for the reference line with coordinate y=0:

h =0.00075 [m]

kh- = 1 [m]

kh+ = 1 [m]

Specify Reference line parameters for the reference line with coordinate y=0.147:

h = 0.03 [m]

Click OK to close the Initial grid editor with saving the entered data.

In properties of the Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.
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4.3.4.4 Adaptation of the computational grid

In this example, you must resolve the vortex formation zone. For this it is necessary to make a grid adaptation
in the volume of a parallelepiped around the cube (you can see cells of the adapted computational grid after the
computation using the Computational grid layer).

Specifying the grid adaptation in an object consists of two steps:

1. Specifying an Object for the adaptation

2. Specifying adaptation criteria

In order to create an Object for the adaptation:

· From the context menu of the folder Objects, select Create.

· In the Create new object window select Object type = Box.

· In the Properties window of the Box #0 specify:

Location

Reference point

X = 0.01 [m]

Y = 0 [m]

Z = 0.005 [m]

Size

X = 0.05 [m]

Y = 0.05 [m]

Z = 0.005 [m]
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Set up the adaptation:

· From the context menu of the folder Computational grid > Adaptation, select the Create command to
create a new element Adaptation #0:

As in this exercise there is only one Subregion, you don't have to add SubRegion #0 into the folder
Computational grid > Adaptation > Adaptation #0 > Subregions using the  Add/Remove
command from the context menu; SubRegion #0 is added to this folder automatically at creation of
Adaptation #0.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Objects and in the Select objects dialog box, which opens, place Box #0 into the pane Selected and click
OK:
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· In the Properties window of the new created element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Split/Merge = Split

Layers

Layers for Level N = 4

Note:

To view the computational grid adaptation, create a layer Computational grid section on Plane #0.

4.3.4.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.0003 [s]

4.3.4.6 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Y+ distribution on the surface of the parallelepiped.

2. Velocity distribution in the plane of symmetry.
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4.3.4.6.1  Y+ distribution

· Create a Supergroup on the BC Wall using the Create supergroup > In Postprocessor command from
the context menu.

· Create a layer Color contours on the Supergroup.

· In the Properties window of the layer specify:

Variable

Variable = Y_plus

Value range

Mode = Manual

Max = 15

Min = 1

Notes:

· To display the palette, which is used for coloring the layer, you can use the Info window or, in properties of
the layer, set Appearance > Enabled = Yes. To open the Info window, you have to select the layer in the

tree of Postprocessor and click the  button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.

· Computation of this project may require long time.
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4.3.4.6.2  Velocity distribution

Visualization of velocity distribution when the step number is near 1100:

Velocity distribution visualized as vectors displays generation of turbulent eddies, which form and go away from
the box some time after starting the computation (initially the fluid moves behind the box symmetrically and

with no eddies)

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.

· In the Properties window of the layer specify:

Grid

Size 1 = 100

Size 2 = 100

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 12

Min = 0

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.
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Notes:

· To display the palette, which is used for coloring the layer (in our case this is coloring the vectors by their
absolute values), you can use the Info window or, in properties of the layer, set Appearance > Enabled =

Yes. To open the Info window, you have to select the layer in the tree of Postprocessor and click the 
 button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.

· Computation of this project may require long time.

4.3.5 Subsonic flow around an airfoil

The SA turbulence model is an one-parameter model, which was developed for aerospace applications. This
model can be used both in Low-Reynolds and Hi-Reynolds computations.

Low-Reynolds computations assume that the viscous boundary layer is resolved by a computational grid. We
recommend to build a grid with dimensionless distance y+  from the center of the wall cell to the wall does not
exceed 1 (the structure of the boundary layer is discussed in work H.Schlichting (1974) "Boundary layer theory"
Nauka, Moscow, 711 pages / Шлихтинг Г. (1974) "Теория пограничного слоя", Москва, Наука, 711 с.).

Consider the application of the SA model for the example problem of subsonic flow around airfoil at Reynolds

number Re = 1.68x106 and Mach number M = 0.3. In this example Hi-Reynolds computations are done, so a
quite coarse computational grid is built (the viscous boundary layer is not resolved) and wall functions are used.

Dimensions:

Chord length c = 0.256 [m]

Dimensions of the computational
domain

5.3 × 5 × 0.00254 [m × m × m]

Angle of attack a= 3 °

Substance: Air

Inflow parameters:

Static pressure: P = 100000 [Pa]
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Static temperature: T = 298 [K]

Velocity on inlet: V
inl

= 103.83 [m s-1]

Mach number: M = 0.3

Reynolds number: Re = 1.68x106

Geometry: NACA0012_3deg.STL

Project: NACA0012_3deg

Note:

Computation of this project may require significant computing resources and long time.

4.3.5.1 Physical model

In the Properties window of the element General settings specify:

Reference values

Temperature = 298 [K]

Pressure = 100000 [Pa]

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify properties of the folder Physical processes:

Heat transfer = Heat transfer via H

Motion = Navier-Stokes model

Turbulence = SA

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

· In the folder Init. data #0 specify:

Velocity

X = 103.83 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

4.3.5.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0
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Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Logarithm law

TurbKinViscosity(Phase #0) = Value in cell near wall

Boundary 2

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip
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TurbKinViscosity(Phase #0) = Symmetry 

Boundary 3

Type = Non-reflecting

Variables

Temperature(Phase #0) = Non-reflect.

Value = 0 [K]

Velocity​​(Phase #0) = Non-reflect.

Velocity at inf.

X = 103.83 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Pressure at inf. = 0 [Pa]

TurbKinViscosity(Phase #0) = Value

Value = 0 [m2 s-1]

4.3.5.3 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.634 [m]

h_min = 0.0006415 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-2.54: [m]

h = 0.634 [m]

Specify Reference line parameters for the reference line with coordinate x=0: [m]

h =0.0006415 [m]

kh- = 1

kh+ = 0.95

Specify Reference line parameters for the reference line with coordinate x=2.794: [m]

h = 0.634 [m]

for axis OY (click the button )

Grid parameters

h_max = 0.634 [m]

h_min = 0.0006415 [m]
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Insert a reference line with coordinate y=0 [m].

Specify Reference line parameters for the reference line with coordinate y=-2.54:

h =0.634 [m]

Specify Reference line parameters for the reference line with coordinate y=0: [m]

h =0.0006415 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate y=2.54: [m]

h =0.634 [m]

Click OK to close the Initial grid editor with saving the entered data.

In properties of the Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

4.3.5.4 Adaptation of the computational grid

Specify adaptation on the surface of the wing:

· From the context menu of the folder Adaptation, select the Create command to create Adaptation #0.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Boundary Conditions and in the Select boundary conditions dialog box, which opens, place the
Boundary condition, which correspond to the wall, into the pane Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 3

Layers

Layers for Level N = 5

Layers for Level N-1 = 4

Layers for Level N-2 = 4

To make parameters Layers for Level N-1 and Layers for Level N-2 available, select in the Properties

window the Layers line and twice click there the screen button  (Append item to the array).

4.3.5.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method =In seconds

Constant step = 1e-5 *) [s]

*) This notation means 10-5.

Note:

In this problem, the time step is chosen approximately equal to 0.04 of the time of flight over the wing's chord.

510
83.103

256.0
*04.0*04.0 



V

L
own
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4.3.5.6 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Mach Number distribution in the plane of the flow.

2. Pressure distribution on the surface of the wing.

4.3.5.6.1  Mach Number distribution

Visualization at the step number 5000:

· In the Properties window of Plane #0 specify:

Object
Normal

X = 0
Y = 0
Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the Color contours specify:

Variable
Variable = MachNumber

Value range

Mode = Manual
Max = 0.4

Min = 0.2
Method = Isolines
Palette

Appearance
Enabled = Yes
Style = Style 1

Notes:

· To display the palette, which is used for coloring the layer, you can use the Info window or, in properties of
the layer, set Appearance > Enabled = Yes. To open the Info window, you have to select the layer in the

tree of Postprocessor and click the  button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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4.3.5.6.2  Pressure distribution

· Create a Supergroup on the BC Wall using the command Create supergroup > In Postprocessor from
the context menu.

· Create a layer Color contours on the Supergroup.

· In the Properties window of the Color contours specify:

Variable

Variable = Pressure

Shift = 1e-5

Value range

Mode = Manual

Max = 6000

Min = -6000

Notes:

· To display the palette, which is used for coloring the layer, you can use the Info window or, in properties of
the layer, set Appearance > Enabled = Yes. To open the Info window, you have to select the layer in the

tree of Postprocessor and click the  button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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4.4 Mass transfer

In FlowVision the following mass transfer models are implemented:

· Mixing simulates convective-diffusive mixing of several Substances including simple chemical reactions
and radioactive decay.

· Chemistry simulates convective-diffusive mixing of several Substances with chemical reaction(s)

· Combustion simulates gas-phase combustion

Simulation of the mass transfer generally also assumes simulation of physical processes Motion and Heat
transfer, which are turned on by similarly-named parameters of the element Phase #N > Physical processes
in the project tree.

To simulate the mass transfer you have to start with:

· Specify Substances, which will be used in the mass transfer, and you have to specify their Aggregative
states as either Liquids or Gases.

· Add no less then two of these Substances into the simulated Phase #N. When Mixing is simulated, it is
recommended to place the Substance, which has higher mass fraction in the Phase, on the last place in the
folder Phase #N > Substances.

· In properties of each of these Substances you have to specify values of their Molar mass and Density.

· Specify the model of mass transfer (select from a drop-down list the value of the Mass transfer parameter in
properties of the element Phase #N > Physical processes in the project tree).

· Specify parameters of the mass transfer that don't depend on the mass transfer's model (Time step

coefficient, Explicit scheme, ρD or array of the Schmidt numbers), specify use of an Ablation model

(simulation of ablation requires enabling the physical process Heat transfer).

· Specify parameters D and F in the Properties windows of the elements Mass transfer > Substances >
Substance (if Mixing or Combustion is simulated).

When Chemistry or Combustion is simulated, you have also to specify other parameters of mass transfer.

When Chemistry is simulated, you have to specify:

· the Substances that take part in the chemical reactions (Phase #N > Physical processes > Mass transfer
> Elements > Substances) and their parameters

· chemical reactions (as elements Phase #N > Physical processes > Mass transfer > Reactions >
Reaction #N) and their parameters (rates of the forward and reverse reactions, stoichiometric coefficients,
coefficients of efficiencies of the Substances in the dissociation-recombination reactions)

· initial and boundary conditions on concentrations of the Substances

When Combustion is simulated, you have to specify:

· which Substances are fuel, oxidizer and products of the combustion

· the model of combustion and its parameters (stoichiometric coefficients i_1, i_2, i_3, temperature of ignition
T ignition, lower and upper combustion limits Alpha min. and Alpha max.)

· initial and boundary conditions on concentrations of the fuel, oxidizer and products of the combustion, and
variance of fuel (if Arrhenius-Magnussen combustion model is used).

· modifier(s) Ignition / extinction zone if you need to specify initiation of the combustion or specify zone(s) of
extinction

To prevent a possible instability of the solution, we recommend to specify constraints for the computation.
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4.4.1 Mixing of non-reacting substances

Consider simulation of mixing air with pure oxygen and pure nitrogen.

Parameters of the problem setting

Inflow parameters:

Mass flow rate of air V
air

= 0.129 [kg m-2s-1]

Mass flow rate of oxygen V
O2

= 1.4 [kg m-2s-1]

Mass flow rate of nitrogen V
N2

= 1.24 [kg m-2s-1]

Geometry file and project's name

Geometry: Mixture.wrl

Project: Mixture

4.4.1.1 Physical model

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

· Create Substance #0.

· Load the properties of Substance #0 from the Substance Database:

Substances = Oxygen

Phases = Gas (equilibrium)
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· Create Substance #0.

· Load the properties of Substance #0 from the Substance Database:

Substances = Nitrogen

Phases = Gas

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add all Substances, which you have just created, into the folder Substances in the following
order:

o Oxygen_Gas (equilibrium)

o Nitrogen_Gas

o Air_Gas (equilibrium)

When Mixing is simulated, we recommend to place the Substance, which has higher mass fraction in the
Phase, on the last place in the folder Phase #N > Substances.

· In the Properties window of the folder Phase #0 > Physical processes specify:

Motion = Navier-Stokes model

Mass transfer = Mixing

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases

In the Properties window of the SubRegion #0, specify:

Model = Model #0
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4.4.1.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Velocity​​(Phase #0) = Logarithm law

Mass frac._ [Oxygen_Gas (equilibrium)] (Phase #0) = Zero gradient

Mass frac._ [Nitrogen_Gas] (Phase #0) = Zero gradient

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Type = Symmetry

Variables

Velocity​​(Phase #0) = Slip

Mass frac._ [Oxygen_Gas (equilibrium)] (Phase #0) = Symmetry

Mass frac._ [Nitrogen_Gas] (Phase #0) = Symmetry

TurbEnergy (Phase #0) = Symmetry

TurbDissipation (Phase #0) = Symmetry

Boundary 3

Type = Inlet/Outlet

Variables
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Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 0.129 [kg m-2 s-1]

Mass frac._ [Oxygen_Gas (equilibrium)] (Phase
#0)

= Value at the inlet

Value = 0

Mass frac._ [Nitrogen_Gas] (Phase #0) = Value at the inlet

Value = 0

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Boundary 4

Type = Inlet/Outlet

Variables

Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 1.4 [kg m-2 s-1]

Mass frac. [Oxygen_Gas (equilibrium)] (Phase
#0)

= Value at the inlet

Value = 1

Mass frac._ [Nitrogen_Gas] (Phase #0) = Value at the inlet

Value = 0

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Boundary 5

Type = Inlet/Outlet

Variables

Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 1.24 [kg m-2 s-1]

Mass frac. [Oxygen_Gas (equilibrium)] (Phase
#0)

= Value at the inlet

Value = 0

Mass frac. [Nitrogen_Gas] (Phase #0) = Value at the inlet

Value = 1

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Boundary 6

Type = Free Outlet

Variables
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Velocity​​ (Phase #0) = Pressure

Value = 0 [Pa]

Mass frac. [Oxygen_Gas (equilibrium)] (Phase
#0)

= Zero gradient

Mass frac. [Nitrogen_Gas] (Phase #0) = Zero gradient

TurbEnergy (Phase #0) = Zero gradient

TurbDissipation (Phase #0) = Zero gradient

 

4.4.1.3 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 200

nY = 100

In the Properties window of the Initial grid click Apply.

4.4.1.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.1 [s]

4.4.1.5 Visualization

To view the dynamics of the solution during the computation, specify visualization of Concentration
distribution in the plane of the flow before the start of computation.

4.4.1.5.1  Concentration distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the new Color contours #0 layer specify:

Variable

Category = Variables of phase "Phase #0"

Variable = Mass. frac. [Air_Gas (equilibrium)]

Value range

Mode = Manual

Max = 1
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Min = 0

To display the palette, which is used for coloring the layer, you can use the Info window or, in
properties of the layer, set Appearance > Enabled = Yes. To open the Info window, you have to

select the layer in the tree of Postprocessor and click the  button.

At the beginning of the computation, the Color contours #0 layer will look as shown below:

After 1000 iterations the stream pattern will settle as shown on the illustration below:

4.4.2 Radioactive decay

Consider the simulation of radioactive decay of an isotope.

Parameters of the problem setting

The length of the area: L = 0.7 [m]

Inflow parameters:

Flow velocity: V = 1 [m s-1]
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Mass fraction of isotopes: Y = 10-3

Properties of sodium with the isotope:

Molar mass M = 0.023 [kg mole-1]

Density r = 925 [kg m-3]

Viscosity m = 6.68×10-4 [kg m-1 s-1]

Thermal conductivity l = 84.9 [W m-1 K-1]

Specific heat Cp = 1382 [J kg-1 K-1]

Geometry file and project's name

Geometry: Isotope.wrl

Project: Isotope

4.4.2.1 Physical model

In properties of the element General settings specify:

Reference values

Temperature = 373 [K]

In the folder Substances:

· Create Substance #0.

· In properties of Substance #0 specify:

Name = Sodium

Aggregative state = Liquid

Molar mass

Value = 0.023 [kg mole-1]

Density

Value =925 [kg m-3]

Viscosity

Value = 6.68e-4 [kg m-1s-1]

Thermal conductivity

Value = 84.9 [W m-1K-1]

Specific heat

Value = 1382 [J kg-1 K-1]

Enthalpy of formation

Value = 0 [J kg-1]

· Copy Sodium.

· In properties of the new Substance specify:

Name = Isotope

Enthalpy of formation

Value = 1e6 [J kg-1]

In the folder Phases:
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· Create a continuous Phase #0.

· In Phase #0 add both the just created substances into the folder Substances in the following order:
o Isotope

o Sodium

Sodium is placed on the second place because its mass fraction in the Phase is greater.

· In properties of of the folder Phase #0 > Physical processes specify:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

Mass transfer = Mixing

In properties of the element Phases > Phase #0 > Physical processes > Mass transfer > Substances >
Isotope specify:

D = -925

In the folder Models:

· Create Model #0.

· Add Phase #0 into the subfolder Model #0 > Phases.

In properties of SubRegion #0, specify Model = Model #0.

4.4.2.2 Boundary conditions

Specify boundary conditions:

Boundary 1

Type = Inlet/Outlet

Variables

Temperature (Phase #0) = Temperature

Value = 0 [K]

Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 925 [kg m-2 s-1]

Mass frac. [Isotope] (Phase #0) = Value at the inlet

Value = 1e-3

Boundary 2

Type = Free Outlet

Variables
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Temperature (Phase #0) = Zero gradient

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

Mass frac._ [Isotope] (Phase #0) = Zero gradient

Boundary 3

Type = Symmetry

Variables

Temperature (Phase #0) = Symmetry

Velocity ​​(Phase #0) = Slip

Mass frac._ [Isotope] (Phase #0) = Symmetry

4.4.2.3 Initial grid

In properties of the Initial grid specify:
Grid structure = 1D
Direction = X
nX = 250

In the Properties window of the Initial grid click Apply.

4.4.2.4 Parameters of calculation

In the Solver tab in properties of the Time step element specify:

Method = Via CFL number

Convective CFL = 1

Diffusive CFL = 1

Max step = 0.01 [s]

4.4.2.5 Visualization

Specify visualization of:

1. Isotope concentration distribution in the plane of the flow

2. Temperature distribution in the plane of the flow
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4.4.2.5.1  Isotope concentration distribution

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create the layer Color contours #0 on Plane #0.

· In properties of Color contours #0 specify:

Variable

Category = Variables of phase "Phase #0"

Variable = Mass. frac. [Isotope]

Palette

Appearance

Enabled = Yes

Style = Style 3
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4.4.2.5.2  Temperature distribution

· Create a Color contours layer in Plane #0.

· In the Properties window of the Color contours specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 0.35

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1

4.4.3 Chemistry (Dissociation of Nitrogen)

In this example we simulate dissociation of nitrogen, which includes two reversible chemical reactions:

1. N
2
 + N

2
 ↔ 2N + N

2

2. N
2
 + N ↔ 2N + N

Parameters of the problem setting

The length of the area: = 0.7 [m]

Inflow parameters:

Flow velocity: = 14 [m s-1]

Mass fraction of N
2
 on inlet: = 100%
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Geometry file and project's name:

Geometry: Isotope.wrl

Project: Dissociation_N2

4.4.3.1 Physical model

Create a project based on the geometry file Isotope.wrl (this file used before for the exercise Radioactive

decay).

In the Properties window of the element General settings specify:

Reference values

Temperature = 300 [K]

Pressure = 101325 [Pa]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = N2

Aggregative state = Gas

Molar mass

Value = 0.028 [kg mole-1]

Density

Value = Ideal gas law [kg m-3]

Specific heat

Value = 1039.3 [J kg-1 K-1]

Enthalpy of formation

Value = 0 [J kg-1]

· Create another Substance and specify its properties:

Name = N

Aggregative state = Gas

Molar mass

Value = 0.014 [kg mole-1]

Density

Value = Ideal gas law [kg m-3]

Specific heat

Value = 1484.7 [J kg-1 K-1]

Enthalpy of formation

Value = 33762857.1 [J kg-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add both the just created substances (N2 and N) into the folder Substances.

· In the Properties window of the folder Phase #0 > Physical processes specify:
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Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

Mass transfer = Chemistry

· In the folder Phases > Phase #0 > Physical processes > Mass transfer > Reactions create Reaction #0
using the Create command of the command menu.

· In the Properties window of the just created Reaction #0 specify*):

Af = 192000000000

nf = -0.5

Tf = 113100

Ar = 10900

nr = -0.5

Tr = 0

Stoichiometric coeffs. > N > Real = 2

Stoichiometric coeffs. > N > Effective = 2

Stoichiometric coeffs. > N2 > Real = -1

Stoichiometric coeffs. > N2 > Effective = -1

Efficiencies > N = 0

Efficiencies > N2 = 2.5

*) constants of the forward and reverse reactions N
2
 + N

2
 ↔ 2N + N

2
 are defined by the following

expressions:

k
f ,1

 = 1.92∙1011T -0.5 e-113100/T

k
r,1

 = 1.09∙104T -0.5

Reaction #0 (N
2
 + N

2
 ↔ 2N + N

2
) has the following molar formula:

N
2
 ↔ 2N

According to this formula, the real stoichiometric coefficients are specified as follows:

· -1 for molecular nitrogen N
2

· 2 for atomic nitrogen N

For Substances from the left side of the molar reaction formula, stoichiometric coefficients are specified
as negative values. For Substances from the right side of the formula, stoichiometric coefficients are
specified as positive values.

The simulated chemical reactions are elementary, so effective stoichiometric coefficients are the same
as the real ones.

· In the folder Phases > Phase #0 > Physical processes > Mass transfer > Reactions create another
chemical reaction, Reaction #1.

· In properties of Reaction #1 specify**):

Af = 4.15e+016

nf = -1.5

Tf = 113100

Ar = 2320000000

nr = -1.5

Tr = 0

Stoichiometric coeffs. > N > Real = 2

Stoichiometric coeffs. > N > Effective = 2
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Stoichiometric coeffs. > N2 > Real = -1

Stoichiometric coeffs. > N2 > Effective = -1

Efficiencies > N = 1

Efficiencies > N2 = 0

**) constants of the forward and reverse reactions N
2
 + N ↔ 2N + N are defined by the following

expressions:

k
f ,2

 = 4.15∙1016T -1.5 e-113100/T

k
r,2

 = 2.32∙109T -1.5

Reaction #1 (N
2
 + N ↔ 2N + N) has the same molar formula, N

2
 ↔ 2N.

So you have to specify for it the same stoichiometric coefficients.

In the folder Models:

· Create Model #0.

· Add Phase #0 into the subfolder Model #0 > Phases.

In the Properties window of SubRegion #0, specify Model = Model #0.

4.4.3.2 Boundary conditions

Specify boundary conditions:

Boundary 1

Type = Inlet/Outlet

Variables

Temperature (Phase #0) = Temperature

Value = 4700 [K]

Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 1 [kg m-2 s-1]

Mass frac. [N2](Phase #0) = Value at the inlet

Value = 1

Mass frac. [N](Phase #0) = Value at the inlet

Value = 0

Boundary 2

Type = Free Outlet

Variables
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Temperature (Phase #0) = Zero gradient

Velocity​​ (Phase #0) = Pressure

Value = 0 [Pa]

Mass frac. [N2](Phase #0) = Zero gradient

Mass frac. [N](Phase #0) = Zero gradient

Boundary 3

Type = Symmetry

Variables

Temperature (Phase #0) = Symmetry

Velocity​​ (Phase #0) = Slip

Mass frac. [N2](Phase #0) = Symmetry

Mass frac. [N](Phase #0) = Symmetry

4.4.3.3 Initial conditions

In properties of child elements in the subfolder Models > Model #0 > Init. data > Init. data #0 specify:

o for the element Temperature (Phase #0) specify Value = 4700.

o for the element Velocity (Phase #0) specify Value > X = 14, Value > Y = 0, Value > Z = 0.

o for the element Pressure (Phase #0) specify Value = 0.

o for the element Mass frac. [N2] (Phase #0) specify Value = 1.

o for the element Mass frac. [N] (Phase #0) specify Value = 0.

In properties of the element SubRegion #0 > Initial conditions > Init. condition #0 specify:

Object = Computational space

Init. data = Init. data #0

4.4.3.4 Initial grid

In properties of the Initial grid specify:
Grid structure = 1D
Direction = X
nX = 250

In the Properties window of the Initial grid click Apply.

4.4.3.5 Parameters of calculation

In the Solver tab in properties of the Time step element specify:

Method = Via CFL number

Convective CFL = 5

Diffusive CFL = 5
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Max step = 1 [s]

4.4.3.6 Visualization

Create a Layer, which will display distribution of mass fraction of dissociated nitrogen:

· In properties of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create the layer Color contours #0 on Plane #0.

· In properties of Color contours #0 specify:

Name = Mass frac. N

Variable

Category = Variables of phase "Phase #0"

Variable = Mass frac. [N]

Palette

Appearance

Enabled = Yes

Title = Yes

Style = Style 3

Run the calculation of the project and view the distribution of fraction of dissociated nitrogen.
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4.4.4 Combustion

Consider simulating the combustion of natural gas in the air.

Parameters of the problem setting

Length of the tube: L = 0.1 [m]

Substances

Fuel = Natural Gas

Oxidant = Air

Inflow parameters:

Speed ​​of natural gas: V = 75 [m s-1]

Pressure: P = 101 000 [Pa]

Mixture combustion parameters:

Steheometrichesky ratio of
oxidant

i_1 = 16.92

Steheometrichesky ratio of
combustion products

i_2 = 17.92

Flashpoint T = 923 [K]

Alpha min. α_min = 0.6

Alpha max. α_max = 1.9

Geometry file and project's name

Geometry: Combustion.wrl

Project: Combustion

4.4.4.1 Physical model

In the Properties window of the element General settings specify:

Reference values

Temperature = 298 [K]

Pressure = 101000 [Pa]

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:
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o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Natural Gas

Phases = Gas (equilibrium)

· CreateSubstance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas

· CreateSubstance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Natural gas+Air, products

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0, add into the folder Substances all the just created substances:
o Natural gas_Gas (equilibrium)

o Air_Gas

o Natural gas+Air, products_Gas (equilibrium)

· Specify properties of the folder Phase #0 > Physical processes:

Heat transfer = Heat transfer via H

Motion = Navier-Stokes model

Mass transfer = Combustion

Turbulence = KES

In Phase #0 > Physical Processes > Mass transfer specify:

Combustion model = Arrhenius-Magnussen

i_1 = 16.92

i_2 = 17.92

T ignition = 923 [K]

Alpha min. = 0.6

Alpha max. = 1.9

Fuel = Natural gas_Gas (equilibrium)

Oxidizer = Air_Gas

Product-1 = Natural gas+Air, products_Gas (equilibrium)

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases
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In the Properties window of the SubRegion #0, specify:

Model = Model #0

4.4.4.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Logarithm law

Mass frac._[Natural gas_Gas (equilibrium)](Phase #0) = Zero gradient

Mass frac._[Natural gas+Air,products_Gas (equilibrium)](Phase
#0)

= Zero gradient

Variance of fuel(Phase #0) = Zero gradient

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Boundary 2
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Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity(Phase #0) = Slip

Mass frac._[Natural gas_Gas (equilibrium)](Phase #0) = Symmetry

Mass frac._[Natural gas+Air,products_Gas (equilibrium)](Phase
#0)

= Symmetry

Variance of fuel(Phase #0) = Symmetry

TurbEnergy (Phase #0) = Symmetry

TurbDissipation (Phase #0) = Symmetry

Boundary 3

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 0 [K]

Velocity​​(Phase #0) = Normal mass velocity

Mass velocity = 50 [kg m-2s-1]

Mass frac._[Natural gas_Gas (equilibrium)](Phase #0) =Value at the inlet

Value = 1

Mass frac._[Natural gas+Air,products_Gas (equilibrium)]
(Phase #0)

=Value at the inlet

Value = 0

Variance of fuel(Phase #0) =Value at the inlet

Value = 0

TurbEnergy(Phase #0) = Pulsations

Value = 0.03

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.0008 [m]

Boundary 4

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 0

Velocity​​(Phase #0) = Inlet pressure

Value = 0 [kg m-2s-1]

Mass frac._[Natural gas_Gas (equilibrium)](Phase #0) = Value at the inlet

Value = 0

Mass frac._[Natural gas+Air,products_Gas (equilibrium)]
(Phase #0)

= Value at the inlet

Value = 0

Variance of fuel(Phase #0) = Value at the inlet

Value = 0

TurbEnergy(Phase #0) = Pulsations  

Value = 0.03

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]
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4.4.4.3 Ignition

In this simulation, you have to burn the fuel in the area where the fuel is mixing with the oxidant.

To do this, you have to specify an Ignition Modifier located in this area.

The procedure of setting a Modifier consists of two steps:
· specifying an area where the Modifier is to be active
· specifying the Modifier in this area

Specify the area where the Modifier is to be active:

· In the folder Objects create a Cone/cylinder.

· In the Properties window of the object Cone/cylinder #0 specify:

Location

Reference point

X = 0.11 [m]

Y = 0 [m]

Z = 0 [m]

Parameters

Height = 0.0005 [m]

Radius 1 = 0.01 [m]

Radius 2 = 0.01 [m]

Base ratio = 1

Channel = None

Create a Modifier for ignition:

· From the context menu of the folder Modifiers, select Create.

· In the Create new modifier window, specify:

Modifier type = Ignition / extinction zone

Objects = Cone/cylinder #0

· In the Properties window of the just created Ignition / extinction zone #0 modifier specify:

Activation

Type = Only once by step
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Start in steps = 10

Duration in steps = 40

Type = Ignition

Note:

It is recommended not to activate an Ignition at the beginning of the computation but only after the flow is
formed.

After switching an Ignition off, the flame can temporarily extinguish.

4.4.4.4 Initial conditions

Specify parameters of the initial distribution of the oxidant:

· In properties of child elements in the folder Models > Model #0 > Init. data > Init. data #0 specify:

o for the element Velocity ​​(Phase #0):

X = 0.1 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

o for the element Pulsations (Phase #0):

Value = 0.03

o for the element Turbulent scale (Phase #0):

Value = 0.01 [m]

Specify the parameters for the initial distribution of fuel:

· In the folder Models > Model #0 > Init. data create Init. data #1.

· In properties of child elements of Init. data #1 specify:

o for the element Velocity ​​(Phase #0):

X = 75 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

o for the element Mass frac._Natural gas_Gas (equilibrium)(Phase #0):

Value = 1

o for the element Pulsations (Phase #0):

Value = 0.03

o for the element Turbulent scale (Phase #0):

Value = 0.0008 [m]

· In the Objects folder create Cone/cylinder #1.

· In properties of Cone/cylinder #1 specify:

Parameters

Height = 0.105 [m]

Radius 1 = 0.005 [m]

Radius 2 = 0.005 [m]

Base ratio = 1

· In the folder SubRegion #0 > Initial conditions create the object Init. condition #1.

· In the Properties window of the object Init. condition #1 specify:

Object = Cone/cylinder #1
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Init. data = Init. data #1

4.4.4.5 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.025 [m]

h_min = 0.0005 [m]

Insert a reference line with coordinate x=0.11 [m].

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.005 [m]

kh+ = 0.9

Specify Reference line parameters for the reference line with coordinate x=0.11:

h = 0.0005 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=1:

h = 0.025 [m]

kh- = 0.9

for axis OY (click the button )

Grid parameters

h_max = 0.025 [m]

h_min = 0.0005 [m]

Specify Reference line parameters for the reference line with coordinate y=0:

h = 0.0005 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate y=0.25:

h = 0.025 [m]

kh- = 1

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.
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In the Postprocessor tab, in properties of the element Layers > Initial grid specify Lines > Color = Black.

4.4.4.6 Parameters of calculation

Specify in the Solver tab:

· In properties of the Time step element specify:

Method = Via CFL number

Convective CFL = 500

Max step = 0.001 [s]

· In properties of the Limiters > Limiters for calculation > Phase limiters > Phase #0 element specify:

Limiter

Density, min. = 0.01 [kg m-3]

Temperature abs, min. = 200 [K]

Temperature abs, max. = 3000 [K]

Velocity, max. = 1000 [m s-1]

Pressure abs, min. = 1000 [Pa]

Pressure abs, max. = 300000 [Pa]

· In properties of the Stopping conditions > Time steps element specify Number = 50.

4.4.4.7 Preliminary and the main calculations

On the Solver tab in properties of the element Advanced settings specify:

Numerical method > Type of scheme = Implicit

Numerical method > Pressure gradient = Simple

Start the project's computation.

After 50 steps (when the ignition finishes its activity) stop the computation and on the Solver tab in properties
of the Time step element specify:

Method = Via CFL number

Convective CFL = 10

(Value of the Max step parameter is not changed)

To obtain a stable flow it is necessary to run the computation with a large number of steps.

· On the Solver tab in properties of the Stopping conditions > Time steps element specify Number =
12000.

· Continue the computation.

4.4.4.8 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Oxidant excess factor's distribution in the plane of the flow.

2. Temperature distribution in the plane of the flow.
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4.4.4.8.1  Oxidant excess factor's distribution

Visualization at the step number 12000:

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the Color contours #0 specify:

Variable

Category = Variables of phase "Phase #0"

Variable = Oxid excess factor rec.

Value range

Mode = Manual

Max = 2

Min = 0.4

Palette

Appearance

Enabled = Yes

4.4.4.8.2  Temperature distribution

Visualization at the step number 12000:

· Create a Color contours layer on Plane #0.

· In the Properties window of the layer Color contours #1 specify:

Variable

Variable = Temperature

Value range
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Mode = Manual

Max = 1800

Min = 0

Palette

Appearance

Enabled = Yes
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4.5 Free surface

In FlowVision for simulating free surface the VOF method is implemented.

In order to simulate the movement of a liquid and take into account its free surface, you have to:
· In properties of the Substance specify Aggregative state = Liquid.
· In properties of the Substance you must specify the value of the Density.
· You have to create two Phases, then add into one Phase the Substance and enable there the computation

of the equations of Motion, and the other Phase leave empty.
· Add both Phases into one Model, using the rule: the Phase with Movement should locate on the first place

in the list, and the empty Phase should locate on the second place.
· Specify the appropriate boundary conditions for the variable VOF (volume of fluid, used in simulations with a

free surface), and be sure that to specify somewhere in the computational domain the initial value VOF=1.
· Use the time step, which does not exceed 5×Surface CFL. When the shape of the free surface changes

significantly, it is recommended to use the time step, which corresponds to 1×Surface CFL.

In order to simulate the movement of the two liquids or a liquid and gas based interface, you have to:
· Create two Substances and set their Aggregate states as Liquid/Liquid or Liquid/Gas.
· In properties of the Substances you must specify the value of their Densities or specify calculation of a

Density according to the ideal gas law.
· Create two Phases, then add into each Phase an appropriate Substance, then enable the computation of

the equations of Motion.
· Add both Phases into one Model, and the first on the list should be the Phase, which has the Substance

with the bigger Density.
· Specify the appropriate boundary conditions for the variables VOF of each Phase, and be sure to specify

somewhere in the computational domain the initial value VOF=1.
· Use the time step, which does not exceed 5×Surface CFL. When the shape of the free surface changes

significantly, it is recommended to use the time step, which corresponds to 1×Surface CFL.

4.5.1 Broken dam

In this example, a collapse of a dam is simulated in two dimensions. A part of the computational domain is
filled with water, which is confined by a wall (the dam). Initially, the dam is quickly removed and a wave begins
to move.
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Parameters of the problem setting

Dimensions:

Dimensions of the computational domain a × b = 5×3 [m × m]

Dimensions of the liquid's column d × d = 2×2 [m × m]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Geometry: Wave.STL

Project: Wave

4.5.1.1 Physical model

In the Properties window of the element General settings specify:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KES

· Create a continuous Phase #1.

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.
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Notes:

1. In this simulation, the flow in the second phase can be neglected, so the Physical processes are not set in
Phase #1. And the Phase, in which physical processes are not specified, must always be the second in the
folder Model #N > Phases.

2. After loading Phase #0 and Phase #1 into the Model, the Phase interaction element (of the Continuum-
vacuum type) automatically appears and the Phase transfer element appears in Physical processes of
Phase #0.

4.5.1.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions: 

Boundary 1

Type = Wall

Variables

Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

VOF(Phase #0) =Symmetry
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Boundary 2

Type =Symmetry 

Variables

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry

TurbDissipation(Phase #0) = Symmetry

VOF(Phase #0) =Symmetry

4.5.1.3 Specification of the water column

When simulating the of liquid's motion with taking into account the free surface, you always have to set the
initial distribution of phases.

Specify the initial data in the Properties window of the element Model #0 > Init. data > Init. data #0 >
VOF(Phase #0):

Value = 1

To define the area where the initial data are applied, do the following in the folder Objects:

· Create Box #0.

· In properties of Box #0 specify:

Location

Reference point

X = 1 [m]

Y = 1 [m]

Z = 0.025 [m]

Size

X =2 [m]

Y =2 [m]

Z = 0.05 [m]

In the View window an image of Box #0 will appear:
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To define the matching between the geometrical Object and the Initial data, specify in properties of the
element SubRegion #0 > Initial conditions > Initial. conditions #0:

Object = Box #0

Init. data = Init. data #0

Method = Replace in cropped volume

Thus, in the volume of the box, a variable is set as VOF=1, which corresponds to the presence (at the initial
time moment) a water column with dimensions 2×2 [m].
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4.5.1.4 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.125 [m]

h_min = 0.03 [m]

Insert reference lines with coordinates:

x1 = 1 [m]

x2 = 4 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

[m]

h = 0.03 [m]

Specify Reference line parameters for the reference line with coordinate x=1:

h = 0.125 [m]

Specify Reference line parameters for the reference line with coordinate x=4:

h = 0.125 [m]

Specify Reference line parameters for the reference line with coordinate x=5:

h = 0.03 [m]

for axis OY (click the button )

Grid parameters

h_max = 0.1 [m]

h_min = 0.03 [m]

Insert reference lines with coordinates:

y1 = 0.5 [m]

y2 = 2.5 [m]

Specify Reference line parameters for the reference line with coordinate y=0:
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h = 0.03 [m]

Specify Reference line parameters for the reference line with coordinate y=0.5:

h = 0.1 [m]

Specify Reference line parameters for the reference line with coordinate y=2.5:

h = 0.1 [m]

Specify Reference line parameters for the reference line with coordinate y=3:

h = 0.03 [m]

Click OK to close the Initial grid editor with saving the entered data.

In properties of the Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

4.5.1.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Surface CFL = 1

Max step = 0.01 [s]

4.5.1.6 Visualization

To view the dynamics of the solution during the computation, specify visualization of liquid's distribution in the
plane of symmetry before the start of computation.

4.5.1.6.1  Distribution of the liquid
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· Create a VOF layer on the Computational space.

4.5.2 Free jet

In this example, consider the motion of a free two-dimensional jet in the gravity field.

Parameters of the problem setting

Free fall acceleration g = 9.8 [m s-2]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Inlet parameters:

Velocity of the flow V = 3 [m s-1]

Initial angle between the flow and the horizon α = 45

Geometry FreeJet.STL

Project: FreeJet

4.5.2.1 Physical model

In the Properties window of the element General settings specify:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass
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Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

· Create a continuous Phase #1.

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.

4.5.2.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions: 

Boundary 1

Type = Symmetry

Variables

Velocity ​​(Phase #0) = Slip

VOF (Phase #0) =Symmetry



212FlowVision Help

 

Boundary 2

Type = Inlet/Outlet

Variables

Velocity (Phase #0) = Normal mass velocity

Mass velocity = 3000 [kg m-2 s-1]

VOF (Phase #0) = Value

Value = 1

Boundary 3

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

VOF (Phase #0) = Zero gradient

4.5.2.3 Initial conditions

In simulations with a free surface it is necessary that some volume of the liquid be present in the region at the
initial time moment.

Specify the initial volume of liquid in the area where the flow goes into the subregion without the liquid:
· In properties of the element Model #0 > Init. data #0 specify:

Velocity

X = 2.12 [m s-1]

Y = 2.12 [m s-1]

Z = 0 [m s-1]

VOF

Value = 1

· In the folder Objects, create Box #0.

· In properties of Box #0 specify:

Location

Reference point

X = 0.1 [m]

Y = 0.1 [m]

Z = 0.05 [m]

Axis X

X = 1

Y = 1

Z = 0

Size

X = 0.1 [m]

Y = 0.07 [m]

Z = 0.1 [m]

· In properties of the element SubRegion #0 > Initial conditions > Init. condition #0 specify:

Object = Box #0

Init. data = Init. data #0
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Method = Replace in cropped volume

Note:

After clicking the Apply button in the Properties window of Box #0, the vectors of the coordinate system of the
box will be automatically redirected and orthonormalized.

4.5.2.4 Initial grid

Specify in the Properties window of the Initial grid:
Grid structure = 2D
Plane = XY
nX = 150
nY = 50

In the Properties window of the Initial grid click Apply.

4.5.2.5 Adaptation on the inter-phase surface

For better accuracy of simulating multiphase flows, it is recommended to use more refined computational grid
on the inter-phase surface. You can do this by applying adaptation of the computational grid that will become
active depending on value of the variable VOF (when 0 < VOF < 1 in a cell, the free surface passes through this
cell).

As in this exercise the inter-phase surface moves over the computational domain, use of only an Adaptation
by condition will cause refining the grid even in areas where it is not necessary anymore (due to the inter-
phase surface changed its location) as shown on the illustration below:
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The Computational grid section layer when only Adaptation by condition is used (no merging is done in the areas,
from which the free surface has get away). The grid contains 920 computational cells.

To prevent waste of the computational grid, you should to set adaptation on the free surface; this adaptation will
move together with the jet and will refine the grid near the inter-phase surface only:

The Computational grid section layer when adaptation on the moving inter-phase surface is used. The grid contains
590 computational cells.

The adaptation on the moving inter-phase surface consists of combination of the three adaptation listed below:

1. A simple Adaptation inside the geometry object, in which Initial conditions were set (this object is Box
#0). In the project tree, in the folder Computational grid > Adaptation create Adaptation #0 within the object
Box #0. In properties of Adaptation #0 specify:

Enabled = Yes
Max level N = 1
Split/Merge = Split
Layers > Layers for Level N = 3

Grid adaptation within the object with Initial conditions is required only until obtaining a correct solution on the
first computational step. After computing the first step, you can disable Adaptation #0.

The grid adaptation settings are applied before placing the free surface, so surface of the jet will not be resolved
yet by the grid on the first computational step. And when the adaptation level changes on the next
computational step, the inter-phase surface might move away. So the rule follows from this: the adaptation level
near the inter-phase surface should not change during the whole computation.

2. Adaptation by condition, which will be working depending on value of the variable VOF. In the project tree,
in the folder Computational grid > Adaptation by condition create Adaptation by condition #0 and in its
properties specify:

Enabled = Yes
Max level N = 1
Layers > Layers for Level N = 3
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Conditions > Variable > Category = Variables of phase "Phase #0"
Conditions > Variable > Variable = VOF
Conditions > Range > From = 0.0001
Conditions > Range > To = 0.9999

Specifying Range of the variable VOF from 0.0001 to 0.9999 provides applying Adaptation by condition #0
just on the inter-phase surface (because VOF (Phase #0) = 1 within the jet, VOF (Phase #0) = 0 outside the
jet, and 0 < VOF (Phase #0) < 1 on the inter-phase surface). You can set other limits of the range within values
0 < VOF (Phase #0) < 1 but more closer are the limits to values 0 and 1, the more accurate resolution of the
free surface by the grid will be.

From the context menu of the element Adaptation by condition > Adaptation by condition #0 > Object
select the command Add/Remove Objects and in the dialog box, which opens, add the Computational
space object into the list of the selected objects and then click OK.

3. A simple Adaptation that merges cell. This adaptation will cancel the grid refining that was made by
Adaptation by condition #0, it restores the initial size of cells in the areas, from which the jet get away. In the
project tree, in the folder Computational grid > Adaptation create Adaptation #1 within the object
Computational space and in its properties specify:

Enabled = Yes
Max level N = 0
Split/Merge = Merge

4.5.2.6 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Surface CFL = 1

Max step = 0.01 [s]

4.5.2.7 Visualization

To view the dynamics of the solution during the computation, specify visualization of: liquid's distribution before
the start of computation.

4.5.2.7.1  Distribution of the liquid

· Create a VOF layer on the Computational space.
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4.5.3 Displacement of oil by water

In this example, consider the displacement oil by water from a tank. At the initial moment of the time, the tank
is completely filled with oil. From the hole in the side wall of the tank the water comes into and gradually
displace the oil from the tank.

Parameters of the problem setting

Parameters of water:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Surface tension s = 0.073 [N m-1]

Parameters of oil:

Density r = 500 [kg m-3]

Viscosity m = 0.01 [kg m-1s-1]

Surface tension s = 0.0647 [N m-1]

Inlet parameters:

Velocity of water, which is being fed V = 0.1 [m s-1]

 

Geometry TwoFluids.wrl

Project: TwoFluids
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4.5.3.1 Physical model

In the Properties window of the element General settings specify:

· Specify the following parameters:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

g-Point

X = 0 [m]

Y = 0.25 [m]

Z = 0 [m]

g-Density = 500 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

Surface tension

Value = 0.073 [N m-1]

· Create Substance #1.

· Specify the following properties of Substance #1:

Aggregative state = Liquid

Molar mass

Value =0.009 [kg mole-1]

Density

Value = 500 [kg m-3]

Viscosity

Value = 0.01 [kg m-1s-1]

Specific heat

Value =2688 [J kg-1 K-1]

Surface tension

Value =0.0647 [N m-1]

In the folder Phases:

· Create a continuous Phase #0.
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· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

· Create a continuous Phase #1.

· In Phase #1 add Substance #1 into the folder Substances.

· Specify properties of the folder Phase #1 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.

Notes:

1. In this simulation, Phase #0 should be placed on the first position in the Model, because its density is
bigger then density of Phase #1.

2. After loading Phase #0 and Phase #1 into the Model, the Phase interaction element (of the Continuum-
continuum type) automatically appears and the Phase transfer element appears in Physical processes of
Phase #1.
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4.5.3.2 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Typ
e

= Inlet/Outlet

Variables

Velocity​​ (Phase #0) = Normal mass velocity

Mass velocity = 100 [kg m-2s-1]

VOF (Phase #0) = Value

Value = 1

Velocity​​ (Phase #1) = Normal mass velocity

Mass velocity = 0 [kg m-2s-1]

VOF (Phase #1) = Value



220FlowVision Help

 

Value = 0

Boundary 2

Type = Symmetry

Variables

Velocity​​(Phase #0) = Slip

VOF (Phase #0) = Symmetry

Velocity​​(Phase #1) = Slip

VOF (Phase #1) = Symmetry

Boundary 3

Type = Free Outlet

Variables

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

VOF (Phase #0) = Zero gradient

Velocity​​(Phase #1) = Pressure

Value = 0 [Pa]

VOF (Phase #1) = Zero gradient

Boundary 4

Type = Wall

Variables

Velocity​​(Phase #0) = No slip

VOF (Phase #0) = Symmetry

Velocity​​(Phase #1) = No slip

VOF (Phase #1) = Symmetry

4.5.3.3 Initial conditions defining volumes of liquids

In Model #0:

· In Init. data #0 specify:

VOF(Phase #1)

Value = 0

· Create Init. data #1.

· In Init. data #1 specify:

Velocity(Phase #0)
Value

X = 0.1 [m s-1]
VOF(Phase #0)

Value = 1

Before creating Init. condition #1 you have to create Box #0, which is a bit smaller than the inlet.

In properties of Init. condition #1, which will be created on Box #0, Method = Replace in full
volume will be specified, so the water will initially fill the whole inlet due to cells that even partially
contact Box #0.

In the folder Objects:

· Create Box #0.
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· In the Properties window of Box #0 specify:

Location
Reference point

X = 0 [m]
Y = 0.06 [m]
Z = 0.005 [m]

Size
X = 0.04 [m]
Y = 0.035 [m]
Z = 0.01 [m]

In SubRegion #0:

· Make sure that in properties of the element Initial conditions > Init. condition #0 the following settings are
specified:

Object = Computational space
Init. data = Init. data #0

· Create the element Initial conditions > Init. condition #1.

· In properties of Init. condition #1 specify:

Object = Box #0
Init. data = Init. data #1
Method = Replace in full volume
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4.5.3.4 Initial grid

Specify in the Properties window of the Initial grid:
Grid structure = 2D
Plane = XY
nX = 50
nY = 100

In the Properties window of the Initial grid click Apply.

4.5.3.5 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Surface CFL = 1

Max step = 1 [s]

4.5.3.6 Visualization

To view the dynamics of the solution during the computation, specify visualization of the liquid's surface before
the start of computation.
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4.5.3.6.1  Water distribution

· Create a VOF layer on the Computational space.
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4.6 Dispersed media

The implemented model of dispersed medium allows solving the following problems:
· flow of liquid/gas in porous carcass
· motion of solid particles in liquid/gas
· motion of droplets in liquid/gas
· motion of bubbles in liquid

We provide the following exercises related to dispersed media:
· Droplet evaporation in air
· Coal combustion

4.6.1 Droplet evaporation in air

Consider the evaporation of droplets in the air because of being heated:

Parameters of the problem setting

Inflow parameters:

Mass flow rate of air: V = 0.5522 [kg m-2 s-1]

Air temperature: T
air

= 10 [K]

Water droplets' temperature T
drops

= 0 [K]

Diameter of the water droplets d = 0.0001 [m]

Fraction of water droplets: = 0.001

Parameters of the heat source

Power P = 2e6 [W m-3]

Geometry: Drops.wrl

Project: Drops

4.6.1.1 Physical model

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

· Create Substance #0.

· Load the properties of Substance #0 from the Substance Database:

Substance = Water
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Phases =Gas (equilibrium)

· Create Substance #0.

· Load the properties of Substance #0 from the Substance Database:

Substances = Water

Phases = Liquid

In the folder Phases:
· Create a continuous Phase #0.
· Add the following substances in the folder Substances:

Water_Gas (equilibrium)
Air_Gas (equilibrium)

· Specify properties of the folder Phase #0 > Physical processes:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

Mass transfer = Chemistry

· Create a dispersed Phase #1 of the Particles type (open the context menu of the folder Phases and select
there the Create particles command)

· Add Water_Liquid to folder Substances of Phase #1.

· Specify properties of the folder Phase #1 > Physical processes:

Heat transfer = Convection & conduction

Phase transfer = Convection & diffusion

Motion = Motion

Mass transfer = Mass transfer

· From the context menu of the folder Phase #1 > Size spectra select the Create command. The element
Phase #1 > Size spectra > Size spectrum #0 will appear in the project tree:

· As Number of size groups = 1 is specified in properties of Phase #1 (this is the default value), Size
spectrum #0 will contain only one size group of particles and the Size groups > [0] > Volume fraction in
the Phase parameter will be read-only and have the value 1. Specify diameter of particles in the size group
[0] of Size spectrum #0:

Size groups > [0] > Diam. particles= 0.0001 [m]

This prepared Size spectrum #0 will be used in Initial data and on Boundary conditions for inlet.

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.

· In the folder Phase interaction in properties of the element Continuum-particles do:

o Click Add ( ) near the element Substance pair.

o Specify:

Substance pair

[0]

Phase0 = Water_Gas (equilibrium)

Phase1 = Water_Liquid

Cd = Model1
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Nu = Model1

Evaporation model = Model1

Sh = Model1

· For the element Init. data > Init. data #0 specify:

Temperature (Phase #0)

Value = 0 [K]

Velocity ​​(Phase #0)

Value

X = 1 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Mass frac._Water_Gas (equilibrium) (Phase #0)

Value = 0

Mass frac._Air_Gas (equilibrium) (Phase #0)

Value = 1

In properties of SubRegion #0, specify: Model = Model #0.

4.6.1.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 10 [K]

Velocity​​(Phase #0) = Normal mass velocity

Mass velocity = 0.5522 [kg m-2 s-1]

Mass frac. [Water_Gas (equilibrium)] (Phase #0)= Value at the inlet

Value = 0

Mass frac. [Air_Gas (equilibrium)] (Phase #0) = Value at the inlet

Value = 1

Phase volume(Phase #1) = Value

Value = 0.001
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Temperature (disp.)(Phase #1) = Value

Value = 0 [K]

Velocity​​ (disp.)(Phase #1) = Particles velocity

Particles velocity

X = 1 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Diameter(Phase #1) = Size spectrum

Size spectrum = Size spectrum #0

Boundary 2

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

Mass frac. [Water_Gas (equilibrium)] (Phase #0) = Symmetry

Mass frac. [Air_Gas (equilibrium)] (Phase #0) = Symmetry

Phase volume(Phase #1) = Symmetry

Temperature (disp.)(Phase #1) = Symmetry

Velocity​​ (disp.)(Phase #1) = Contact with wall

Diameter (Phase #1) = Symmetry

Boundary 3

Type = Free Outlet

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

Mass frac. [Water_Gas (equilibrium)] (Phase
#0)

= Zero gradient

Mass frac. [Air_Gas (equilibrium)] (Phase #0) = Zero gradient

Phase volume(Phase #1) = Permeable surface

Temperature (disp.)(Phase #1) = Permeable surface

Velocity (disp.)(Phase #1) = Permeable surface

Diameter (Phase #1) = Permeable surface

4.6.1.3 Modifiers

In order to set the Volume heat source modifier, do the following:

· From the context menu of the folder Objects, select Create.

· In the Create new object window, which appears, select Box.

· In the Properties window of Box #0, specify:

Location

Reference point

X = 0.15 [m]
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Y = 0.05 [m]

Z = 0.05 [m]

Size

X = 0.1 [m]

Y = 0.1 [m]

Z = 0.1 [m]

· In the context menu of the Modifiers folder, select Create.

· In the Create new modifier window, specify:

Modifier type = Volume heat source

Objects = Box #0

· In properties of the Volume heat source #0 modifier, which appears, specify:

Activation

Type = Permanent

Volume heat source = 2e6 [W m-3]

4.6.1.4 Initial grid

Specify in the Properties window of the Initial grid:
Grid structure = 1D
Direction = X
nX = 104

In the Properties window of the Initial grid click Apply.

4.6.1.5 Parameters of calculation

Specify in the Solver tab:

· In properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Diffusive CFL = 1e+20

· In properties of the Advanced settings element specify:

Numerical method

Type of scheme = Implicit

Pressure gradient = Simple

Multiphase D

Cloud boundary = 0.0001

4.6.1.6 Visualization

Specify visualizations of:

1. Moisture vapor distribution in the plane of the flow

2. Temperature distribution in the plane of the flow
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4.6.1.6.1  Moisture vapor distribution

Visualization at the step 450:

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Category = Variables of phase "Phase #0"

Variable = Mass. frac [Water_Gas (equilibrium)]

Value range

Mode = Manual

Max = 0.03

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1
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4.6.1.6.2  Temperature distribution

Visualization at the step 450:

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 60

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1

4.6.2 Coal combustion

In this example we simulate coal combustion in an 1D problem setting.

Mixture of gas and coal particles is being blown in a channel with high initial temperature 2073 [К] where the
coal begins to burn due to the high temperature.

Parameters of the problem setting

Inflow parameters:

     Mass velocity of the gas u1 = 31.73 [kg/(m2 s)]

     Temperature of the gas T = 573 [K]

     Mass fraction of oxygen m[O2] = 0.23333

     Mass fraction of coal in the mixture n = 0.0003

     Mass velocity of coal particles u2 = 2.68 [kg/(m2 s)]
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Initial temperature in the computational domain T0 = 2073 [K]

Geometry: Coal.wrl

Project: Coal

4.6.2.1 Physical model

In properties of the element General settings specify:

Reference values

Temperature = 573 [K]

Specify modified properties of substances that are ingredients of the gas.

In the folder Substances:

· Create Substance #0.

· Load properties of Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the Load from database dialog box, which opens, select:

Substances = Water

Phases = Gas (equilibrium)

For the new substance Water_Gas specify:

o In properties of the child element Molar mass specify Value = 0.018 [kg mole-1] as a constant.

o In properties of the child element Specific heat specify Value = 2000 [J/(kg·K)] as a constant.

o In properties of the child element Enthalpy of formation specify Value = -13434778 [J/kg] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Methane

Phases = Gas

Specify modified properties of substances that are ingredients of the coal.

For the new substance Methane_Gas specify:

o In properties of the child element Molar mass specify Value = 0.016 [kg mole-1] as a constant.

o In properties of the child element Specific heat specify Value = 3000 [J/(kg·K)] as a constant.

o In properties of the child element Enthalpy of formation specify Value = -5502800 [J/kg] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Oxygen

Phases = Gas

For the new substance Oxygen_Gas specify:

o In properties of the child element Molar mass specify Value = 0.032 [kg mole-1] as a constant.

o In properties of the child element Specific heat specify Value = 1000 [J/(kg·K)] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Nitrogen

Phases = Gas

For the new substance Nitrogen_Gas specify:
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o In properties of the child element Molar mass specify Value = 0.028 [kg mole-1] as a constant.

o In properties of the child element Specific heat specify Value = 1100 [J/(kg·K)] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Carbon dioxide

Phases = Gas

For the new substance Carbon dioxide_Gas specify:

o In properties of the child element Molar mass specify Value = 0.044 [kg mole-1] as a constant.

o In properties of the child element Specific heat specify Value = 1200 [J/(kg·K)] as a constant.

o In properties of the child element Enthalpy of formation specify Value = -8943409 [J/kg] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Water

Phases = Liquid

For the new substance Water_Liquid specify:

o In properties of the child element Specific heat specify Value = 4000 [J/(kg·K)] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Graphite

Phases = Solid

For the new substance Graphite_Solid specify:

o In properties of the child element Specific heat specify Value = 2100 [J/(kg·K)] as a constant.

· Create another Substance and load it from the Standard substance database. In the Load from database
dialog box, which opens, select:

Substances = Fe2O3

Phases = Solid

For the new substance Fe2O3_Solid specify:

o In properties of the child element Thermal conductivity specify Value = 1 [W/(m·K)] as a constant.

o In properties of the child element Specific heat specify Value = 1500 [J/(kg·K)] as a constant.

o In properties of the child element Enthalpy of formation specify Value = 0 [J/kg].

In the folder Phases:

· Create a continuous Phase #0 (from the context menu of the folder Phases select the command Create
continuous).

· Rename Phase #0 as Gas (specify in its properties Name=Gas).

· Add the following Substances into the folder Gas > Substances:
o Water_Gas (equilibrium)

o Methane_Gas

o Oxygen_Gas

o Nitrogen_Gas

o Carbon dioxide_Gas

· In properties of the folder Gas > Physical processes specify:

Heat transfer = Heat transfer via H

Motion = Navier-Stokes model

Mass transfer = Coal
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· In properties of the element Gas > Physical processes > Mass transfer specify:

i_1*) = 2.6712

i_2*) = 2.1478

i_3*) = 1.5234

Fuel = Methane_Gas

Oxidizer = Oxygen_Gas

Product-1 = Carbon dioxide_Gas

Product-2 = Water_Gas (equilibrium)

*) These are stoichiometric coefficients of combustion of methane in oxygen.

· Create a dispersed Phase of the Particles type (from the context menu of the folder Phases select the
command Create particles). Rename this Phase as Coal.

· Add the following Substances into the folder Coal > Substances:
o Water_Liquid

o Methane_Gas

o Graphite_Solid

o Fe2O3_Solid

· In properties of the folder Coal > Physical processes specify:

Heat transfer = Convection & conduction

Phase transfer = Convection & diffusion

Motion = Motion

Mass transfer = Coal

· From the context menu of the folder Coal > Size spectra select the Create command. The element Coal >
Size spectra > Size spectrum #0 will appear in the project tree.

· Specify diameter of particles in the size group [0] of Size spectrum #0:

Size groups > [0] > Diam. particles= 3.1e-5 [m]

· In properties of the element Coal > Physical processes > Mass transfer specify:

dens.initial = 768.9 Initial density of coal particles, [kg/m3]

Composition > Water_Liquid = 0.022 Mass fractions of the coal Substances (their sum is to
be 1)

Composition > Methane_Gas = 0.278

Composition > Graphite_Solid = 0.552

Composition > Fe2O3_Solid = 0.148

A_pyr = 10e8 Pyrolysis rate

C_dif = 10e8 Oxygen diffusion rate

A_CO2 = 10e8 Char combustion rate

LastWV = 0.1 Mass fraction of the rest of water and the mass fraction
of the rest of volatiles to be released immediately (for
one time step)

In the folder Models:

· Create Model #0.

· Add phases Gas and Coal into subfolder Model #0 > Phases.

· In properties of the element Model #0 > Phase interaction > Continuum-particles specify:

Cd = Model1
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Nu = Model1

Evaporation model = Model1

Sh = Model1

· For the element Model #0 > Init. data > Init. data #0 specify:

Temperature(Gas)

Value = 1500 [K]

Velocity​​(Gas)

Value > X = 30 [m/s]

Mass frac. [Oxygen_Gas](Gas)

Value = 0.23333

Velocity (disp.)(Coal)

Value > X = 30 [m/s]

In properties of SubRegion #0, specify: Model = Model #0.

4.6.2.2 Boundary conditions

Specify boundary conditions according to the illustration:

Boundary 1

Name = Inlet

Type = Inlet/Outlet

Variables

Temperature(Gas) = Temperature

Value = 0 [K]

Velocity​​(Gas) = Normal mass velocity

Mass velocity = 31.73 [kg/(m2·s)]

Mass frac. [Water_Gas](Gas) = Value at the inlet

Value = 0

Mass frac. [Methane_Gas](Gas) = Value at the inlet

Value = 0

Mass frac. [Oxygen_Gas](Gas) = Value at the inlet

Value =0.23333

Mass frac. [Carbon dioxide_Gas](Gas) = Value at the inlet

Value = 0

Phase volume(Coal) = Value

Value = 0.0003
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Temperature (disp.)(Coal) = Value

Value = 0

Velocity (disp.)(Coal) = Particles mass velocity

Value = 2.68 [kg/(m2·s)]

Diameter(Coal) = Size spectrum

Size spectrum = Size spectrum #0

Mass frac. [Water_Liquid](Coal) = Coal

Mass frac. [Methane_Gas](Coal) = Coal

Mass frac. [Graphite_Solid](Coal) = Coal

Boundary 2

Name = Symmetry

Type = Symmetry

Boundary 3

Name = Outlet

Type = Free Outlet

Variables

Temperature(Gas) = Temperature

Value = 0 [K]

Velocity(Gas) = Total pressure

Total pressure = 0 [Pa]

Mass frac. [Water_Gas](Gas) = Value

Value = 0

Mass frac. [Methane_Gas](Gas) = Value

Value = 0

Mass frac. [Oxygen_Gas](Gas) = Value

Value = 0.23333

Mass frac. [Carbon dioxide_Gas](Gas) = Value

Value = 0

Phase volume(Coal) = Permeable surface

Temperature (disp.)(Coal) = Permeable surface

Velocity (disp.)(Coal) = Permeable surface

Diameter(Coal) = Permeable surface

Mass frac. [Water_Liquid](Coal) = Permeable surface

Mass frac. [Methane_Gas](Coal) = Permeable surface

Mass frac. [Graphite_Solid](Coal) = Permeable surface

4.6.2.3 Initial grid

In this example, an 1D problem setting is used.

Specify in properties of the Initial grid:
Grid structure = 1D
Direction = X
nX = 100

In the Properties window of the Initial grid click Apply.
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4.6.2.4 Parameters of calculation

Specify in the Solver tab:

· In properties of the Time step element specify:

Method = In seconds

Constant step = 0.0001 [s]

· In properties of the element Advanced settings specify:

Multiphase D

Cloud boundary = 0

· In properties of the element Limiters > Limiters for calculation > Phase limiters > Gas specify:

Limiter

Density, min. = 0.01 [kg m-3]

Temperature abs, min. = 200 [K]

Temperature abs, max. = 3000 [K]

Velocity, max. = 1000 [m s-1]

Pressure abs, min. = 1000 [Pa]

Pressure abs, max. = 300000 [Pa]

· In properties of the element Limiters > Limiters for calculation > Phase limiters > Coal specify:

Limiter

Density, min. = 0.01 [kg m-3]

Temperature (disp.) [0], min. = 200 [K]

Temperature (disp.) [0], max. = 3000 [K]

Velocity, max. = 1000 [m s-1]

4.6.2.5 Visualization

The next sections describe how to set visualization of distribution the following values along the channel:
· mole fraction of oxygen
· mass fraction of water vapor
· temperature of the gas

Colors of axes, the plot's grid, and the plot line itself can be tuned in properties of the layers.

4.6.2.5.1  Distribution of oxygen

Create a Line that will be oriented along the channel. On this Line a Layer will be built displaying distribution
of oxygen:

· In the Postprocessor tab, open the context menu of the folder Objects and select the Create command.

· In the Create new object dialog box, which opens, select Object type = Line and click OK.

· In properties of the new Line #0 specify:

Object

Reference point

X = -0.12 [m]

Z = 0.001 [m]
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Create a Layer for visualization the distribution of oxygen:

· From the context menu of Line #0 select the Create layer and in the Create new layer dialog box, which
opens, specify Layer type = Plot along line.

· In properties of the new line Plot along line #0 (Line #0) specify:

Name = X_O2

Variable

Category = Variables of phase "Gas"

Variable = Molar frac. [Oxygen_Gas]

Interpolation = No

Number of points = 100

Rotation angle = -90

Run the computation and view the distribution of the oxygen mass fraction along the channel.

On the outlet of the channel the value of the oxygen mass fraction should be minimal and be near the value

obtained from analytic expressions (0.0403).

The plot at the step number 150:

4.6.2.5.2  Distribution of water vapour

Create a Layer for visualization the distribution of water vapor along Line #0:

· From the context menu of Line #0 select the Create layer and in the Create new layer dialog box, which
opens, specify Layer type = Plot along line.

· In properties of the new line Plot along line #0 (Line #0) specify:

Name = X_H2O
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Variable

Category = Variables of phase "Gas"

Variable = Product 2 mass frac. true*)

Interpolation = No

Number of points = 100

Rotation angle = -90

*) Product 2 mass frac. true is the true mass fraction of water vapor from the computational domain while
Mass frac. [Water_Gas (equilibrium)] is the mass fraction of water vapor before the combustion process
(recovered) that, for example, is supplied on the inlet as pure substance in the pure state; in this
computation this variable refers to vapor that has evaporated from the coal.

On the outlet from the channel, value of the mass fraction of water vapor should be minimal and be near the
value calculated analytically(0.03509).

Run the computation and view the distribution of mass fraction of water vapor along the channel.

4.6.2.5.3  Distribution of the gas temperature

Create a user variable Tgas_abs that will correspond to temperature of the gas.

· In the Postprocessor tab, open the context menu of the folder User variables > Local and select the
Create > Scalar command.

· A new user variable UV #0 will appear in the folder User variables > Local. Specify in its properties
Name=Tgas_abs.

· Then specify the value of the variable Tgas_abs using the Formula editor:

o Click the icon  near the Value field and in the dialog box of the Formula editor, which opens, in

the Variables & constants pane, double-click the variable All > Gas > Temperature.

o The Variable identification dialog box will open where the program prompts a name, which will be

used for this variable in the formula (TEMP0). Click OK. The variable identifier TEMP0 will appear in the
Formula pane in the upper part of the Formula editor.

o In the Formula pane add the reference value of temperature to the existing identifier. You can do this

by adding either the constant 573 or the variable Reference temperature from Internal
characteristics. Let's apply the second method. Start with adding the "+" symbol into the Formula
pane. Then, in the Integral tab double-click the Reference temperature variable. The Variable
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identification dialog box will open, in which the program will prompt the standard name
(RefTemperature) of this variable in the Formula editor. Click OK in the Variable identification
dialog box. Finally the Formula pane will contain the formula TEMP0+RefTemperature:

o Click Accept.

· In the Properties window of the new user variable, which is being edited, click Apply. After this the variable
will change its name to Tgas_abs and will have the value specified by the formula.

Create a Layer for visualization the distribution of the gas temperature along Line #0:

· From the context menu of Line #0 select the Create layer and in the Create new layer dialog box, which
opens, specify Layer type = Plot along line.

· In properties of the new line Plot along line #0 (Line #0) specify:

Name = Tgas_abs

Variable

Category = User variables

Variable = Tgas_abs

Interpolation = No
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Number of points = 100

Rotation angle = -90

Run the computation and view the distribution of the gas temperature along the channel.

On the outlet of the channel the value of the gas temperature should be near to the value obtained from analytic

expressions (2440 [K]).

The plot at the step number 150:
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4.7 Radiation

In FlowVision the following models for simulating the radiation are implemented:
1. the radiation model P1
2. the model of an optically thin layer
3. discrete-ordinates method

In order to simulate the radiation transport, it is necessary:
· In properties of the Substance you have to specify the values of Density and Specific heat capacity,

and, it might be necessary to specify the value of Thermal conductivity.
· Enable calculation of equations of Heat transfer and Radiation.
· Specify the appropriate initial and boundary conditions for the temperature and density of the radiation

flux.
· If you notice some signs of instability of the solution, is recommended to reduce the time step.

4.7.1 Radiative transfer in turbid medium

Consider the one-dimensional simulation of radiation heat transfer in an opaque medium between two walls with
different temperatures.

Parameters of the problem setting

Dimensions:

Length of the bar l = 1 [m]

Inlet parameters:

Temperature of the hot wall T
hot

= 100 [K]

Temperature of the cold wall T
cold

= 0 [K]

The absorption coefficient α = 100 [m-1]

Geometry: Radiation.wrl

Project: Radiation

4.7.1.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Solid

Density

Value = 1 [kg m-3]

Thermal conductivity

Value = 1е-9 [W m-1K-1]

Specific heat

Value = 1009 [J kg-1 K-1]

In the folder Phases:
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· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· In properties of the folder Physical processes, specify:

Heat transfer = Heat transfer via h

Radiation = P1

· In properties of Radiation, specify:

Absorption coefficient = 100 [m-1]

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

In the Properties window of SubRegion #0, specify: Model = Model #0.

4.7.1.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Radiation density(Phase #0) = Radiation flux density

Value = 0

Boundary 2

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 100 [K]

Radiation density(Phase #0) = Calculating of radiation flux density

Blackness = 1
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Boundary 3

Type = Wall

Variables

Temperature(Phase #0) = Temperature

Value = 0 [K]

Radiation density(Phase #0) = Calculating of radiation flux density

Blackness = 1

4.7.1.3 Initial grid

Specify in properties of the Initial grid:
Grid structure = 1D
Direction = X
nX = 100

In the Properties window of the Initial grid click Apply.

4.7.1.4 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method =In seconds

Constant step = 1 [s]

Note:

In the simulation of radiative heat transfer it is recommended to use a time step that is comparable to the
diffusion CFL.

4.7.1.5 Visualization

To view the dynamics of the solution during the computation, specify visualization of the temperature
distribution before the start of computation.
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4.7.1.5.1  Temperature distribution

Visualization of temperature distribution when the step number is near 15000:

· Create a Line object in the folder Objects.

· In the Properties window of Line #0 specify:

Object

Reference point

X = -0.5 [m]

Y = 0 [m]

Z = 0.05 [m]

· Create a layer Plot along line on Line #0.

· In the Properties window of the layer Plot along line #0 (Line #0) specify:

Variable

Variable = Temperature

Number of points = 100

To obtain this plot, the program will require more then 10000 steps of the computation.

4.7.2 Simulating the radiative transfer by the discrete-ordinates method

The discrete-ordinates method is the most comprehensive model of radiation energy transfer.
Implementation of the discrete-ordinates method includes angular discretization of radiative transfer
equations: the whole space is split to separate solid angles with constant radiation intensity in each of
them. Accuracy of the method increases with increasing the number of the solid angles.

Specifics of the discrete-ordinates method is that, when curvilinear geometry is used, derivatives by
angular variables in the radiative transfer equation are approximated with high accuracy.
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In this training case the following situation is simulated: in a room a row of lamps are installed tilted by an angle

of φ. The lamps radiate and heat the room and surfaces.

The sought-for values are:
· temperature near the lamps
· temperature near the floor

To simulate this problem setting, consider a periodic fragment of row of lamps. The fragment contains a single
lamp:

This training case is simulated in 2D problem setting.

Parameters of the problem setting

Geometry parameters:

Length of the area l = 0.5 [m]

Width of the area w = 0.6 [m]

Lamp's tilt angle φ = 30 [degree]

Parameters:

Temperature of the hot wall T
hot

= 673 [K]

Temperature of the cold wall T
cold

= 273 [K]

Heat transfer coefficient of the wall α = 0.1 [W/(m2·K)]

Geometry: Plane_lamps.STL

Project: Lamps_MDO

4.7.2.1 Physical model

Create a new project based on the geometry Plane_lamps.STL.

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)
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In the folder Phases:

· Create a continuous Phase #0.

· Add Air_Gas (equilibrium) into the subfolder Phase #0 > Substances.

· In properties of the folder Physical processes, specify:

Heat transfer = Heat transfer via h

Radiation = Discrete-ordinates method

Then let's specify properties of the Radiation physical process. The discrete-ordinates method uses

discretization of the space by the polar angle θ and the azimuth angle φ of the spherical coordinate system,

see the illustration below:

· In properties of Radiation, specify:

Time step coefficient = 1

Refraction index = 1
(this value equals to the ratio of the speed of light in vacuum to the speed of light in the medium)

Relaxation coefficient = 0.2
(the coefficient, which is used to take into account the rate of deexcitation of atoms)

Dispersion coefficient = 0 [m-1]
(this value equals to the ratio of the radiant flux dispersed by the body to the incident flux)

Anisotropy dispersion coefficient = 0

(When this coefficient of anisotropy dispersion a is non-zero, it means anisotropic emission of the radiation

in the medium.

When a>0, the radiation emits mostly in the forward direction; when а<0, the radiation emits mostly

backward.)

Number Polar Angle = 4

Number Azimuth Angle = 8
(this value is set by the program automatically)

Axis for polar angle = Axis Y

· Apply the Create command from the context menu of the subfolder Radiation > Spectrum to create the
element Spectral band #0 and in properties of the element specify:

Absorption coefficient = 1 [m-1]
(this value equals to the ratio of the radiant flux absorbed by to body to the incident flux)

The simulation will be done in the "gray" approach, so you don't have to change the default values of the Begin
wavelength and End wavelength parameters.

In the folder Models:
· Create Model #0.
· Add Phase #0 into subfolder Model #0 > Phases.
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In properties of SubRegion #0, specify: Model = Model #0.

4.7.2.2 Boundary conditions

Specify boundary conditions in SubRegion #0 as it is shown on the illustration:

Boundary 1

Name = Symmetry

Type = Symmetry

Variables

Temperature (Phase #0) = Symmetry

Radiation intensity (Phase #0) = Opaque wall

Boundary 2
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Name = Hot wall

Type = Wall

Variables

Temperature (Phase #0) = Temperature

Value = 400 [K]

Radiation intensity (Phase #0) = Opaque wall

Boundary 3

Name = Cold wall

Type = Wall

Variables

Temperature (Phase #0) = External heat exchange

Heat-transfer coef. = 0.1 [W m-2 K-1]

Blackness = 1

T of external medium = 0 [K]

Radiation intensity (Phase #0) = Opaque wall

Boundary 4

Name = Left boundary

Type = Connected

Boundary 5

Name = Right boundary

Type = Connected

4.7.2.3 Binding the subregions

Specify snap points:

· From the context menu of the element Boundary links > Free BCs > SubRegion #0: Left boundary
select the Create snap point command. The program will create the child element SubRegion #0: Left
boundary > Snap point #0, in properties of which you have to specify:

Coordinates
X = 0
Y = 0
Z = 0

· From the context menu of the element Boundary links > Free BCs > SubRegion #0: Right boundary
select the Create snap point command. The program will create the child element SubRegion #0: Right
boundary > Snap point #0, in properties of which you have to specify:

Coordinates
X = 0.5
Y = 0
Z = 0

Create Binder #0:

· From the context menu of the folder Boundary links > Binders select the Create all command. The
program will create the child element Binder #0.

Create Binder condition #0:

· From the context menu of the folder Boundary links > Binder conditions select the Create command and
in the Create binder condition dialog box, which opens, specify Connection type = Periodic surface
(values 1st model and 2nd model will be already set as Model #0).
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Specify the matching between Binder #0 and Binder condition #0:

· From the context menu of the folder Boundary links > Binder conditions > Binder condition #0 >
Binders select the Add/Remove command and in the Select binders dialog box, which opens, click the
Add All button. Then click OK.
In the project tree the element Boundary links > Binder conditions > Binder condition #0 > Binders >
Binder #0 will appear and the "!" mark near the element Boundary links > Binders > Binder #0 will
disappear.

4.7.2.4 Initial grid

Specify in properties of the Initial grid:
Grid structure = 2D
Plane = XY
nX = 50
nY = 60

In the Properties window of the Initial grid click Apply.

4.7.2.5 Parameters of calculation

In the Solver tab specify parameters of calculation.

In properties of the element Time step specify:

Method = In seconds

Constant step = 100

In properties of the element Stopping conditions > Time steps specify Number = 100.
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4.7.2.6 Visualization

This training case includes the following visualizations:
· distribution of the radiation density
· distribution of temperature
· variation of temperature at a specified point

4.7.2.6.1  Distribution of the radiation density

· In properties of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· On Plane #0 create a Color contours layer and in its properties specify:

Name = Radiation density

Variable

Category = Common and phase-unrelated variables

Variable = Radiation density

Palette
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Appearance

Enabled = Yes

Title = Yes

Style = Style 1

4.7.2.6.2  Distribution of temperature

· On Plane #0 create a Color contours layer and in its properties specify:

Name = Temperature

Variable

Category =  Common and phase-unrelated variables

Variable = Temperature

Palette

Appearance

Enabled = Yes

Title = Yes

Style = Style 1
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4.7.2.6.3  Temperature variation at a point

To obtain value of the temperature at specified points, a Set of sensors geometry object will be created, which
contains two sensors near the lamp:

· In Preprocessor in the folder Objects create the Set of sensors #0 object, which will include two sensors,
and in its properties specify:



253FlowVision Help

 

Sensor set

[0]

Coordinates

     X = 0.22 [m]

     Y = 0.5 [m]

     Z = 0.005 [m]

[1] *)

Coordinates

     X = 0.22 [m]

     Y = 0.4 [m]

     Z = 0.005 [m]

*) To create the element [1], which corresponds to the second sensor, click the screen button 
 (Append item to the array) in the Sensor set line in properties of the Set of sensors #0 object:

· Create a Characteristic on Set of sensors #0. In properties of the element Characteristics #0 (Set of
sensors #0) specify:

Variable

Category = Common and phase-unrelated variables

Variable = Temperature

· In the Solver tab, in the folder Stopping conditions > User values create a user Stop criterion and in its
properties specify:

Name = T_sensor#0

Object = Characteristics #0 (Set of sensors #0)

Group = Sensor #0

Variable = Variable value

· Similarly create another user Stop criterion with the following properties:

Name = T_sensor#1

Object = Characteristics #0 (Set of sensors #0)

Group = Sensor #1

Variable = Variable value

· Run computation of the project and view in the Plot tab of the Monitor window dynamics of Temperature at
locations of the Sensors:
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4.8 Electrodynamics

FlowVision implements simulating of electromagnetodynamics.

This is illustrated in the following exercises:
· Interaction of two isolators
· Hartmann problem

4.8.1 Interaction of two isolators

Consider the interaction of the two plates, which conduct electricity poorly. Between the upper ends of the
plates (A and B) a constant voltage is maintained, while the lower ends of the plates (A1 and B1) are connected
by a short-circuit conductor.

Parameters of the problem setting

Dimensions:

Height of the plates h = 0.02 [m]

Distance between the plates d = 0.005 [m]

Inlet parameters:

Voltage difference between A and B U
АВ

= 20 [V]

Voltage difference between A1 and B1 U
А1В1

= 0 [V]

Properties of the substance between isolators

Conductivity s = 1 [W -1m-1]

Dielectric permittivity ε = 1

Relative magnetic permeability μ = 1

Geometry: DielPlates.wrl

Project: DielPlates
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4.8.1.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0 as constants:

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]]

Density

Value = 1 [kg m-3]

Specific heat

Value = 1000 [J kg-1 K-1]

Conductivity

Value = 1 [W -1 m-1]

Permittivity

Value = 1

Permeability

Value = 1

In the folder Phases:

· Create a continuous Phase #0.

· Add Substance #0 into the folder Phase #0 > Substances.

· In properties of Phase #0 > Physical processes specify:

EMHD = Electrodynamics

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

In the Properties window of SubRegion #0, specify: Model = Model #0.
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4.8.1.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Electrical potential (Phase #0) = Value of el.potential

To define the distribution of the potential on the Boundary 1, do the following:
· In properties of the element Electrical potential (Phase #0) change the method for specification the

value in the Value of el.potential data field, select the Formula option ( ).

· Open the Formula Editor by clicking the icon .
· In the Formula Editor, create a link to the coordinate along the axis X (select Variables & constants >

All > Common > Coordinates > X):

· Specify the linear distribution of the electric potential in the insulator between points А and А1 by the
formula:
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 

h

xU
xU AB



2

In the Formula Editor enter the formula: 20/2*COORD_X/0.02
· Click the Accept button in the Formula Editor.
· Click the Apply button in the Properties window of the element Electrical potential (Phase #0).

Specify the other boundary conditions. Distribution of the electric potential on boundaries 2 and 3 are
respectively specified by the formulae:

between points B and B1:  

h

xU
xU AB



2

between points А1 and B1:  

d

y
UyU AB 

Boundary 2

Type = Wall

Variables

Electrical potential (Phase #0) = Value of el.potential

Value of el.potential = -20/2*COORD_X/0.02 [V]

Boundary 3

Type = Wall

Variables

Electrical potential (Phase #0) = Value of el.potential

Value of el.potential = -20*COORD_Y/0.005 [V]

Boundary 4

Type = Wall

Variables

Electrical potential (Phase #0) = Value of el.potential

Value of el.potential = 0 [V]

Boundary 5

Type = Symmetry

Variables

Electrical potential (Phase #0) = Symmetry
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4.8.1.3 Initial grid

Specify in properties of the Initial grid:
Grid structure = 2D
Plane = XY
nX = 200
nY = 50

In the Properties window of the Initial grid click Apply.

4.8.1.4 Parameters of calculation

In the Solver tab, in properties of the Time step element, specify:

Method = In seconds

Constant step = 1 [s]

4.8.1.5 Visualization

Specify visualization of:

1. Electrical intensity's distribution in the plane of symmetry.

2. Electrical intensity's distribution along the horizontal axis.
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4.8.1.5.1  Electrical intensity's distribution in a plane

· In the Properties window of Plane #0 specify:

Object

Normal

X = 0

Y = 0

Z = 1

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Electric field intensity

Value range

Mode = Manual

Max = 4000

Min = 0

Method = Isolines

Palette

Appearance

Enabled = Yes

Style = Style 1
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4.8.1.5.2  Electrical intensity's distribution along a line

· Create a Line object in the folder objects

· In theProperties window of Line #0, specify:

Object

Reference point

X = 0.01 [m]

Y = -0.002499 [m]

Z = 0.00125 [m]

Direction

X = 0
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Y = 1

Z = 0

· Create a layer Plot along line on Line #0.

· In the Properties window of the layer specify:

Variable

Variable = Electric field intensity

Rotation angle = -90

Value range

Mode = Manual

Max = 2050

Min = 2000

4.8.2 Hartmann problem

In this exercise we consider a laminar flow between two dielectric plates affected by external magnetic field
(this is the J. Hartmann problem).

This problem has an exact analytical solution (see Тананаев В.А. Течения в каналах МГД-устройств. -
Мoscow: Атомиздат, 1979, 368 pages).

Problem setting

Incompressible liquid flows between two dielectric plates being affected by external constant transverse

magnetic field By, with free outlet, as shown on the illustration below:

Density ρ = 1000 [kg/m3]

Viscosity μ = 0.001 [kg m-1 s-1]

Specific electric
conductivity

σ = 1000 [S/m]=[Ohm-1 m-1]

Length of the channel L = 1 [m]

Half of the distance
between the plates

а = 0.01 [m]

Mass velocity on the
inlet

ρU = 1 [kg/(m2 s)]

Component of the vector
of the external magnetic
field along axis Y

B = 1 [T]

Hartmann number




BaHa  = 10
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Magnetic Reynolds
number

Rem=μ· μ
0
· σ· а· U

0
= 1.25664· 10-8

Reynolds number



 a
Rе



 = 10

Relative dielectric
permittivity

ε = 1

Relative magnetic
permeability

μ
r = 1

Geometry: Hartmann.wrl

Project: Hartmann

4.8.2.1 Physical model

In the folder Substances:

· Create Substance #0 with the following properties:

Aggregative state = Liquid

Molar mass

Value = 0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1 s-1]

Thermal conductivity

Value = 1e-09 [W (m K)-1]

Specific heat

Value = 1009 [J (kg K)-1]

Conductivity

Value = 1000 [W -1 m-1]

Permittivity

Value = 1

Permeability

Value = 1

In the folder Phases:

· Create a continuous Phase #0.

· Add Substance #0 into the folder Phase #0 > Substances.

· In properties of Phase #0 > Physical processes specify:

Motion = Navier-Stokes model

EMHD = MHD Potential model

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.
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· In properties of the element Model #0 > Init. data > Init. data #0 > Velocity (Phase #0) specify:

Value

X = 0.001 [m/s]

Y = 0 [m/s]

Z = 0 [m/s]

In properties of SubRegion #0, specify: Model = Model #0.

4.8.2.2 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables *)

Velocity (Phase #0) = No slip

Electrical potential (Phase #0) = Zero gradient

Magnet potential (Phase #0) = Zero gradient

*) Do not change the existing values of these parameters.

Boundary 2

Name = Symmetry

Type = Symmetry

Variables *)

Velocity (Phase #0) = Slip

Electrical potential (Phase #0) = Symmetry

Magnet potential (Phase #0) = Symmetry

*) Do not change the existing values of these parameters.

Boundary 3

Name = Outlet

Type = Free Outlet

Variables *)

Velocity (Phase #0) = Pressure
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Electrical potential (Phase #0) = Zero gradient

Magnet potential (Phase #0) = Zero gradient

*) Do not change the existing values of these parameters.

Boundary 4

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity (Phase #0) = Normal mass velocity

    Mass velocity = 1 [kg m-2 s-1]

Electrical potential (Phase #0) = Zero gradient

Magnet potential (Phase #0) = Zero gradient

4.8.2.3 Setting the external magnetic field

The external magnetic field is set using a Modifier of the External Induction type. Follow these steps:

· Select Create from the context menu of the Subregions > SubRegion #0 > Modifiers folder.

· In the Create new modifier dialog box, which opens, specify:

Modifier type = External Induction

Objects = Computational space

· In properties of the External Induction #0 modifier, which appears, specify:

Activation

Type = Permanent

Induction vector

X = 0 [T]

Y = 1 [T]

Z = 0 [T]

4.8.2.4 Initial grid

For correct simulation of fluid friction on the wall, you have to build a two-dimensional nonuniform grid, which is
condensed near the walls.

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:
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for axis OY (click the button )

Grid parameters

h_max = 0.001 [m]

h_min = 1e-005 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-0.01:

h = 1e-005 [m]

kh+ = 1.1485

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.001 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0.01:

h = 1e-005 [m]

Click OK to close the Initial grid editor with saving the entered data.

Specify in properties of the Initial grid:
Grid structure = 2D
Plane = XY
nX = 200

In the Properties window of the Initial grid click Apply.

4.8.2.5 Parameters of calculation

Specify parameters of elements in the Solver tab.

· In properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = 20

4.8.2.6 Stopping conditions

Let us create a user Stop criterion that is based on average pressure on the inlet. This stopping criterion will
allow you to watch dynamics of pressure on the inlet that will be displayed as a plot in the Monitor window.
Follow these steps:

· In the Preprocessor tab, create a Supergroup, selecting the Create supergroup > In Preprocessor
command from the context menu of the boundary condition Inlet.

· From the context menu of the just created geometry object Supergroup on "Inlet" select the Create
characteristics command.

· In properties of the just created element Characteristics #0 specify:

Name = Pressure (Supergroup on "Inlet")

Variable

       Variable = Pressure

· In the Solver tab, create a Stop criterion in the folder Stopping conditions > User values.

· In properties of the just created Stop criterion #0 specify:

Name = Aver. Pressure on inlet

Level = 0 *)

Object = Pressure (Supergroup on "Inlet")

Variable = <f surf.>
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*) When you set Level = 0, the computation will not stop by this criterion but the Plot tab of the Monitor
will display the plot of the specified variable over time.

Also add a stopping condition based on number of steps. To do so, specify Number =30 in properties of the
element Stopping conditions > Time steps.

4.8.2.7 Visualization

· Profiles of velocity and magnetic induction
· Variation of pressure on inlet

4.8.2.7.1  Profiles of velocity and magnetic induction

To visualize profiles of the velocity and magnetic induction, two Plot along line layers will be created. Also a
Vectors layer will be created to visualize the velocity.

In the Postprocessor tab, create Planes for the visualization:

· From the context menu of the Objects folder, select Create.

· In the Create new object dialog box, which opens, select Object type = Plane.

· In properties of the just created Plane #1 specify:

Object

     Reference point

X = 0.94

Y = -0.01

Z = -0.05

     Normal

X = 0

Y = 0

Z = -1

· Create also Plane #2 with the following properties:

Object

     Reference point

X = 0.97

Y = -0.01

Z = -0.05

     Normal

X = 0

Y = 0

Z = -1

To visualize profiles of magnetic induction, create a Plot along line layer on Plane #1:

· In the Postprocessor tab, create a Plot along line layer on Plane #1. To do so, select the Create layer
command from the context menu of Plane #1 and in the Create new layer dialog box, which opens, specify
Layer type = Plot along line and Objects = Plane #1.

· In properties of the just created layer Plot along line #0 specify:

Name = Induction

Variable

Variable = Induction
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Component = X

Number of points = 100

Value range

Mode = Manual

Max = 9.7e-10

Min = -9.7e-10

Appearance

Plot

     Color =  Red

     Width =4

· On Plane #2 create Plot along line #1 layer with the following properties:

Name = Velocity

Variable

Variable = Velocity

Component = X

Number of points = 100

Value range

Mode = Manual

Max = 0.0011

Min = 0

Appearance

Plot

     Color =  Green

     Width =4

· On Plane #1 create a Vectors layer with the following properties:

Name = Velocity vectors

Variable

Variable = Velocity*)

Grid

Size 2 = 30

Coloring**)

Variable

     Variable = Velocity

Palette

     Appearance

          Enabled = Yes
*) For Vectors layers the program by default sets Variable > Variable = Velocity.
**) These parameters are set to color velocity vectors depending on their absolute values.
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As a result, profile of velocity, profile of magnetic induction, and vectors of velocity will be displayed during the
computation (at step number 30):

4.8.2.7.2  Variation of pressure on inlet

Variation of the average pressure on the inlet during the computation will be displayed on the Plot tab in the
Monitor window:
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5 Advanced modules

This section describes the following additional features of FlowVision:
1. Conjugate simulations
2. Rotation
3. Moving bodies
4. Icing on a solid surface
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5.1 Conjugate simulation

Conjugate simulations take into account the interaction between the different Subregions or different
boundaries of one Subregion.

In order to run conjugate simulations, you have to:
· Prepare a geometric model of the computational domain, consisting of several Subregions.
· Set the boundary condition Connected on both sides of surfaces, on which the subregions' conjugation will

be calculated.
· Create appropriate Binders, Binder conditions and matching between these Binders and Binder

conditions.

5.1.1 Conjugate heat exchange

Consider a simulation of a laminar flow of viscous cold air in a tube with a thick metal wall heated from the
outside.

Parameters of the problem setting

Dimensions:

Length of the tube L = 0.1 [m]

The inner radius of the tube R = 0.015 [m]

Thickness of the wall d = 0.005 [m]

Inflow parameters:

Velocity on inlet V
inl

 = 0.1 [m s-1]

Temperature on inlet T
inl

 = 0 [K]

Temperature of the outer surface of the tube T
w
 = 100 [K]

Fluid parameters:

Density r = 1 [kg m-3]

Viscosity m =1.82e-5 [kg m-1 s-1]

Thermal conductivity l = 0.026 [W m-1 K-1]
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Specific heat c
p

= 1009 [J kg-1 K-1]

The parameters of the solid substance:

Density r = 7900 [kg m-3]

Thermal conductivity l = 45 [W m-1 K-1]

Heat capacity c
p

= 457 [J kg-1 K-1]

Reynolds number:
165

101.82

10.10.0152

μ

ρ2RV
Re

5
inl











5.1.1.1 Making the project based on a single detail

Geometry: Conjugate_Convection.STL

Project: Conjugate_Convection

5.1.1.1.1  Computational domain

When preparing a geometric model based on a single detail, a situation of so-called T-shaped surfaces arise.

To solve this problem, it is necessary to change the geometry by adding thin walls instead of the T-shaped
surfaces. On the boundary of these fictitious walls the adiabatic boundary conditions are set. The disadvantage
of this method is that it distorts the image of the actual physical process. If the energy equation is solved in the
simulation, after introduction of such walls thermal bridges will appear.

A fully prepared geometry of the computational domain is stored in the file Conjugate_Convection.STL.

5.1.1.1.2  Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = Steel

Aggregative state = Solid

Molar mass

Value = 0.056 [kg mole-1]

Density

Value = 7900 [kg m-3]

Thermal conductivity

Value = 45 [W m-1K-1]

Specific heat

Value = 457 [J kg-1 K-1]

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = Air

Aggregative state = Gas

Molar mass
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Value = 0.0289 [kg mole-1]

Density

Value = 1 [kg m-3]

Viscosity

Value = 1.82e-5 *) [kg m-1s-1]

Thermal conductivity

Value = 0.026 [W m-1K-1]

Specific heat

Value = 1009 [J kg-1 K-1]

*) 1.82e-5 is notation for 1.82x10-5.

In the folder Phases:

· Create a continuous Phase #0.

· In the Properties window of Phase #0, specify:

Name = Steel

· In the folder Substances of the phase Steel load the substance Steel.

· In the Properties window of the folder Physical processes, specify:

Heat transfer = Heat transfer via h

· Create a continuous Phase #0.

· In the Properties window of Phase #0, specify:

Name = Air

· In the folder Substances of the phase Air load the substance Air.

· Specify in the Properties window of the folder Physical processes:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· In the Properties window of Model #0, specify:

Name = Steel

· Add the phase Steel into the folder Models > Steel > Phases.

· Create Model #0.

· In the Properties window of Model #0, specify:

Name = Air

· Add the phase Air into the folder Models > Air > Phases.

· In Models > Air > Init. data > Init. data #0 specify:

Velocity ​(Air)

X = 0 [m s-1]

Y = 0 [m s-1]

Z = -0.1*) [m s-1]

*) Negative value of the initial velocity is specified because the flow goes against the axis Z.
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5.1.1.1.3  Boundary conditions

In the Properties window of the Subregion within the inner tube specify:

Name = Flow

Model = Air

Specify the following boundary conditions on the inner surface of the inner tube:

Boundary 1

Name = Inlet

Type = Inlet/Outlet

Color =  Red

Variables

Temperature(air) = Temperature

Value = 0 [K]

Velocity​​(Air) = Normal mass velocity

Mass velocity = 0.1 [kg (m2s)-1]

Boundary 2

Name = Outlet

Type = Free Outlet

Color =  Blue

Variables

Temperature(air) = Zero gradient

Velocity​​(Air) = Pressure

Value = 0 [Pa]

Boundary 3

Name = Wall

Type = Connected

Color =  Green

In the Properties window of the Subregion between the outer and inner tubes specify:

Name = Tube

Model = Steel
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Specify the following boundary conditions on the surfaces, which are boundaries for the steel:

Boundary 1

Name = Outer wall

Type = Wall

Color =  Maroon

Variables

Temperature(Steel) = Temperature

Value = 100 [K]

Boundary 2

Name = Wall

Type = Wall

Color =  Gray

Variables

Temperature(Steel) = Zero gradient

Boundary 3

Name = Inner wall

Type = Connected

Color =  Yellow

Notes:

When setting the boundary conditions on the inner you have select not only the surface but also the side of the
surface. On the outer surfaces of the inner tube the boundary conditions are specified in the subregion Tube,
while on the inner surfaces of the inner tube the boundary conditions are specified in the subregion Flow. To
select a side of the surface of the inner tube, to the following in the View window:

· Go to the Selection mode to select a surface in the View window by clicking the button  (Selection
mode) in the Work modes toolbar, or press and hold down the Alt button.

· Hover your mouse pointer over the required surface.

· Click by the left mouse button.
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· If a wrong surface would be selected, click by the left mouse button repeatedly until until the required surface
is selected.

· If a wrong side would be selected, then right-click the selected surface. A context menu will open, select
there the option Select other side:

To understand, which side is selected, you can look at the pattern on its image. The selected side surface has

no pattern on it, while the unselected side is marked by a pattern consisting of the "no" symbols .

Also, to select a surface, you can use the elements Subregion > SubRegion #N > Geometry > Region -
Surface #N > Region - Group #N in the project tree in Preprocessor. Displaying of all geometrical groups as
elements in the project tree is set by the menu command File > Preferences by the setting Display > Show
all groups = Yes | No. When you have many nested subregions and geometry groups, this method becomes
preferable.

5.1.1.1.4  Binding the subregions

Binding the boundary conditions consists of the following steps:
· creating a Binder of two Boundary conditions, which types are Connected
· creating a Binder condition
· matching the Binder and the Binder condition

Create Binder #0:

· Select Create all from the context menu of the folder Boundary links > Binders:

Create Binder condition #0:
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· Select Create from the context menu of the folder Boundary links > Binder conditions.

· In the Create binder condition dialog box, which opens, specify:

Connection type = Conjugate temperature

1st model = Steel

2nd model = Air

Specify the matching between the Binder and the Binder condition:

· From the context menu of the folder Binder condition #0 > Binders, select Add/Remove.

· Select Binder #0 from the Not selected list and click the Add button. Then click OK.
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5.1.1.1.5  Initial grid
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Specify in the Properties window of the Initial grid:

nX = 25

nY = 25

nZ = 25

In the Properties window of the Initial grid click Apply.

5.1.1.1.6  Adaptation of the computational grid

In this example, it is necessary to make an adaptation of the grid within solid walls of the tube and near the wall
in the subregion of the flow.

Specify the adaptation of the computational grid within the subregion Tube:

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #0 will be created.

· From the context menu of the element Adaptation #0 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place Tube into the pane Selected and click OK.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Objects and in the Select objects dialog box, which opens, place Computational space into the pane
Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Split/Merge = Split

Layers

Layers for Level N = 1

Specify the adaptation within the subregion Flow:

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #1 will be created.

· From the context menu of the element Adaptation #1 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place Flow into the pane Selected and click OK.

· From the context menu of the element Adaptation #1 > Objects select the command Add/Remove
Boundary Conditions and in the Select boundary conditions dialog box, which opens, place Flow : Wall
into the pane Selected and click OK.

· In the Properties window of the element Adaptation #1 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 4

5.1.1.1.7  Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.1 [s]
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5.1.1.1.8  Visualization

To view the dynamics of the solution during the computation, specify visualization of the temperature
distribution in the plane of the flow before the start of computation.

5.1.1.1.8.1  Temperature distribution

Visualization at the step number 50:

· In properties of the layer Solids specify:

Clipped = Yes

· In properties of Plane #0 specify:

Object

Normal

X = -1

Clipping object = Yes

· Create a layer Color contours on Plane #0.

· In properties of this layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 100

Min = 0

Palette

Operations
Click  (Load palette from file) and then select the file
heat.fvpal (this file locates in the directory where FlowVision is

installed).

5.1.1.2 Making the project based on several details (an assembly)

Geometry: Conj_Convection_TConnect_Part1.STL
Conj_Convection_TConnect_Part2.STL

Project: Conjugate_Convection_TConnect
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5.1.1.2.1  Computational domain

When a geometric model is prepared based on an assembly, the T-shaped surfaces are processed correctly
and there is no need of additional modifying the geometric model, as it was in the previous example.

In this case, the geometric model of each subregion must be stored in a separate file. The assembling is done
at the step of creating the project when all the files are loaded in FlowVision.

To create a project based on an assembly:

· In the File menu, select Create assembly:

· The Assembly creation dialog box will open. Click there the Add button and, in a standard operating
system's dialog box for file selection, which opens, select the following files:
o Conj_Convection_TConnect_Part1.STL
o Conj_Convection_TConnect_Part2.STL

· The selected files will appear in the Files in assembly pane in the Assembly creation dialog box.

The files are to be displayed in the Files in assembly pane of the Assembly creation dialog box
in the following order:

1) Conj_Convection_TConnect_Part2.STL

2) Conj_Convection_TConnect_Part1.STL

This order is important, because the external subregion must be specified on the first position in
the assembly list, and internal subregions must be specified on other places.

If necessary, place the file Conj_Convection_TConnect_Part2.STL on the first position in the list

applying buttons Move Up and/or Move Down.

· Click OK in the Assembly creation dialog box.

· The Part intersection fix dialog box will open. Leave there the default settings and click OK.
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· Specify the name of the project.

5.1.1.2.2  Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = Steel

Aggregative state = Solid

Molar mass

Value = 0.056 [kg mole-1]

Density

Value = 7900 [kg m-3]

Thermal conductivity

Value = 45 [W m-1K-1]

Specific heat

Value = 457 [J kg-1 K-1]

· Create Substance #0.

· In properties of Substance #0 specify:

Name = Air

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]

Density

Value = 1 [kg m-3]

Viscosity

Value = 1.82e-5 *) [kg m-1s-1]

Thermal conductivity

Value = 0.026 [W m-1K-1]

Specific heat

Value = 1009 [J kg-1 K-1]
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*) 1.82e-5 is notation for 1.82x10-5.

In the folder Phases:

· Create a continuous Phase #0.

· In properties of Phase #0, specify:

Name = Steel

· Load the Steel substance into the Substances folder of this Phase.

· In properties of the folder Steel > Physical processes specify:

Heat transfer = Heat transfer via h

· Create a continuous Phase #0.

· In properties of Phase #0, specify:

Name = Air

· Load the Air substance into the Substances folder of this Phase.

· In properties of the folder Air > Physical processes specify:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· In properties of Model #0, specify:

Name = Steel

· Add phase Steel into subfolder Steel > Phases.

· Create Model #0.

· In properties of Model #0, specify:

Name = Air

· Add phase Air into subfolder Air > Phases.

· In Init. data #0 specify:

Velocity ​​(Air)

X = 0.1 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

5.1.1.2.3  Boundary conditions

In the Properties window of the Subregion between the external and the internal surfaces, specify:

Name = Tube

Model = Steel



283FlowVision Help

 

Specify the following boundary conditions (on the inner side of the outer surface and the outer side of the inner
surface):

Boundary 1

Name = Outer wall

Type = Wall

Color =  Maroon

Variables

Temperature(Steel) = Temperature

Value = 100 [K]

Boundary 2

Name = Wall

Type = Wall

Color =  Gray

Variables

Temperature(Steel) = Zero gradient

Boundary 3

Name = Inner wall

Type = Connected

Color =  Yellow

In the Properties window of the Subregion within the inner surface, specify:

Name = Flow

Model = Air
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Specify the following boundary conditions (on the inner side of the inner surface):

Boundary 1

Name = Inlet

Type = Inlet/Outlet

Color =  Red

Variables

Temperature(Air) = Temperature

Value = 0 [K]

Velocity​​(Air) = Normal mass velocity

Mass velocity = 0.1 [kg (m2s)-1]

Boundary 2

Name = Outlet

Type = Free Outlet

Color =  Blue

Variables

Temperature(air) = Zero gradient

Velocity​​(Air) = Pressure

Value = 0 [Pa]

Boundary 3

Name = Wall

Type = Connected

Color =  Green

5.1.1.2.4  Binding the subregions

Binding the boundary conditions consists of the following steps:
· creating a Binder of two Boundary conditions, which types are Connected
· creating a Binder condition
· matching the Binder and the Binder condition

Create Binder #0:

· Select Create all from the context menu of the folder Boundary links > Binders:
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Create Binder condition #0:

· Select Create from the context menu of the folder Boundary links > Binder conditions.

· In the Create binder condition dialog box, which opens, specify:

Connection type = Conjugate temperature

1st model = Steel

2nd model = Air

Specify the matching between the Binder and the Binder condition:

· From the context menu of the folder Binder condition #0 > Binders, select Add/Remove.

· Select Binder #0 from the Not selected list and click the Add button. Then click OK.
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5.1.1.2.5  Initial grid
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Specify in the Properties window of the Initial grid:

nX = 25

nY = 25

nZ = 25

In the Properties window of the Initial grid click Apply.

5.1.1.2.6  Adaptation of the computational grid

In this example, it is necessary to make an adaptation of the grid within solid walls of the tube and near the wall
in the subregion of the flow.

Specify the adaptation of the computational grid within the subregion Tube:

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #0 will be created.

· From the context menu of the element Adaptation #0 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place Tube into the pane Selected and click OK.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Objects and in the Select objects  dialog box, which opens, place Computational space into the pane
Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Split/Merge = Split

Layers

Layers for Level N = 1

Specify the adaptation within the subregion Flow:

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #1  will be created.

· From the context menu of the element Adaptation #1 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place Flow into the pane Selected and click OK.

· From the context menu of the element Adaptation #1 > Objects select the command Add/Remove
Boundary Conditions and in the Select boundary conditions dialog box, which opens, place Flow: Wall
into the pane Selected and click OK.

· In the Properties window of the element Adaptation #1 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 4

5.1.1.2.7  Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.1 [s]
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5.1.1.2.8  Visualization

To view the dynamics of the solution during the computation, specify visualization of the  temperature
distribution in the plane of the flow before the start of computation.

5.1.1.2.8.1  Temperature distribution

Visualization at the step number 50:

· In the Properties window of the layer Solids specify:

Clipped = Yes

· In the Properties window of Plane #0 specify:
Object

Normal
X = 0
Y = 0
Z = -1

Clipping object = Yes

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 100

Min = 0

Palette

Operations Click  (Load palette from file) and then select the file heat.fvpal (this

file locates in the directory where FlowVision is installed).
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5.1.2 Conjugate radiation heat transfer

Consider the natural convection of air around the lamp bulb, heated from the inside by a filament.

Parameters of the problem setting

Boundary parameters:

The temperature of the filament T
s
 =2400 [K]

Ambient temperature T
air

 = 0 [K]

The emissivity of the bulb = 10-4

Properties of the air:

Molar mass M = 0.0289 [kg mole-1]

Viscosity m =1.82x10-5 [kg m-1s-1]

Thermal conductivity l = 0.026 [W m-1K-1]

Specific heat c
p

= 1009 [J kg-1 K-1]

Geometry: Lamp.STL

Project: Lamp

5.1.2.1 Computational domain

In FlowVision, the surface from which a Subregion is formed, can be defined after the creation of the project.
The surface geometry is imported from a file or is created based on objects of Preprocessor. In this project,
you have to create an outer surface of the Subregion, where motion of the air is simulated.

Create an outer surface of the Subregion:

· In the folder Objects on the Preprocessor tab, create a Box.

· In the Properties window of Box #0, specify:

Size

X = 0.5 [m]

Y = 0.5 [m]

Z = 0.5 [m]
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· From the context menu of Box #0, select Build into the main geometry.

· In the Properties window of the new just created Subregion, specify:

Name = External environment

In the Properties window of the Subregion, which corresponds to the lamp, specify:

Name = Lamp

5.1.2.2 Physical model

In the Properties window of the element General settings specify:

Gravity vector

X = 0 [m s-2]

Y =9.8 [m s-2]

Z =0 [m s-2]

g-Density = 1.286 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = Air

Aggregative state = Gas

Properties

Molar mass = Constant

Value = 0.0289 [kg mole-1]

Density = Ideal gas law

Viscosity =Constant

Value =1.82e-5 [kg m-1s-1]

Thermal conductivity =Constant

Value = 0.026 [W m-1K-1]

Specific heat =Constant

Value = 1009 [J kg-1 K-1]

· Create Substance #0.

· Specify the following properties of Substance #0:

Name = Vacuum

Aggregative state = Solid

Properties

Density =Constant

Value = 0.001 [kg m-3]

Thermal conductivity =Constant

Value = 1e-8 [W m-1K-1]

Specific heat =Constant

Value = 1e+8 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.
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· In the Properties window of Phase #0, specify:

Name = Air

· Add the substance Air into the folder Substances of the phase Air.

· In the Properties window of the folder Phases > Air > Physical processes, specify:

Motion = Navier-Stokes model 

Heat transfer = Heat transfer via h

· Create a continuous Phase #0.

· In the Properties window of Phase #0, specify:

Name = Vacuum

· Add the substance Vacuum into the folder Substances of the phase Vacuum.

· In the Properties window of the folder Phases > Vacuum > Physical processes, specify:

Heat transfer = Heat transfer via h

Radiation = P1

In the folder Models:

· Create Model #0.

· In the Properties window of Model #0, specify:

Name = Air

· Add phase Air into subfolder Air > Phases.

· Create Model #0.

· In the Properties window of Model #0, specify:

Name = Vacuum

· Add phase Vacuum into subfolder Vacuum > Phases.

5.1.2.3 Specifying boundary conditions (Part 1)

In this exercise some parameters of connected boundary conditions can be only set after binding the
subregions.

After binding the subregions, it is necessary to specify some more parameters of the boundary
conditions.

In the Properties window of the subregion Lamp, specify:

Model = Vacuum



292FlowVision Help

 

Specify the following boundary conditions:

Boundary 1

Name = Glass bulb

Type = Connected

Boundary 2

Name = Filament

Type = Wall

Variables

Temperature (Vacuum) = Temperature

Value = 2400 [K]

Radiation density (Vacuum) = Calculating of radiation flux density

Blackness = 1

Boundary 3

Name = Wall

Type = Wall

Variables

Temperature (Vacuum) = Zero gradient

Radiation density (Vacuum) = Calculating of radiation flux density

Blackness = 1

In the Properties window of the subregion External environment, specify:
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Model = Air

Specify the following boundary conditions:

Boundary 1

Name = Glass bulb

Type = Connected

Boundary 2

Name = Wall

Type = Wall

Variables

Temperature(Air) = Zero gradient

Velocity​​(Air) = No slip

Boundary 3

Name = Outlet

Type = Inlet/Outlet

Variables

Temperature(Air) = Temperature
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Value = 0 [K]

Velocity ​​(Air) = Total pressure

Value = 0 [Pa]

5.1.2.4 Binding the subregions

Create Binder #0:

· Select Create from the context menu of the folder Binders.

· In the Create binder window, which opens, specify:

Free BC list = Lamp: Glass bulb

Free BC list = External environment: Glass bulb

Create Binder condition #0:

· Select Create from the context menu of the folder Binder conditions.

· In the Create binder condition dialog box, which opens, specify:

Connection type = Conjugate temperature

1st model = Vacuum

2nd model = Air

Specify the matching between the Binder and the Binder condition:

· From the context menu of the folder Binder condition #0 > Binders, select Add/Remove.

· Add Binder #0.

5.1.2.5 Specifying boundary conditions (Part 2)

For the subregion Lamp, specify the remaining boundary conditions' parameters (you add them to the
parameters, which have already been specified):

In the Properties window of the boundary condition Glass bulb, specify:

Variables

Radiation density (Vacuum) = Calculating of radiation flux density

Blackness = 0.0001

5.1.2.6 Initial grid

Specify in the Properties window of the Initial grid:

nX = 5

nY = 5

nZ = 5

In the Properties window of the Initial grid click Apply.

5.1.2.7 Adaptation

Specify an Adaptation in the subregion Lamp.

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #0 will be created.

· From the context menu of the element Adaptation #0 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place Lamp into the pane Selected and click OK.
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· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Objects and in the Select objects dialog box, which opens, place Computational space into the pane
Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 4

Split/Merge = Split

Layers

Layers for Level N = 4

Layers for Level N-1 = 4

Layers for Level N-2 = 4

Layers for Level N-3 = 4

Specify two Adaptations  in the subregion External environment:

Adaptation #1 will be created in the volume within a geometry object (cylinder), and Adaptation #2 will be
created on the surface of the glass bulb of the lamp:

· In Preprocessor, in the folder Objects, create a Cone/cylinder object.

· In the Properties window of the object Cone/cylinder #0, specify:

Location

Reference point

X = 0 [m]

Y = -0.26 [m]

Z = 0 [m]

Axis X

X = 0

Y = 1

Z = 0

Parameters

Height = 0.2 [m]

Radius 1 = 0.025 [m]

Radius 2 = 0.025 [m]

Base ratio = 1

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #1 will be created.

· From the context menu of the element Adaptation #1 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place External environment into the pane
Selected and click OK.

· From the context menu of the element Adaptation #1 > Objects select the command Add/Remove
Objects and in the Select objects dialog box, which opens, place Cone/cylinder #0 into the pane
Selected and click OK.

· In the Properties window of the element Adaptation #1 specify:

Enabled = Yes

Max level N = 4

Split/Merge = Split

Layers

Layers for Level N = 4

Layers for Level N-1 = 4
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Layers for Level N-2 = 4

Layers for Level N-3 = 4

· From the context menu of the folder Computational grid > Adaptation, select the Create command, so
Adaptation #2 will be created.

· From the context menu of the element Adaptation #2 > Subregions select the command Add/Remove
and in the Select Subregions dialog box, which opens, place External environment into the pane
Selected and click OK.

· From the context menu of the element Adaptation #2 > Objects select the command Add/Remove
Boundary Conditions and in the Select boundary conditions dialog box, which opens, place External
environment : Glass bulb into the pane Selected and click OK.

· In the Properties window of the element Adaptation #2 specify:

Enabled = Yes

Max level N = 5

Split/Merge = Split

Layers

Layers for Level N = 6

Layers for Level N-1 = 5

Layers for Level N-2 = 4

Layers for Level N-3 = 5

Layers for Level N-4 = 6

5.1.2.8 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 100

Max step = 1 [s]

5.1.2.9 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Velocity distribution in the plane of the flow

2. Temperature distribution in the plane of the flow
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5.1.2.9.1  Velocity distribution

· Specify orientation of Plane #0 (its object in the project tree is Objects > Plane #0 in the Postprocessor
tab). Specify in its Properties window:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.

· In the Properties window of the Vectors specify:

Grid

Size 1 = 100

Size 2 = 100

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 0.3

Min = 0
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Palette

Appearance

Enabled = Yes

Color = Black

The program will automatically specify the variable, which is used to build the vectors, Variable > Variable
= Velocity.

Note:

If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.

5.1.2.9.2  Temperature distribution

· Create a layer Color contours on Plane #0.

· In the Properties window of the Color contours specify:

Variable
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Variable = Temperature

Value range

Mode = Manual

Max = 14

Min = 1

Method = Isolines

Palette

Appearance

Enabled = Yes

Note:

If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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5.2 Rotation

FlowVision can take into account the rotation of surfaces in the selected coordinate system. The program can
take into account both normal and tangential components of the rotational speed or only the tangential
component.

To specify a rotation, you have to:
· Create a Local coordinate system and Rotation.
· Specify a rotation on the boundary condition, which is specified mounted on the rotating surface.
· If necessary, specify a Rotation on the Region.

5.2.1 Rotor

This example illustrates simulation of turbulent viscous motion of incompressible liquid between the blades of a
rotating rotor.

Parameters of the problem setting

Dimensions: 

Length of the inlet passage L = 0.17 [m]

Radius of the rotor R = 0.1 [m]

Inflow parameters:

Velocity on inlet: V
inl

 = 20 [m s-1]

Speed of rotation w = 300 [radian s-1]
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Parameters of the substance:

Density r = 1 [kg m-3]

Viscosity m = 1.82 * 10-5 [kg m-1s-1]

Reynolds number: 4
5

inl 10*5
101.82

10.0520

μ

DρV
Re 









Geometry: Rotor.STL

Project: Rotor

5.2.1.1 Physical model

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Gas

Molar mass

Value = 0.0289 [kg mole-1]

Density

Value = 1 [kg m-3]

Viscosity

Value = 1.82e-5 [kg m-1s-1]

Thermal conductivity

Value = 0.026 [W m-1K-1]

Specific heat

Value = 1009 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· In properties of the element Init. data #0 > Pulsations (Phase #0) specify Value = 0.01.

· In properties of the element Init. data #0 > Turbulent scale (Phase #0) specify Value = 0.01 [m].

5.2.1.2 Rotation

To specify a rotation of a surface, it is necessary to follow the next steps:
· Create a Local coordinate system relative to which the rotation will occur.
· Specify a Rotation in this Local coordinate systems.
· Specify the Rotation on a surface.

Create a Local coordinate system:
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· From the context menu of the folder Local coordinate systems, select Create.

Specify a Rotation:

· In Local CS #0 in the context menu of the folder Rotation, select Create.

· In the Properties window of Rotation #0, specify:

Speed = 300 [radian s-1]

Direction

X = 0

Y = 0

Z = 1
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To enable the accounting of the normal velocity's component during the rotation, specify in properties of
Region:

Local CS = Local CS #0

Rotation = Rotation #0
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5.2.1.3 Boundary conditions

In the Properties window of the SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Mass velocity = 20 [kg m-2 s-1]

TurbEnergy (Phase #0) = Pulsations
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Value = 0.01

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.01 [m]

Boundary 3

Name = Outlet

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy (Phase #0) = Pulsations

Value = 0.01

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.01 [m]

Boundary 4

Name = Blades

Type = Wall

Local CS = Local CS #0

Rotation = Rotation #0

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall
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5.2.1.4 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OZ (click the button )

Grid parameters

h_max = 0.01 [m]

h_min = 0.0025 [m]

Specify Reference line parameters for the reference line with coordinate z=0:

h = 0.0025 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate z=0.189:

h = 0.01 [m]

kh- = 1

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

nX = 50

nY = 50

In the Properties window of the Initial grid click Apply.
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5.2.1.5 Adaptation of the computational grid

Specify the adaptation of the computational grid on the boundary condition Blades:

· From the context menu of the folder Computational grid > Adaptation, select Create, so Adaptation #0
will be created.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, place SubRegion #0 : Blades
into the pane Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 4

5.2.1.6 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.0001 [s]

5.2.1.7 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Pressure variation on inlet

2. Velocity distribution in the plane of rotation of the blades

5.2.1.7.1  Pressure variation on inlet

· Create a Supergroup on the BC Inlet using the command Create supergroup > In Preprocessor from the
context menu.

· Create Characteristics on this Supergroup.

· In the Properties window of the appropriate Characteristics object, which locates in the Preprocessor tab
of the project tree, specify:

Variable

Variable = Pressure
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· In the Properties window of the appropriate Characteristics object, which locates in the Postprocessor tab
of the project tree, specify:

Save to file

Type = Automatic

· After the computation is finished, open the glo-file, which is recorded by the data from the Characteristics,

and plot the dependency of Avg by Time.

5.2.1.7.2  Velocity distribution

Visualization at the step number 2250:

· In properties of Plane #0 specify:

Object

Reference point

X = 0

Y = 0

Z = 0.01

Normal

X = 0



309FlowVision Help

 

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.

· In properties of the Vectors specify:

On regular grid = No

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 55

Min = 15

Palette

Appearance

Enabled = Yes

Style = Style 1

The program will automatically specify the variable, which is used to build the vectors, Variable > Variable
= Velocity.
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5.2.2 Sector of a rotor

This example illustrates simulation of movement of incompressible gas between blades of a 8-blade rotor. To
speed up the calculation, the flow is simulated in only one sector of the rotor.

Parameters of the problem setting

Dimensions:

Length of the inlet passage L = 0.17 [m]

Radius of the rotor R = 0.1 [m]

Inflow parameters:

Mass velocity on inlet rV
inl

 = 20 [kg m-2 s-1]

Speed of rotation w = 50 [radian s-1]

Substance: = Air

Geometry: RotorSector.wrl

Project: RotorSector
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5.2.2.1 Making geometry of the computational domain

When simulating the flow in the rotor consisting of several identical sectors, to reduce the dimension of the
task, it is reasonable to calculate the motion in one of the sectors. Do the following:

· At the step of preparation the geometry, cut from the full geometric model of the rotor one of its periodic
sectors.

· When specifying the project, match appropriate surfaces using a periodic binder condition.

5.2.2.2 Physical model

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· In properties of the folder Phase #0 > Physical processes, specify:

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· In the folder Init. data #0, specify:

Pulsations(Phase #0)
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Value = 0.01

Turbulent scale(Phase #0)

Value = 0.01 [m]

5.2.2.3 Rotation

Create a Local coordinate system (local coordinate system):

· From the context menu of the folder Local coordinate systems, select Create.

Specify a Rotation:

· In the folder Local CS #0 > Rotation create Rotation #0.

· In the Properties window of Rotation #0, specify:

Speed = 50 [radian s-1]

Direction

X = 0

Y = 0

Z = 1

In the Properties window of Region, specify:

Local CS = Local CS #0

Rotation = Rotation #0
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5.2.2.4 Boundary conditions

In properties of SubRegion #0 specify:

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity ​​(Phase #0) = Normal mass velocity

Mass velocity = 20 [kg m-2 s-1]

TurbEnergy (Phase #0) = Pulsations

Value = 0.01

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.01 [m]
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Boundary 3

Name = Outlet

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy (Phase #0) = Pulsations

Value = 0.01

TurbDissipation (Phase #0) = Turbulent scale

Value = 0.01 [m]

Boundary 4

Name = Blades

Type = Wall

Local CS = Local CS #0

Rotation = Rotation #0

Variables

Velocity ​​(Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 5

Name = Binder surface 1_1

Type = Connected

Boundary 6

Name = Binder surface 1_2

Type = Connected

Boundary 7

Name = Binder surface 2_1

Type = Connected

Boundary 8

Name = Binder surface 2_2

Type = Connected

5.2.2.5 Binding the subregions

When binding boundary conditions that are not different sides of one surface, it is necessary to specify Snap
points, which are reference points on each of the two bound surfaces matching to each other. It is enough to
specify one pair of snap points for each binder.

To specify a pair of snap points, it is necessary:



315FlowVision Help

 

· In the folder Free BCs in the context menus of both connected boundary conditions select Create snap
point.

· In the Properties windows of both snap points specify their coordinates in such a way that provides
correct matching of the surfaces that will be bound.

Create a snap point on the boundary condition Binder surface 1_1:

· From the context menu of the element Free BCs > SubRegion #0 : Binder surface 1_1 select the
command Create snap point.

· In the Properties window of Snap point #0, specify:

Coordinates

X = -0.039199

Y = 0.028954

Z = 0

Create a snap point on the BC Binder surface 1_2:

· From the context menu of the BC Binder surface 1_2 select Create snap point.

· In the Properties window of Snap point #0, specify:

Coordinates

X = -0.007244

Y = 0.048191

Z = 0

Create a snap point on the BC Binder surface 2_1:

· From the context menu of the BC Binder surface 2_1 select Create snap point.

· In the Properties window of Snap point #0, specify:

Coordinates

X = 0.004345

Y = 0.097904

Z = 0
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Create a snap point on the BC Binder surface 2_2:

· From the context menu of the BC Binder surface 2_2 select Create snap point.

· In the Properties window of Snap point #0, specify:

Coordinates

X = 0.072301

Y = 0.066156

Z = 0

Create Binder #0 and Binder #1:

· From the context menu of the folder Binders, select Create all.

Create Binder condition #0:

· From the context menu of the folder Binder conditions, select Create.

· In the Create binder condition dialog box, which opens, specify:

Connection type = Periodic surface

1st model = Model #0

2nd model = Model #0

Specify the matching between the Binders and the Binder condition:

· From the context menu of the folder Binder conditions > Binder condition #0 > Binders, select
Add/Remove and click Add All button in the Select binders dialog box, which opens.

5.2.2.6 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.
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Specify in the Initial grid editor:

for axis OZ (click the button )

Grid parameters

h_max = 0.01 [m]

h_min = 0.0025 [m]

Specify Reference line parameters for the reference line with coordinate z=0:

h = 0.0025 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate z=0.189:

h = 0.01 [m]

kh- = 1

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

nX = 25

nY = 25

In the Properties window of the Initial grid click Apply.

5.2.2.7 Adaptation of the computational grid

Specify the adaptation of the computational grid on the boundary condition Blades:

· From the context menu of the folder Computational grid > Adaptation, select Create, so Adaptation #0
will be created.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, place SubRegion #0 : Blades
into Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 2

5.2.2.8 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = In seconds

Constant step = 0.0001 [s]

5.2.2.9 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Pressure variation on inlet

2. Velocity distribution in the plane of rotation of the blades
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5.2.2.9.1  Pressure variation on inlet

We consider below two methods of displaying a plot the pressure variation on inlet. The first steps of these
methods are same:

· On the BC Inlet create a Supergroup in Preprocessor (use in the context menu the command Create
supergroup > In Preprocessor).

· Create Characteristics on this Supergroup.

· In properties of the created element Characteristics > Characteristics #0 (Supergroup on "Inlet") specify:

Variable

Variable = Pressure

Displaying the plot in the Monitor window

In the Solver tab, in the folder Stopping conditions > User values create a user Stop criterion #0 and in its
properties specify:

Object = Characteristics #0 (Supergroup on "Inlet")

Variable = <f surf.>

Run the computation and view dynamics of  the pressure variation on inlet in the Plot tab of the Monitor
window (select the Stop criterion #0 in the right pane and set parameters of the plot if necessary):

RotorSector_PressureVariatinChart_MonYellow__E.png

Displaying the plot in an external program

· In the Postprocessor tab, in properties of the element Characteristics > Characteristics #0 (Supergroup
on "Inlet"), specify:

Save to file

Type = Automatic
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· After the computation is finished, open the glo-file, which is specified in properties of the element

Characteristics #0 (Supergroup on "Inlet"), by an external program (for example, by Excel) and plot the
dependency of Avg by Time.

·

5.2.2.9.2  Velocity distribution

· In the Properties window of Plane #0 specify:

Object

Reference point

X = 0

Y = 0

Z = 0.01

Normal

X = 0

Y = 0

Z = 1



320FlowVision Help

 

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on Plane #0.

· In the Properties window of the layer specify:

On regular grid = No

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 55

Min = 5

Palette

Appearance

Enabled = Yes

Style = Style 1

The program will automatically specify the variable, which is used to build the vectors, Variable >
Variable = Velocity.

5.2.3 Rotor+Stator

This example illustrates simulation of movement of the air between blades of a rotating rotor and in the stator's
outlet passage.
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Parameters of the problem setting

Dimensions:

Length of the inlet passage L = 0.17 [m]

Radius of the rotor R = 0.1 [m]

Inflow parameters:

Mass velocity on inlet rV
inl

 = 20 [kg m-2 s-1]

Speed of rotation w = 50 [radian s-1]

Substance: = Air

Geometry: RotorStator.STL

Project: RotorStator

5.2.3.1 Making geometry of the computational domain

When simulating rotations of surfaces in the computational domain, the outer boundary of which is not a
surface of revolution around an appropriate axis of rotation, it is necessary to split the geometry into several
subregions. Thus, the outer boundaries of the subregions, where the rotation is defined, must be surfaces of
revolution around an appropriate axis. Relationship between subregions is provided by Sliding Binder
conditions that allow simulation of fluid flows across subregions' borders taking into account the rotation of the
rotating subregion relating to the stationary subregion.

To split subregions, you have to do the following steps:
· Create a Rotation.
· Create a splitting surface.
· Split the computational domain into Subregions by the splitting surface.

Create a Rotation:

· Create a Local coordinate system.

· In the folder Local CS #0 > Rotation create Rotation #0.

· In the Properties window of Rotation #0, specify:

Speed = 50 [radian s-1]

Direction

X = 0

Y = 0

Z = 1
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Create a separating surface:

· In the folder Object create a Cone/cylinder.

· Specify in the Properties window of Cone/cylinder #0.

Location

Reference point

X = 0.0005 [m]

Y = 0 [m]

Z = 0 [m]

Axis X

X = 0

Y = 0

Z = 1

Parameters

Height = 0.018 [m]

Radius 1 = 0.1025 [m]

Radius 2 = 0.1025 [m]

Base ratio = 1

· From the context menu of Cone/cylinder #0 select Copy as imported object.

· In the Surface extraction window, check Lateral surface only. Bottom base and Top base must remain
unchecked.
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· From the context menu of the Sliding surfaces folder, select Create.

· In the Create new sliding surface window, specify:

Object = Imported object #0
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Split the computational domain into Subregions by the splitting surface:

· In the Properties window of Sliding surface #0 specify:

Local CS = Local CS #0

Rotation = Rotation #0

· From the context menu of Sliding surface #0, select Insert:
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5.2.3.2 Physical model

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· In the folder Init. data #0, specify:

Pulsations(Phase #0)

Value = 0.01

Turbulent scale(Phase #0)

Value = 0.01 [m]

5.2.3.3 Boundary conditions

In the Properties window of the Subregion, which corresponds to the rotor (see illustration below), specify:

Name = Rotor
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Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Boundary 2

Name = Inlet

Type = Inlet/Outlet

Variables

Velocity(Phase #0) = Normal mass velocity

Mass velocity = 20 [kg m-2 s-1]

TurbEnergy(Phase #0) = Pulsations

Value = 0.01
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TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]

Boundary 3

Name = Connection surface

Type = Connected

Boundary 4

Name = Blades

Type = Wall

Local CS = Local CS #0

Rotation = Rotation #0

Variables

Velocity(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

In the Properties window of the Subregion, which corresponds to the stator (see illustration below), specify:

Name = Stator

Model = Model #0

Specify the following boundary conditions:

Boundary 1

Name = Wall

Type = Wall

Variables

Velocity(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall
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Boundary 2

Name = Outlet

Type = Free Outlet

Variables

Velocity(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy(Phase #0) = Pulsations

Value = 0.01

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]

Boundary 3

Name = Connection surface

Type = Connected

5.2.3.4 Binding the subregions

Create Binder #0:

· Select Create all from the context menu of the folder Binders.

Create Binder condition #0:

· Select Create from the context menu of the folder Binder conditions.

· In the Create binder condition dialog box, which opens, specify:

Connection type = Sliding surface

1st model = Model #0

2nd model = Model #0

Specify the matching between the Binder and the Binder condition:

· From the context menu of the folder Binder condition #0 > Binders select Add/Remove.

· Add Binder #0 into the folder.

In the Properties window of the subregion Rotor, specify:

Local CS = Local CS #0

Rotation  = Rotation #0
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5.2.3.5 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OZ (click the button )

Grid parameters

h_max = 0.01 [m]

h_min = 0.0025 [m]

Specify Reference line parameters for the reference line with coordinate z=0:

h = 0.0025 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate z=0.189:

h = 0.01 [m]

kh- = 1

Click OK to close the Initial grid editor with saving the entered data.

Specify in the Properties window of the Initial grid:

nX = 75

nY = 70

In the Properties window of the Initial grid click Apply.

5.2.3.6 Adaptation of the computational grid

Create an Adaptation of the computational grid that will be active in the subregion Rotor (on Blades and on
the Connection surface) and in the subregion Stator on the Connection surface:

· From the context menu of the folder Computational grid > Adaptation, select Create, so Adaptation #0
will be created.

· From the context menu of the element Adaptation #0 > Subregions select Add/Remove and, in the
Select Subregions dialog box, place both Rotor and Stator into the Selected pane, and then click OK.

· From the context menu of the element Adaptation #0 > Objects select Add/Remove Boundary
Conditions and, in the Select boundary conditions dialog box, place Rotor : Blades, Rotor : Connection
surface, and Stator : Connection surface into the Selected pane, and then click OK.
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· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 2

5.2.3.7 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 100

Slide CFL = 1

Max step = 0.001 [s]

5.2.3.8 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Pressure variation on inlet

2. Pressure distribution in the plane of rotation of the blades

5.2.3.8.1  Pressure variation on inlet

· Create a Supergroup on the BC Inlet using the command Create supergroup > In Preprocessor from the
context menu.

· Create Characteristics on this Supergroup.

· In the Properties window of the appropriate Characteristics object, which locates in the Preprocessor tab
of the project tree, specify:

Variable

Variable = Pressure

· In the Properties window of the appropriate Characteristics object, which locates in the Postprocessor tab
of the project tree, specify:

Save to file
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Type = Automatic

· When the computation is finished, open the glo-file recorded, which is recorded from the Characteristics

and make a plot of Avg depending on Time.

5.2.3.8.2  Pressure distribution

· In the Properties window of Plane #0 specify:

Object

Reference point

X = 0

Y = 0

Z = 0.01

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer specify:

Variable

Variable Pressure
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Value range

Mode = Manual

Max = 13000

Min = -1000

Palette

Appearance

Enabled = Yes

Style = Style 3

Color = Black

Note:

In the current version of the program inaccuracies might appear in the displaying of layers when solving
problems with sliding surfaces.

5.2.4 Rotating tank

This example illustrates simulation of a rotating tank, which is half-filled with some liquid.
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Parameters of the problem setting

Dimensions:

Height of the tank L = 2 [m]

Radius of the tank R = 0.5 [m]

Parameters of the wall

Speed of rotation w = 10 [radian s-1]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 100 [kg m-1s-1]

Level of the liquid h = 1 [m]

Geometry: Bak.STL

Project: Bak

5.2.4.1 Physical model

In the Properties window of the element General settings specify:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

Viscosity

Value = 100 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

· Create a continuous Phase #1.

In the folder Models:

· Create Model #0.

· Add phases Phase #0 andPhase #1 into subfolder Model #0 > Phases.



334FlowVision Help

 

5.2.4.2 Rotation

Create a Local coordinate system:

· From the context menu of the folder Local coordinate systems, select Create.

Specify a Rotation:

· In the folder Local CS #0 > Rotation, create Rotation #0.

· In the Properties window of Rotation #0, specify:

Speed = 10 [radian s-1]

Direction

X = 0

Y = 1

Z = 0

5.2.4.3 Boundary conditions

In the Properties window of SubRegion #0, specify:

Model = Model #0

Specify the following boundary conditions: 

Boundaries 1, 2
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Type = Wall

Local CS = Local CS #0

Rotation = Rotation #0

Variables

Velocity ​(Phase #0) = No slip
VOF(Phase #0) =Symmetry

Boundary 3

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0 [Pa]
VOF (Phase #0) = Zero gradient

5.2.4.4 Initial conditions

Specify the initial volume of the liquid:

· In properties of the element Model #0 > Init. data > Init. data #0, specify:

VOF

Value = 1

· In the folder Objects create Box #0.

· In the Properties window of Box #0 specify:

Location

Reference point

X = 0 [m]

Y = 0.5 [m]

Z = 0 [m]

Size

X = 1 [m]

Y = 0.99 [m]

Z = 1 [m]

· In SubRegion #0, in the Properties window of the element Initial conditions > Init. condition #0, specify:

Object = Box #0

Init. data = Init. data #0
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5.2.4.5 Initial grid

Specify in the Properties window of the Initial grid:

nX = 20

nY = 40

nZ = 20

In the Properties window of the Initial grid click Apply.

5.2.4.6 Adaptation of the computational grid

Specify the adaptation of the computational grid on the boundary condition, which corresponds to the side wall
of the tank:

· From the context menu of the folder Computational grid > Adaptation, select Create, so Adaptation #0
will be created.
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· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, move the boundary condition,
which corresponds to the side wall of the tank, from the pane Not selected to the pane Selected, and then
click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 4

Layers for Level N-1 = 4

5.2.4.7 Parameters of calculation

In the Solver tab, in properties of the Time step element, specify:

Method = Via CFL number

Surface CFL = 1

Max step = 1 [s]

5.2.4.8 Visualization

To view the dynamics of the solution during the computation, specify visualization of the liquid surface layer
before the start of computation.
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5.2.4.8.1  Surface of the liquid

Visualization at the step number 2000:

· Create a VOF layer on the Computational space.

· In properties of this layer, specify:

Clipped = Yes

Appearance

Fill

Color = Aqua

· In properties of Plane #0 specify Clipping object = Yes.

Notes:

If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.
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5.2.5 Sector of axial compressor

This example illustrates use of a sector-sliding setting for simulation of a transonic axial compressor. The flow
will be simulated in only one sector of the compressor, with use of sliding and periodic boundary conditions.

The simulated compressor is split into sectors, and boundaries between adjacent sectors are set as periodic
boundary conditions.

This simulation uses the techniques of sliding meshes.

This class of problems often requires researches of interference between stationary components and rotating
blades of the compressor. The techniques of sliding meshes allows the mesh, which is connected to the blade
ring of the rotor, to rotate relatively the stationary mesh, which is connected to the stator's blades. Absence of
a procedure of permanent regeneration of a mesh around rotating rotor's blades increases the precision of the
solution and reduces the required calculation time. This exercise is based on the well-known NASA stage37
compressor.

Parameters of the problem setting

Number of rotor's blades = 36

Number of stator's blades = 46

Size:

Radial clearance = 0.365 x 10-3 [m]

Input parameters

Angular speed of rotor's rotation w = 1800 [radian s-1]

Working medium = air

Reference pressure Pref = 101325 [Pa]
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Reference temperature Tref = 283 [K]

Geometry: NASA_stage37.wrl

Project: NASA_stage37

5.2.5.1 Making geometry of the computational domain

In simulations of problems with rotating bodies, when the flow is assumed to be axially symmetric relatively to
the axis of rotation, to reduce the calculation time, it is desired to select a sector containing the geometry of
the shroud and of one compressor's blade, and simulate the flow in only this sector.

For this, it is necessary to modify the compressor's geometry in the CAD software. The specified sector should
pack into the full circle (360 degrees) an integer number of times. In the NASA stage37 axial compressor the
rotor's wheel has 36 blades, and the stator's blade contains 46 blades. So the sector, which contains a rotor's
blade, should be multiple of 360/36 = 10 degrees, and the sector, which contains a stator's blade, should be
multiple of 360/46 = 7.826 degrees. In this exercise we used the minimal possible sector angles that are
multiple of these values.

The inlet part can be combined with the rotor's sector or, as in our exercise (to demonstrate possible
functionality), be specified as a separate sector with angle as of 7.5 degrees.

Surfaces of all subregions must be closed and not coincide. To provide this, it is necessary, in the CAD
software, to move apart the subregions, obtained after splitting into sectors the common initial geometry of the
assembly.
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Moving the subregions apart can be done by the following methods:
· by moving the subregions apart along their axis of rotation (this is done so in our exercise, as

shown on the illustration above)
· by turning the subregions around their axis of rotation so their conjugated surfaces will not

coincide

5.2.5.2 Physical model

Load into Pre-Postprocessor the previously prepared geometry of the project, NASA_stage37.wrl.

After loading the geometry, FlowVision will automatically recognize three subregions.

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· In properties of the folder Phase #0 > Physical processes, specify:

Heat transfer = Heat transfer via H

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:
· Create Model #0.
· Add Phase #0 into subfolder Model #0 > Phases.
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Rename the recognized Subregions as Inlet, Rotor, and Stator. Specify Model = Model #0 in properties of
each of these Subregions.

In the folder Models > Model #0 > Init. data > Init. data #0 specify:

Velocity (Phase #0)

X = 150 [m s-1]

5.2.5.3 Boundary conditions

Boundary conditions of the subregion "Inlet"

In the subregion Inlet specify the following boundary conditions:
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Boundary 0

Name = Periodic1

Type = Connected

Boundary 1

Name = Inlet-Rotor

Type = Connected

Boundary 2

Name = Periodic2

Type = Connected

Boundary 3
Name = Shroud

Type = Wall

Variables

Temperature (Phase #0) = Zero gradient

Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 4

Name = Inlet

Type = Inlet/Outlet

Variables

Temperature (Phase #0) = Total temperature

    Value = 0   [K]

Velocity (Phase #0) = Total pressure

    Value = 0   [Pa]

TurbEnergy (Phase #0) = Pulsations

    Value = 0

TurbDissipation (Phase #0) = Turbulent scale

    Value = 0

Boundary conditions of the subregion "Rotor"
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In the subregion Rotor specify the following boundary conditions:

Boundary 0

Name = Periodic1

Type = Connected

Boundary 1

Name = Rotor-Stator

Type = Connected

Boundary 2

Name = Shroud

Type = Wall

Variables
Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 3

Name = Inlet-Rotor

Type = Connected

Boundary 4

Name = Periodic2

Type = Connected

Boundary 5

Name = Hub

Type = Wall

Variables
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Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 6

Name = Blade

Type = Wall

Variables
Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 7

Name = Blade tip

Type = Wall

Variables
Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary conditions of the subregion "Stator"

In the subregion Stator specify the following boundary conditions:

Boundary 0

Name = Blade

Type = Wall

Variables
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Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 1

Name = Shroud

Type = Wall

Variables
Temperature (Phase #0) = Zero gradient
Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Boundary 2

Name = Rotor-Stator

Type = Connected

Boundary 3

Name = Periodic2

Type = Connected

Boundary 4

Name = Outlet

Type = Free Outlet

Boundary 5

Name = Periodic1

Type = Connected

5.2.5.4 Specifying the Rotation and binding Subregions

To use the technique of sliding meshes, it is necessary to bind Subregions. For this, you have to create a
Local coordinate system having a Rotation element.

This element Rotation has to be assigned to those interface boundary conditions, from which the working
medium (gas) will flow from one Subregion to another.

In this exercise, the computational area consists of three Subregions and has two interface surfaces, so the
binder conditions will be created for:

· two pairs of Boundary conditions, connecting the Subregions
· and three pairs of periodic Boundary conditions

Create a Local coordinate system:
· From the context menu of the folder Local coordinate systems, select Create.

Specify a Rotation:
· In the folder Local CS #0 > Rotation create Rotation #0.
· In the Properties window of Rotation #0, specify:

Speed = 1800 [radian s-1]

Direction

X = 1

Y = 0
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Z = 0

In the subregion Inlet, specify:

· In the Properties window of the boundary condition Inlet-Rotor, specify:

Local CS = Local CS #0

Rotation = Rotation #0

In the subregion Rotor, specify:

· In the Properties window of the boundary condition Inlet-Rotor, specify:

Local CS = Local CS #0

Rotation = Rotation #0

· In the Properties window of the boundary condition Rotor-Stator, specify:

Local CS = Local CS #0

Rotation = Rotation #0

In the subregion Stator, specify:

· In the Properties window of the boundary condition Rotor-Stator, specify:

Local CS = Local CS #0

Rotation = Rotation #0

As it already has explained in the exercise Sector of a rotor, when boundary conditions for periodic surfaces are
being bound, it is necessary to specify Snap points. Let's specify a pair of Snap points per each binder,
which is used to bind periodic surfaces.

For this, in the folder Free BCs, from context menus of both Boundary conditions that are to be bound, select
the command Create snap point. Then, in the Properties windows of the both snap points, if necessary,

specify their coordinates or move the Snap points using icon buttons with arrows ( , , , ) in such
way, that, at binding the periodic surfaces, these Snap points will correctly match each other.

Correct matching of Snap points might require their movement.

Buttons  and  (thick arrows) in the Properties windows of a Snap point move the Snap
point along the contour of the periodic surface to the next sharp bend of the contour. It is
recommended to use these buttons when the contour has evident sharp bends.

Buttons  and  (thin arrows) in the Properties windows of a Snap point move the Snap point
along the contour of the periodic surface to the next vertex of the polygon, which approximates the
curvilinear contour. This buttons move the Snap point relatively slowly and without selecting
positions of sharp bends; this is less convenient and increases the risk of errors.

Also you can enter coordinates of the Snap point and then click Apply.

In the folder Free BCs, create Snap points for the following Boundary conditions:
· Inlet: Periodic1
· Inlet: Periodic2
· Rotor: Periodic1
· Rotor: Periodic2
· Stator: Periodic1
· Stator: Periodic2
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You don't have to create snap points for binding sliding surfaces, and, after a Local CS (local
coordinate system) and Rotation are specified on such surfaces, it will be  impossible to specify snap
points on these surfaces.

Create Binders:
· From the context menu of the folder Binders, select Create all.

Create Binder condition #0:
· From the context menu of the folder Binder conditions, select Create.
· In the Create binder condition dialog box, which opens, specify:

Connection type = Periodic surface

1st model = Model #0

2nd model = Model #0

Specify the matching between the Binders and the Binder condition:
· From the context menu of the folder Binder conditions > Binder condition #0 > Binders, select

Add/Remove and click Add All button in the Select binders dialog box, which opens.

Create Binder condition #1:
· From the context menu of the folder Binder conditions, select Create.
· In the Create binder condition dialog box, which opens, specify:

Connection type = Sliding surface

1st model = Model #0

2nd model = Model #0

Specify the matching between the Binders and the Binder condition:
· From the context menu of the folder Binder conditions > Binder condition #1 > Binders, select

Add/Remove and click Add All button in the Select binders dialog box, which opens.

5.2.5.5 Specifying the rotor's rotation

In the Properties window of the subregion Rotor, specify:

Local CS = Local CS #0

Rotation = Rotation #0
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Also specify Local CS = Local CS #0 and Rotation = Rotation #0 in properties of boundary conditions in the
subregion Rotor:

· In the Properties window of the boundary condition Blade, specify:

Local CS = Local CS #0

Rotation = Rotation #0

· In the Properties window of the boundary condition Hub, specify:

Local CS = Local CS #0

Rotation = Rotation #0

· In the Properties window of the boundary condition Blade tip, specify:

Local CS = Local CS #0

Rotation = Rotation #0

5.2.5.6 Initial grid

Specify in the Properties window of the Initial grid:
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nX = 120

nY = 60

nZ = 50

In the Properties window of the Initial grid click Apply.

5.2.5.7 Adaptation of the computational grid

Specify the adaptation in the subregion Rotor:

· Create the element Computational grid > Adaptation > Adaptation #0.

· From the context menu of the element Adaptation #0 > Subregions select Add/Remove and, in the
Select Subregions dialog box, place Rotor into Selected, and click OK.

· From the context menu of the element Adaptation #0 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, place Rotor : Blade into
Selected and click OK.

· In the Properties window of the element Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 2

· Create the element Computational grid > Adaptation > Adaptation #1.

· From the context menu of the element Adaptation #1 > Subregions select Add/Remove and, in the
Select Subregions dialog box, place Rotor into Selected, and click OK.

· From the context menu of the element Adaptation #1 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, place Rotor : Blade tip into
Selected and click OK.

· In the Properties window of the element Adaptation #1 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 2

Layers for Level N-1 = 2

Specify the adaptation in the subregion Stator:

· Create the element Computational grid > Adaptation > Adaptation #2.

· From the context menu of the element Adaptation #2 > Subregions select Add/Remove and, in the
Select Subregions dialog box, place Stator into Selected, and click OK.

· From the context menu of the element Adaptation #2 > Objects select the command Add/Remove
Boundary Conditions and, in the Select boundary conditions dialog box, place Stator : Blade into
Selected and click OK.

· In the Properties window of the element Adaptation #2 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 2

Note: This project uses a simplified computational grid. To obtain good results, use a grid with higher
resolution.
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5.2.5.8 Parameters of calculation

In the Solver tab of the project tree, specify:

· In the Properties window of the element Time step, specify:

Method = Via CFL number

Convective CFL = 100

Max step = 0.001 [s]

· In the Properties window of the element Advanced settings, specify:

Numerical method

Advection scheme = 1st order scheme

Type of scheme = Implicit 

Sliding surfaces

Method *) = Frozen Rotor

*) Problems in sector-sliding settings are recommended to be simulated using the Frozen Rotor method.

· In the Properties window of the element Limiters > Limiters for calculation > Phase Limiters > Phase
#0, specify:

Limiter

Density, min. = 0.001 [kg m-3]

Temperature abs, min. = 100 [K]

Temperature abs, max. = 500 [K]

Velocity, max. = 10e+4 [m s-1]

Pressure abs, min. = 100 [Pa]

Pressure abs, max. = 10e+9 [Pa]

5.2.5.9 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:
1. Mass flow variation
2. Mach Number distribution on a cylindrical surface, which goes through Inlet, Rotor and Stator

5.2.5.9.1  Mass flow variation

This problem is a quasi-steady-state one. To find the convergence of the solution, it is necessary to watch
values of algebraic residuals.

Also this class of problems has another character parameter, the mass flow. To watch the mass flow, lets
create a Characteristics in the Preprocessor tab of the project tree.

In the project tree, in the Preprocessor tab, open the context menu of the object Subregions > Inlet >
Boundary conditions > Inlet and, selecting there the command Create supergroup > In Preprocessor,
create a Supergroup on the boundary condition Inlet.

Create Characteristics #0 on the new just created Supergroup.

In the Properties window of Characteristics #0, specify:

Variable

    Variable = Pressure

Create a Stop criterion:
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In the project tree, in the Solver tab, in the folder Stopping conditions > User values, create Stop criterion
#0.

In the Properties window of Stop criterion #0, specify:

Level = 1e-4

Object = Characteristics #0 (Supergroup on "Inlet")

Variable = Mass flow+

Stop criterion #0, which you have just created, you can watch variation of the variable Mass flow+
immediately in Pre-Postprocessor, in the Plot tab of the Monitor window:

5.2.5.9.2  Mach Number distribution

To view the whole rotor, stator, and circular inlet of the compressor, click the button  (Enable/disable
duplication and overlapping of subdomains up to the complete model supplied with sector-sliding) in
the Rendering toolbar. Images of Subregions will be multiplied (repeatedly copied and placed around the
compressor's axis of rotation):
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Displaying or hiding periodic and/or slicing boundary conditions in the image, formed when you click the 
button, can be tuned by parameters Display > Subregion positioning > ... in the Preferences window, which
is opened by the File > Preferences command from the main menu:
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From the main menu select the command File > Preferences and in the Preferences window, which opens,
specify:

Display > Subregion positioning > Hide periodic = Yes

Display > Subregion positioning > Hide sliding = Yes

Note: Making multiple images of Subregions will require additional resources of RAM memory on the Solver's
side and video RAM memory on the side of the client computer.

In the project tree, in the Postprocessor tab, create a geometric object Cone/cylinder.

In the Properties window of the just created object Cone/cylinder #0, specify the following parameters:

Object

Location > Reference point

   X = -0.05 [m]

   Y = 0

   Z = 0

Parameters

   Height = 0.15 [m]

   Radius 1 = 0.22

   Radius 2 = 0.22

   Base ratio = 1



355FlowVision Help

 

On the object Cone/cylinder #0, create a Color contours layer.

In the Properties window of the just created layer Color contours #0 (Cone/cylinder #0), specify:

Parts

Select = Selected surfaces

Surfaces > Lateral surface = Yes

Surfaces > Bottom base = No

Surfaces > Top base = No

Variable

Variable = MachNumber

Value range

Mode = Local

Palette

Appearance > Enabled = Yes

During the project's computation, the visualization of the Mach Number distribution will be formed:
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5.3 Moving bodies

FlowVision allows changing the initial position of individual elements of the geometry and simulating of their
translational or rotational movement. This is supported by Moving body modifiers. The geometry of a moving
body is loaded from files, which are similar to the files with the basic geometry.

In order to simulate a task with moving bodies, it is necessary to:

· Create geometric models of the Moving bodies in FlowVision or using a third-party CAD software.

· Based on these geometric models, create Imported objects.

· Create Moving bodies.

· Disable updates of those Moving bodies, which will not move during the computation.

· Specify a law of motion for those Moving bodies, which will move during the computation.

· Specify appropriate boundary conditions on the surfaces of Moving bodies.

· It is advisable to use the value of the time step about 1xSurface CFL.

· If Moving bodies are moving in incompressible fluid under the action of forces from the fluid, and oscillations
occur, it is recommended to specify (in properties of the Substance) the Density, which depends on
Pressure and/or Temperature (for example, by specifying partial derivatives of Density with respect to
Pressure and/or to Temperature, dRho/dP and dRho/dT). If the oscillations do not disappear, it is
recommended to enable the Artificial compressibility in properties of the physical process Motion and
specify values of damping coefficients in properties of the Moving bodies (parameters Translation >
Damping parameter and Rotation > Damping parameter).

5.3.1 Transonic flow around an airfoil

This example illustrates a transonic flow around the RAE 2822 airfoil with the angle of attack of 2.31​ degrees.
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Parameters of the problem setting

Dimensions:

Chord length: c = 0.3 [m]

Dimensions of the computational
domain

13.8 × 12 × 0.1 [m × m × m]

Angle of attack: a = 2.31 °

Substance: = Air

Inlet parameters:

Static pressure: P = 109 000 [Pa]

Static temperature: T = 255.6 [K]

Velocity ​​on inlet: V
inl

=233,585 [m s-1]

Mach number: M = 0.73

Reynolds number: Re = 6.5 × 106

Geometry: RAE_2822_Domain.wrl

Project: RAE_2822

Note:

Computation of this project might require significant computing resources and a long time.

5.3.1.1 Physical model

In the Properties window of Region, specify:

Tolerance = 1e-10

In the Properties window of the element General settings specify:

Reference values

Temperature = 255.6 [K]

Pressure = 109000 [Pa]

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify in properties of the folder Physical processes:

Motion = Navier-Stokes model

Heat transfer = Heat transfer via H

Turbulence = SA

In the folder Models:

· Create Model #0.
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· Add Phase #0 into subfolder Model #0 > Phases.

· In the folder Init. data #0, specify:

Velocity

X = 233.585 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

5.3.1.2 Moving body

In order to be able to define the attack angle from the interface, it is necessary to specify the airfoil profile as a
Moving body.

Creation of a moving body consists of the following steps:
· creation the geometry of the Moving body
· creation a Moving body modifier

Geometry of a Moving body can be created:
· in a third-party geometric modeling software and then be loaded into FlowVision as an Imported object
· in FlowVision

In this example, the geometry of the Moving body is loaded in FlowVision from a file. To load the geometry of
the Moving body, do the following steps: 
· Select Create from the context menu of the folder Objects.
· Specify Object type = Imported object.
· Download the geometry of the moving body from the file RAE_2822_Airfoil.STL.

To assign the status of a moving body to the Imported object, do the following:

· In the Properties window of SubRegion #0, specify:

Model = Model #0

· In the folder Modifiers, create a new Moving body modifier based on an Imported object #0.
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· In the Properties window of the Moving body, specify:

Initial position

Axis X
X = 0.999187

Y = -0.04030

Z = 0

· In the Properties window of the Moving body, click Operations >  (Place to initial position).

· In the Properties window of the Moving body, specify:

Update
Type = Disabled

Notes:

1. After you disable updates of a Moving body, its Mass Properties, parameters of Translational and
Rotation movement, Initial position, Limitation becomes unavailable for editing. So the Initial position
is to be specified before you disable the Update.
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2. When update of a Moving body is enabled, then rebuilding of the grid is done on each iteration. This
operation is resource consuming and wastes CPU time. Therefore, in simulations where the Moving body
actually does not move, it is recommended to disable its Update.

3. If there are several Moving bodies in a simulation, then update of at least one of them will cause update of
the others.

5.3.1.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Non-reflecting

Variables

Temperature(Phase #0) = Non-reflect.

Value = 0 [K]

Velocity​​(Phase #0) = Non-reflect.

Velocity at inf.
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X = 233.585 [m s-1]

Y

Z

Pressure at inf. = 0 [Pa]

TurbKinViscosity(Phase #0) = Value

Value = 0

Boundary 2

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

TurbKinViscosity(Phase #0) = Symmetry

Boundary 3

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Logarithm law

TurbKinViscosity(Phase #0) = Value in cell near wall

5.3.1.4 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 1.5 [m]

h_min = 0.0015 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-6:

h = 1.5 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.0015 [m]
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kh- = 0.97

kh+ = 0.97

Specify Reference line parameters for the reference line with coordinate x=7.8:

h = 1.5 [m]

kh- = 0.93

for axis OY (click the button )

Grid parameters

h_max = 1.5 [m]

h_min = 0.0015 [m]

Insert a reference line with coordinate y=0 [m].

Specify Reference line parameters for the reference line with coordinate y=-6:

h = 1.5 [m]

kh+ = 1.4

Specify Reference line parameters for the reference line with coordinate y=0:

h = 0.0015 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate y=6:

h = 1.5 [m]

kh- = 0.6

Click OK to close the Initial grid editor with saving the entered data.

In properties of the Initial grid specify:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

5.3.1.5 Adaptation of the computational grid

In this project the computation is done in two stages:
· Up to 300-th step the computation is done on the coarse initial grid. At step 300 the solution will be a

steady-state one and it will form a supersonic area with a pressure surge on the upper surface of the airfoil.
Resolution of this area by the grid, details of the flow in the area and location of the pressure surge after the
300-th step will be found out at the second stage of the computation (see below).

· From the 300-th to the 500-th step an Adaptation by condition will be applied that will resolve supersonic
areas that were formed at the first stage. Also adaptation near the surface of the airfoil and merging the
cells that get out of the supersonic areas. At the 500-th step the solution becomes a steady-state one and
you can stop the computation.

So the following adaptations of the computational grid are specified in this project:
· a simple Adaptation on the surface of the airfoil
· Adaptation by condition M > 1. This adaptation will resolve supersonic area at upper side of the airfoil,

its maximal level is 2 and the algorithm creates 20 layers for each level outside, so this adaptation will
include the pressure surge after the supersonic area.

· an Adaptation for merging to the level 0 the cells that previously were split (adapted) but now are getting
out of the supersonic area

Specify a simple Adaptation on the boundary condition, which is set on the airfoil's surface (boundary 3):

· Create the element Computational grid > Adaptation > Adaptation #0.

· Add the boundary condition Wall #0, which is set on the airfoil's surface, to the subfolder Computational
grid > Adaptation > Adaptation #0 > Objects.

· In properties of Adaptation #0 specify:
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Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 10

Layers for Level N-1 = 10

Specify an Adaptation to solution, which will resolve the supersonic area over the airfoil and the pressure
surge after the supersonic area:

· Create the element Computational grid > Adaptation by condition > Adaptation by condition #0.

· Add Computational space to the subfolder Computational grid > Adaptation by condition >
Adaptation by condition #0 > Objects.

· In properties of Adaptation by condition #0 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 20

Layers for Level N-1 = 20

Conditions

Variable

   Variable = MachNumber

Range

From = 1

To = 10000000000

Specify a simple Adaptation to merge cells. This Adaptation will undo the grid refinement that was made by
Adaptation by condition #0, it will restore the initial size of the cells in places, from which the supersonic
area got away:

· Create the element Computational grid > Adaptation > Adaptation #1.

· Add Computational space to the subfolder Computational grid > Adaptation > Adaptation #1 >
Objects.

· In properties of Adaptation #1 specify:

Enabled = Yes

Max level N = 0

Split/Merge = Merge

The adaptations should be applied after the solution on the Initial grid is converged (becomes steady-state),
after the 300-th step. Specify this:

· In properties of the folder Computational grid > Adaptation specify:

Activation

Type = Inactive

· In properties of the folder Computational grid > Adaptation by condition specify:

Activation

Type = Repetitive by step

Start in steps = 300

Duration in steps = 5

Period in steps = 50

According to these settings, Adaptation #0 and Adaptation #1 will not be activated independently, because
activation of their folder Computational grid > Adaptation is disabled (Activation > Type = Inactive is set
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there). However, at the moments when Adaptation by condition #0 is triggered, these simple adaptations will
also be triggered, because Enabled = Yes is set in their properties.

For better understanding this tutorial case, start off with creating and running this project without grid
adaptations and watch dynamics of the solution.

And only after this specify adaptations and run the project with them.

5.3.1.6 Parameters of calculation

Specify in the Solver tab:

· In the Properties window of the Time step element specify:

Method = Via CFL number

Convective CFL = 100

Max step = 0.01 [s]

· In the Properties window of the Limiters > Limiters for calculation > Phase limiters > Phase #0 element
specify:

Limiter

Density, min. = 0.001 [kg m-3]

Velocity, max. = 1500 [m s-1]

Pressure abs, min. = 100 [Pa]

Pressure abs, max. = 1e+8 [Pa]

Temperature abs, min. = 100 [K]

Temperature abs, max. = 1e+5 [K]

5.3.1.7 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Mach number distribution in the plane of the flow

2. Cp distribution on the profile's surface
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5.3.1.7.1  Mach number distribution

· In the Properties window of Plane #0, specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Color contours on Plane #0.

· In the Properties window of the layer, specify:

Variable

Variable MachNumber

Value range

Mode = Manual

Max = 1.1

Min = 0.3

Method = Isolines

Palette

Appearance

Enabled = Yes
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The given illustration shows results of the simulation at the 600th time step.

5.3.1.7.2  Cp distribution

Building the distribution of Cp on the profile's surface consists of the following steps:

1. Creating the variable Cp

2. Creating the "Plot along curve" layer for Cp

5.3.1.7.2.1  Creating the variable Cp

Create the Cp variable in Postprocessor:

· From the context menu of the folder User Variables > Local, select Create > Scalar.

· In the Properties window of the just created variable, open the Formula editor (select the Value field and

then click  there):

· In the Formula editor, identify the variable Pressure (Phase #0).

o in the pane Variables & constants, in the tab All, select in Phase #0 the variable Pressure and

open the window Variable identification.

o in the Variable identification window, specify the name under which the variable will be presented

in the formula
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· In the Formula pane of the Formula editor enter -PRES0/(1.485713*233.585^2/2)



369FlowVision Help

 

· Click Accept.

5.3.1.7.2.2  Creating a plot along curve

· In the Properties window of Plane #0, specify:

Object

Reference point

X = -0.1

Y = -0.1
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Z = 0.05

· Create a layer Plot along curve on Plane #0.

· In the Properties window of the Plot along curve, specify:

Variable

Category = User variables

Variable = UV #0

Number of points = 1000

Distribute along = Every curve

Rotation angle = 90

Axis X

Length

    Mode = Manual

    Value = 0.5

Appearance

Plots

Visible = 1

5.3.2 Ball falling in viscous fluid

In this example, we consider falling of a ball caused by gravity inside a column of viscous incompressible fluid.

Forces act on the ball falling in the fluid, the force of gravity and the force of resistance.

After some time a stationary regime is reached, when the velocity of the ball becomes constant.
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Parameters of the problem setting

Dimensions of the region  = 30 × 30 [m × m]

Parameters of the ball

Radius R = 0.5 [m]

Density r = 1500 [kg m-3]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 1000 [kg m-1s-1]

Geometry FallingBall_Domain.STL

Project Falling_Ball

5.3.2.1 Physical model

In the Properties window of the element General settings specify:

· Add a hydrostatic layer by clicking Stratum > .

· Specify the following parameters:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

g-Point

X = 0 [m]

Y = 5 [m]

Z = 0 [m]

Stratum

   [0]

g-Thickness = 30 [m]

g-Density = 1000 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

Viscosity

Value = 1000 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]
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In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

Note:

The value Viscosity=1000 is set to increase the convergence.

5.3.2.2 Moving body

In the Properties window of SubRegion #0, specify:

Model = Model #0.

Create the geometry of the Moving body:
· In Preprocessor, in the folder Objects, create a new Ellipsoid/sphere object.
· In the Properties window of Ellipsoid/sphere #0, specify:

Parameters

Radius = 0.5 [m]

Approximation

Subdivisions = 200
· From the context menu of Ellipsoid/Sphere #0, select Copy as imported object.

Specify the Moving body:
· In the folder SubRegion #0 > Modifiers create a Moving body based on Imported object #0.
· In the Properties window of Moving body #0, specify:

Mass Properties

Mass [kg] = 785.4 [kg] 

Translation

TimeForces [s]

X = 0 [s]

Y = 0 [s]

Z = 0 [s]

HydroForce [N]

X = No

Y = Yes

Z = No

Notes:

1. Values of HydroForce and HydroTorque the program calculates automatically.

2. In order to place the body in the initial position, you have to click the button Operations >  (Place to
initial position).
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5.3.2.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Free Outlet

Variables

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

Boundary 2

Type = Wall

Variables

Velocity​​(Phase #0) = No slip
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5.3.2.4 Initial grid

Specify in the Properties window of the Initial grid:

nX = 15

nY = 15

nZ = 15

In the Properties window of the Initial grid click Apply.

5.3.2.5 Adaptation of the computational grid

In this example, the grid should be adapted on the surface of the moving ball and merge the previously adapted
cells that locate away from the ball. To do this, you have to set two Adaptations:

1. Splitting the cells on the surface of the ball
2. Merging the cells in the volume away from the ball

Specify the adaptation on the surface of the ball:

· Create Computational grid > Adaptation > Adaptation #0.

· Add the boundary condition, which corresponds to the ball's surface, to the subfolder Computational grid >
Adaptation > Adaptation #0 > Objects.

· In properties of Adaptation #0 specify:

Enabled = Yes

Max level N = 4

Layers
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Layers for Level N = 4

Layers for Level N-1 = 4

Layers for Level N-2 = 4

Layers for Level N-3 = 4

Specify the adaptation for merge of the previously split cells in the space along from the ball:

· Use the Copy command from the context menu of the element Computational grid > Adaptation >
Adaptation #0 to create the element Computational grid > Adaptation > Adaptation #1.

· From the context menu of the subfolder Computational grid > Adaptation > Adaptation #1 > Objects
select the command Add/Remove Boundary Conditions and in the Select boundary conditions dialog
box, which opens, remove the boundary condition, which corresponds to the surface of the ball, from the
pane Selected, and then click OK.

· Add the geometry object Computational space to the subfolder Computational grid > Adaptation >
Adaptation #1 > Objects.

· In properties of Adaptation #1 specify:

Enabled = Yes

Max level N = 0

Split/Merge = Merge

5.3.2.6 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Convective CFL = 1

Surface CFL = 20

Max step = 0.01 [s]

5.3.2.7 Visualization

To view the dynamics of the solution during the computation, specify visualization of the dependency of the
ball's velocity on the time prior the start of computation.

5.3.2.7.1  Ball's velocity in time

· Create Characteristics on the Imported object in Postprocessor.

· In the Properties window of the Characteristics, specify:
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Characteristics

Variable

Variable = Velocity

Component = Y

Save to file

Type = Automatic

· After the computation is done, download the glo-file from the server part of the project using the menu

command File > Download additional files and selecting the GLO-files checkbox.

· Using the data from the glo-file, plot the dependency of the ball's velocity (Velocity.y) on the time (Time).

5.3.3 Floating box

In this example, we consider the motion of a body with a displaced center of mass on the surface of the water
and generation of waves on the surface under because of the body's motion.

Parameters of the problem setting

Dimensions of the region = 0.6 × 0.3 × 0.3 [m × m × m]

Parameters of the body:

Dimensions a × b × c = 0.2 × 0.05 × 0.1 [m × m × m]

Density r = 500 [kg m-3]

Parameters of the liquid:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]
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Geometry FloatingBox_Domain.wrl

Project FloatingBox

5.3.3.1 Physical model

In the Properties window of the element General settings specify:

· Add a hydrostatic layer by clicking Stratum > .

· Specify the following parameters:

Gravity vector

X = 0 [m s-2]

Y =-9.8 [m s-2]

Z =0 [m s-2]

g-Point

X = 0 [m]

Y = 0 [m]

Z = 0 [m]

Stratum

   [0]

g-Thickness = 0.15 [m]

g-Density = 1000 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density 

Value = 1000 [kg m-3]

dRho/dP = 5.102e-007 [kg m-3 Pa-1]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

· Create a continuous Phase #1.

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.
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In properties of SubRegion #0 specify:

Model = Model #0

5.3.3.2 Moving body

Create a Moving body:
· Download the geometry of an Imported object from the file FloatingBox_Box.stl.

· In the folder SubRegion #0 > Modifiers create a Moving body on Imported object #0.
 

In the Properties window of the Moving body, specify:

Mass Properties

Mass [kg] = 0.5 [kg]

Center of Inertia

X = 0 [m] 

Y = 0 [m] 

Z = -0.005 [m] 

Moment Inertia X [kg*m2]

X = 0.00846 [kg m2]

Y = 0 [kg m2]

Z = 0 [kg m2]

Moment Inertia Y [kg*m2]

X = 0 [kg m2]

Y = 0.00333 [kg m2]

Z = 0 [kg m2]

Moment Inertia Z [kg*m2]

X = 0 [kg m2]

Y = 0 [kg m2]

Z = 0.00333 [kg m2]

Translation

TimeForces [s]

X = 0 [s]

Y = 0 [s]

Z = 0 [s]

HydroForce [N]

X = No

Y = Yes

Z = No

Rotation
TimeTorques [s]

X = 0 [s]

Y = 0 [s]

Z = 0 [s]

HydroTorque [N*m]

X = Yes

Y = No

Z = No
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Initial position

Reference point

X = 0.3 [m]

Y = 0.05 [m]

Z = 0.15 [m]

Note:

In order to place the body in the initial position, you have to click the button Operations >  (Place to initial
position).

5.3.3.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Velocity(Phase #0) = No slip
VOF(Phase #0) = Symmetry

Boundary 2

Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0
VOF (Phase #0) = Value

Value = 1

Boundary 3
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Type = Free Outlet

Variables

Velocity ​​(Phase #0) = Pressure

Value = 0
VOF (Phase #0) = Value

Value = 0

5.3.3.4 Initial conditions

In Model #0, in Init. data #0, specify:

VOF

Value = 1

In the folder Objects:

· create Box #0.

· In the Properties window of Box #0 specify:

Location

Reference point

X = 0.3 [m]

Y = -0.075 [m]

Z = 0.15 [m]

Size

X = 0.6 [m]

Y = 0.149 [m]

Z = 0.3 [m]

In SubRegion #0, in the Properties window of the element Initial conditions > Init. condition #0, specify:

Object = Box #0

Init. data = Init. data #0 

5.3.3.5 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.
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Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.05 [m]

h_min = 0.03 [m]

Insert a reference line with a coordinate x=0.3 [m].

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.05 [m]

Specify Reference line parameters for the reference line with coordinate x=0.3:

h = 0.03 [m]

Specify Reference line parameters for the reference line with coordinate x=0.6:

h = 0.05 [m]

for axis OY (click the button )

Grid parameters

h_max = 0.025 [m]

h_min = 0.004 [m]

Insert a reference line with a coordinate y=0 [m].

Specify Reference line parameters for the reference line with coordinate y=-0.15:

h = 0.025 [m]

Specify Reference line parameters for the reference line with coordinate y=0:

h = 0.004 [m]

Specify Reference line parameters for the reference line with coordinate y=0.15:

h = 0.025 [m]

for axis OZ (click the button )

Grid parameters

h_max = 0.0375 [m]

h_min = 0.006 [m]

Insert a reference line with a coordinate z=0.15 [m].

Specify Reference line parameters for the reference line with coordinate z=0:

h = 0.0375 [m]

Specify Reference line parameters for the reference line with coordinate z=0.15:

h = 0.006 [m]

Specify Reference line parameters for the reference line with coordinate z=0.3:

h = 0.0375 [m]

Click OK to close the Initial grid editor with saving the entered data.

In the Properties window of the Initial grid click Apply.

5.3.3.6 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Surface CFL = 1

Max step = 0.1 [s]
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5.3.3.7 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of a
Layer for water surface.

5.3.3.7.1  Water surface

· Create a VOF layer on Computational space.

5.3.4 Floating boat

In this example, we simulate motion of a boat through the water.

Parameters of the problem setting

Dimensions of the region = 52 × 25 × 24 [m × m × m]

Parameters of the body:
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Mass m = 968 [kg]

Parameters of water:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Inlet rate V
in

= 4 [m s-1]

Geometry Boat_Domain.wrl

Project Boat

Note:

Calculation of the project may require significant computing resources and long time.

5.3.4.1 Physical model

In the Properties window of the element General settings specify:

· Add a hydrostatic layer by clicking Stratum > .

· Specify the following parameters:

Gravity vector

X = 0 [m s-2]

Y =0 [m s-2]

Z =-9.8 [m s-2]

g-Point

X = 0 [m]

Y = 0 [m]

Z = 0 [m]

Stratum

   [0]
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g-Thickness = 12 [m]

g-Density = 1000 [kg m-3]

In the folder Substances:

· Create Substance #0.

· Specify the following properties of Substance #0:

Aggregative state = Liquid

Molar mass

Value =0.018 [kg mole-1]

Density

Value = 1000 [kg m-3]

Viscosity

Value = 0.001 [kg m-1s-1]

Specific heat

Value = 4217 [J kg-1 K-1]

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the folder Substances.

· Specify in properties of the folder Phase #0 > Physical processes:

Motion = Navier-Stokes model

Turbulence = KES

· Create a continuous Phase #1.

In the folder Models:

· Create Model #0.

· Add Phase #0 and Phase #1 into subfolder Model #0 > Phases.

In properties of SubRegion #0 specify:

Model = Model #0

5.3.4.2 Moving body

Create a Moving body:
· Download the geometry of an Imported object from the file Boat_Body.wrl.

· In the folder SubRegion #0 > Modifiers create a Moving body on Imported object #0.
 

In the Properties window of the Moving body, specify:

Mass Properties

Mass [kg] = 968 [kg] 

Center of Inertia

X = 3.856 [m]

Y = 0 [m]

Z = -0.12 [m]

Moment Inertia X [kg*m2]
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X = 304 [kg m2]

Y = 0 [kg m2]

Z = 0 [kg m2]

Moment Inertia Y [kg*m2]

X = 0 [kg m2]

Y = 6025 [kg m2]

Z = 0 [kg m2]

Moment Inertia Z [kg*m2]

X = 0 [kg m2]

Y = 0 [kg m2]

Z = 6080 [kg m2]

Translation

TimeForces [s]

X = 0 [s]

Y = 0 [s]

Z = 0 [s]

HydroForce [N]

X = No

Y = No

Z = Yes

Rotation
TimeTorques [s]

X = 0 [s]

Y = 0 [s]

Z = 0 [s]

HydroTorque [N*m]

X = No

Y = Yes

Z = No
Initial position

Reference point

X = 0 [m]

Y = 0 [m]

Z = 0 [m]
Rotation definition By matrix
Axis X

X = -1

Y = 0

Z = 0

Axis Y

X = 0

Y = -1

Z = 0

FSI

Artificial compressibility = Yes
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Flexibility = 0.0001 [m Pa-1]

Mobility = 0.05 [m2kg-1]

· In the Properties window of the Moving body, click Operations >  (Place to initial position).

5.3.4.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Inlet/Outlet

Variables

Velocity​​(Phase #0) = Normal mass velocity

Mass velocity = 4000 [kg m-2 s-1]

TurbEnergy(Phase #0) = Pulsations

Value = 0.01

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]
VOF (Phase #0) = Value

Value = 1

Boundary 2

Type = Inlet/Outlet
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Variables

Velocity​​(Phase #0) = Normal mass velocity [kg m-2s-1]

Mass velocity = 4000

TurbEnergy(Phase #0) = Pulsations

Value = 0.01

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]
VOF (Phase #0) = Zero gradient

Boundary 3

Type = Symmetry

Variables

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry

TurbDissipation(Phase #0) = Symmetry
VOF (Phase #0) = Symmetry

Boundary 4

Type = Free Outlet

Variables

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy(Phase #0) = Pulsations

Value = 0.01

TurbDissipation(Phase #0) = Turbulent scale

Value = 0.01 [m]
VOF (Phase #0) =Zero gradient

Boundary 5

Type = Wall

Variables

Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

VOF(Phase #0) = Symmetry

5.3.4.4 Initial conditions

In Model #0, in Init. data #0, specify:

Velocity​​(Phase #0)

Value

X = 4 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

Pulsations(Phase #0)

Value = 0.01
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Turbulent scale(Phase #0)

Value = 0.01 [m]
VOF(Phase #0)

Value = 1

In the folder Objects:

· create Box #0.

· In the Properties window of Box #0 specify:

Location

Reference point

X = 0 [m]

Y = -12.5 [m]

Z = -6 [m]

Size

X = 52 [m]

Y = 24.999 [m]

Z = 12 [m]

In SubRegion #0:

· In the Properties window of the element Initial conditions > Init. condition #0, specify:

Object = Box #0

Init. data = Init. data #0

5.3.4.5 Initial grid

For correct simulation of this task you need to make a resolution by the computational grid the free surface and
area near the board of the boat.

You do not have to make resolution of areas over the boat and located away from the boat. The outer
boundaries of the computational domain locate far away from the boat only to reduce influence of boundary
conditions on the solution near the boat.

In this situation it is desirable to condense the initial grind near the free surface (along the axis OZ). Along the
axis OY you should condense the grid near the surface of the boat and smoothly increase the size of the cells
when moving away from the boat at the distances more then 1.5 of the boat's width. Along the axis OX it is
desirable to resolute the boat's head and the aft, where the intensive generation of waves occurs, while along
the boat, between its head and the aft, the cells can be slightly elongated because contours of the ship there
are uniform and velocity vectors are directed along these elongated cells, so the elongation of the cells does not
affect substantially on the simulation's results.
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In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max =2 [m]

h_min = 0.2 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-26:

h = 2 [m]

kh+ = 1.3

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.2 [m]

kh- = 1.3

kh+ = 0.92

Specify Reference line parameters for the reference line with coordinate x=26:

h = 2 [m]

kh- = 0.7

for axis OY (click the button )

Grid parameters

h_max = 2 [m]

h_min = 0.2 [m]

Specify Reference line parameters for the reference line with coordinate y=-25:

h = 2 [m]

kh+ = 1.4

Specify Reference line parameters for the reference line with coordinate y=0:

h = 0.2 [m]

kh- = 1.06

for axis OZ (click the button )

Grid parameters

h_max =2 [m]

h_min = 0.2 [m]

Insert a reference line with coordinate z=0 [m].

Specify Reference line parameters for the reference line with coordinate z=-12:

h = 2 [m]

kh+ = 1.05

Specify Reference line parameters for the reference line with coordinate z=0:

h = 0.2 [m]

kh- = 1.15

kh+ = 0.8

Specify Reference line parameters for the reference line with coordinate z=12:

h = 2 [m]

kh- = 0.95
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Click OK to close the Initial grid editor with saving the entered data.

In the Properties window of the Initial grid click Apply.

5.3.4.6 Adaptation of the computational grid

Specify the adaptation on the surface of the boat:

· Create Computational grid > Adaptation > Adaptation #0.

· Add the boundary condition, which corresponds to the boat's surface, to the subfolder Computational grid >
Adaptation > Adaptation #0 > Objects.

· In properties of Adaptation #0 specify:

Enabled = Yes

Max level N = 1

Layers

Layers for Level N = 4

Specify the merge of the previously split cells:

· Create Computational grid > Adaptation > Adaptation #1.

· Add the geometry object Computational space to the subfolder Computational grid > Adaptation >
Adaptation #1 > Objects.

· In properties of Adaptation #1 specify:

Enabled = Yes

Max level N = 0

Split/Merge = Merge

5.3.4.7 Parameters of calculation

Specify in the Solver tab in properties of the Time step element:

Method = Via CFL number

Surface CFL = 1

Max step = 1 [s]

5.3.4.8 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:

1. Water surface

2. Pressure distribution on the surface of the boat
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5.3.4.8.1  Water surface

· Create a VOF layer on Computational space.

· In the Properties window of the VOF layer, specify:

Appearance

Fill

Color = Aqua

· In the Properties window of Plane #0, specify:

Object

Reference point

X = 0 [m]

Y = -0.0001 [m]

Z = 0 [m]

Normal

X = 0

Y = -1

Z = 0

Clipping object = Yes

Mirror = Yes



392FlowVision Help

 

· In the Properties window of the layer Solids, specify:

Clipped = Yes

5.3.4.8.2  Pressure distribution

· Create a layer Color contours on the Imported object.

· In the Properties window of these Color contours, specify:

Variable

Variable = Pressure

Shift = 0.000001

Value range

Mode = Manual

Max = 2000

Min = -1200

Palette

Appearance

Enabled = Yes

Style = Style 1

Note:

In order to display only the surface of the interface and hide the surface between the phase and the boundary of
the computational domain, it is necessary to specify Volume=No in properties of the layer VOF.
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5.3.5 Rotary compressor

In this example, we simulate the flow in a hydraulic pump.

Parameters of the problem setting

Inflow parameters:

Pressure on inlet p
in

= 101000 [Pa]

Back pressure on outlet p
out

= 102000 [Pa]

Parameters of rotors:

Angular velocity of the left rotor W
l

= 600 [radian s-1]

Angular velocity of the right rotor W
r

= 400 [radian s-1]

Substance = Air

Geometry Compressor_Domain.STL

Project Compressor
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5.3.5.1 Physical model

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

 

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify in properties of the folder Physical processes:

Heat transfer = Heat transfer via h

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· In the Properties window of Model #0, specify:

Use Gap model = Standard Gap model

In properties of SubRegion #0 specify:

Model = Model #0

5.3.5.2 Moving bodies

Create the Left rotor:
· Select Create from the context menu of the Objects folder and create an Imported object by loading its

geometry from the file Compressor_Male.wrl.

· In the folder SubRegion #0 > Modifiers, create a Moving body modifier on the downloaded Imported
object.

In the Properties window of the just created Moving body, specify:

Rotation

Rotation Speed [radian/s]

X = 0 [radian s-1]

Y = 0 [radian s-1]

Z = 600 [radian s-1]

Create the Right rotor:
· Select Create from the context menu of the Objects folder and create an Imported object by loading its

geometry from the file Compressor_Female.wrl.

· In the folder SubRegion #0 > Modifiers, create a Moving body modifier on the downloaded Imported
object.

 

In the Properties window of the just created Moving body, specify:
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Mass Properties

Center of Inertia

X = 0.085 [m]

Y = 0 [m]

Z = 0 [m]

Rotation

Rotation Speed [radian/s]

X = 0 [radian s-1]

Y = 0 [radian s-1]

Z = -400 [radian s-1]

5.3.5.3 Boundary conditions

Specify the following boundary conditions:

Boundaries 1, 2, 3

Type = Wall
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Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Logarithm law 

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Boundary 4

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Total temperature

Value = 0 [K]

Velocity​​(Phase #0) = Total pressure

Total pressure = 0 [Pa]

TurbEnergy(Phase #0) = Pulsations 

Value = 0

TurbDissipation(Phase #0) = Turbulent scale 

Value = 0 [m]

Boundary 5

Type = Inlet/Outlet

Variables

Temperature(Phase #0) = Temperature

Value = 0 [K]

Velocity​​(Phase #0) = Total pressure

Total pressure = 1000 [Pa]

TurbEnergy(Phase #0) = Pulsations

Value = 0

TurbDissipation(Phase #0) = Turbulent scale

Value = 0 [m]

Boundary 6

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry

TurbDissipation(Phase #0) = Symmetry

5.3.5.4 Initial conditions

In simulations of rotary compressors, it is recommended to specify in the area near outlet the same initial
values of variables as the values on the outlet.

In Model #0, in Init. data #0, specify:

Pressure(Phase #0)

Value = 1000 [Pa]

In the folder Objects:
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· Create Box #0.

· In the Properties window of Box #0 specify:

Location

Reference point

X = 0.04275 [m]

Y = -0.095 [m]

Z = 0.005 [m]

Size

X = 0.05 [m]

Y = 0.08 [m]

Z = 0.012 [m]

In SubRegion #0, in the Properties window of the element Initial conditions > Init. condition #0, specify:

Object = Box #0

Init. data = Init. data #0
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5.3.5.5 Initial grid

Specify in the Properties window of the Initial grid:

Grid structure = 2D

Plane = XY

nX = 18

nY = 22

In the Properties window of the Initial grid click Apply.

5.3.5.6 Adaptation of the computational grid

Specify the adaptation in the area of gears.

Start with creation of a geometry object, within which the adaptation will act:

· Create Box #1 in the folder Objects.

· Specify parameters in the Properties window of Box #1:

Location

Reference point
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X = 0.0427 [m]

Y = 0 [m]

Z = 0.005 [m]

Size

X = 0.2 [m]

Y = 0.12 [m]

Z = 0.012 [m]

Then specify the adaptation itself, which will act within Box #1:

· Create Computational grid > Adaptation > Adaptation #0.

· Add the geometry object Box #1 to the subfolder Computational grid > Adaptation > Adaptation #0 >
Objects.

· In properties of Adaptation #0 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 4

Layers for Level N-1 = 4

5.3.5.7 History of the computation

In this simulation, it is supposed to display the history of the computation depending on time.

In order to display this history, it is necessary to:
· save the history of the computation
· create a layer for the visualization
· start sequential loading of the computation's results with saving images into files

5.3.5.8 Parameters of calculation

Specify in the Solver tab:

· In the Properties window of the Data autosave element, specify:

History = Yes

Frequency

Type = By time

Number of seconds = 0.0005 [s]

5.3.5.9 Visualization

To view the dynamics of the solution during the computation, prior to computation, specify visualization of:
1. Distribution of gap cells
2. Instant Velocity distribution in the plane of symmetry
3. Dynamics of the velocity profile depending on time
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5.3.5.9.1  Distribution of gap cells

· Create a layer Cell set on the Computational space

· In the Properties window of this layer Cell set, specify:

Type = Gap

Appearance

Mode = Lines

Note: 

See section Flow in clearance - use of the Gap model for the algorithm of selecting gap cells.
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5.3.5.9.2  Velocity distribution

· In the Properties window of Plane #0, specify:

Object

Normal

X = 0

Y = 0

Z = 1

(to direct a Plane's normal along the axis Z, you can also click the Operations >  button in the
Properties window of the Plane)

· Create a layer Vectors on the Plane #0.

· In the Properties window of the layer, specify:

Grid



402FlowVision Help

 

Size 1 = 50

Size 2 = 50

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 33

Min = 0

Palette

Appearance

Enabled = Yes

Style = Style 1

The program will automatically specify the variable, which is used to build the vectors, Variable > Variable
= Velocity.

5.3.5.9.3  Velocity variation

To display changing of the velocity profile (field of velocities), do the following:

· Go to the first saved step by clicking the button  (Load first step).

· Run sequential saving of the images from the View window into files by clicking the button  (Begin
sequence). The Image capture dialog box will open:

· Do not change sizes of the image that are set in the Image capture dialog box and click OK.

· In the dialog box for specifying files enter the prefix for file names of the image files (the program will create
multiple files with names that will be formed from your prefix and sequential numbers).

· Run the sequential download of the data stored at intermediate steps by clicking the button  (Start
playback).

· After the sequential data download ends, stop the saving the images from the View window into files by

clicking the button  (Finish sequence).

5.3.5.9.4  Displaying a text in the View window

The text Title in the View window will display number of rotations of the left and the right rotors.

Create Characteristics #0 on the left rotor using the Create characteristics command from the context menu
of the Imported object #0, which corresponds to the left rotor. You can build Characteristics #0 by any
variable, this has no matter for results in this exercise.
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Similarly create Characteristics #1 on the right rotor.

Create a User variable corresponding to the number of revolutions of the left rotor. In Preprocessor, in the
context menu of the User variables > Global apply the Create > Scalar command. In properties of the just
created variable UGV #0 specify:

Name = N_left
Value = abs(trunc(RotVelocity0_Z*Time/(2*PI)))

To specify Value, apply the Formula editor:
· RotVelocity0_Z is specified in the Variables & constants pane in the Integral tab, in the variable

Characteristics #0 (Imported object #0) > Rotation velocity > Z.
· Time is specified in the Variables & constants pane in the Integral tab, in the variable Internal

characteristics > Current time.
· PI is specified in the Variables & constants pane in the Constants tab, in the constant Pi number.

Similarly create a User variable named as N_right for number of revolutions of the right rotor.

Create Stop criteria in the folder Stopping conditions > User values in the Solver tab:
· Create Stop criterion #0 and in its properties specify: Object = N_left.
· Create Stop criterion #1 and in its properties specify: Object = N_right.

Define the text, which will be displayed in the View window. In the Postprocessor tab, in properties of the root
element 3D-scene, specify:

Show title = Yes
Title > Text = Rotary compressor
Title > Show time = Yes
Title > Show step number = Yes
Title > User values > [0] > Line begin = left rotor's number of revolutions
Title > User values > [0] > User stopper = Stop criterion #0
Title > User values > [1] > Line begin = right rotor's number of revolutions
Title > User values > [1] > User stopper = Stop criterion #1

Note: To make parameters Title > User values > [0] > ... and Title > User values > [1] > ... available, click

twice the User values >  (Append item to the array) screen button.

If necessary, change the text color of the title using the Title > Text color parameter so this text be not same
as the background color of the View window.

The View window will display the text title with information about number of complete revolutions of the left and
the right rotors.
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5.4 Icing on a solid surface

In this case we consider simulating of icing on an airplane's surfaces. It is the problem, which has great
practical value.

Conditions, when the icing is possible, are formed when an airplane flies in the troposphere in clouds or in
super-cooled rain.

The icing is the most probable at temperatures from 0 °С to -20 °С. When the temperature is below -40 °С, the
icing is unlikely.

The troposphere at temperatures below 0 °С contains, besides air, water vapor, waterdrops and ice crystals.
Dispersed subcooled waterdrops are nuclei of condensation and crystallization of the water vapor.

The main meteorological parameters, which influence on the icing rate, are:
· liquid water content (LWC), which measures the mass of condensed water containing in a unit volume of a

cloud.

· temperature of the air (T)

· size of waterdrops (d)

FlowVision implements simulating of the following modes of icing:
· dry mode, when waterdrops impact the ice surface and freeze immediately
· wet mode, when subcooled waterdrops form a film on the solid surface. One part of this film becomes ice,

while the other part, under the action of aerodynamic forces, flows along the external stream.

In this exercise we simulate the wet mode of icing; crystallization of subcooled waterdrops occurs on the
surface of the NACA0012 airfoil, which is being flown.

Parameters of the problem setting

Size and orientation:

chord length of NACA0012 c = 0.5334 [m]

dimensions of the computational domain 5.3 × 5 × 0.00254 [m]

angle-of-attack α = 3.5 [degree]

Substances: air, liquid water, gas water (water vapor), solid water (ice)

Inlet parameters:

Pressure at infinity p ∞
= 91201 [Pa]
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Temperature at infinity T∞
= 262 [K]

Velocity on inlet (vector) V = (102.8, 0, 0) [m/s]

Liquid water content (LWC) = 1 [g/m3]

Mean volume diameter (MVD) of particles in the dispersed
phase

= 20 [μm] = 2×10-5 [m]

Mass fraction of vapor in the air = 0.0016

Geometry: icing_plane.wrl (for the computational domain)

icing_NACA0012.wrl (for the airfoil)

Project: Icing_naca012

Loading the geometry

Start your work from creation a new project based on the geometry icing_plane.wrl.

Then load an Imported object that corresponds to the airfoil. To do so, in the Preprocessor tab, open the
context menu of the Objects folder, select there the Batch import and, in the operating system's dialog
window, which opens, select the file NACA0012_opt_airfoil.wrl.

5.4.1 Physical model

In properties of the element General settings specify:

Reference values

Temperature = 262 [K]

Pressure = 91201 [Pa]

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:

o From the context menu of Substance #0 select Load from SD > Standard.

o In the Load from database dialog box, which opens, select:

Substances = Air

Phases = Gas (equilibrium)

· Create three more Substances and load them from the Standard substance database. In their Load from
database dialog boxes, which open, specify:

o Substances=Water, Phases=Liquid

o Substances=Water, Phases=Gas (equilibrium)

o Substances=Water, Phases=Solid (ice)

In the folder Phases:

· Create a dispersed Phase of the Particles type (from the context menu of the folder Phases select the
command Create particles). Rename this Phase as WATERDROPS.

· Add substance Water_Liquid into the folder WATERDROPS > Substances.

· In properties of the folder WATERDROPS > Physical processes specify:

Heat transfer = Convection & conduction

Phase transfer = Convection & diffusion

Motion = Motion
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Crystallization = Film model

· From the context menu of the folder WATERDROPS > Size spectra select the Create command. The
element WATERDROPS > Size spectra > Size spectrum #0 will appear in the project tree.

· Specify diameter of particles in the size group [0] of Size spectrum #0:

Size groups > [0] > Diam. particles= 20e-6 [m]

· In properties of the element WATERDROPS > Physical processes > Crystallization specify:

Roughness model = Shin-Bond

LWC = 1 [g/m3]

Source smoothing = 1

· Create a continuous Phase and rename it as ICE.

· Add the substance Water_Solid (ice) into the folder ICE > Substances.

· In properties of the folder ICE > Physical processes specify Heat transfer = Heat transfer via h.

· In properties of the element ICE > Physical processes > Heat transfer specify Time step coefficient =
1000000. In this exercise the time step of the ice phase is substantially greater then the time step of the
flow-around simulation. Value of the time step coefficient for the ice phase is several orders of magnitude
greater than for other processes to obtain the temperature equilibrium in the ice phase be settled at one time
step of the flow-around simulation.

· Create a continuous Phase and rename it as AIR.

· Add, in sequential order, substances Water_Gas (equilibrium) and Air_Gas (equilibrium) into the folder
AIR > Substances.

· In properties of the folder AIR > Physical processes specify:

Heat transfer = Heat transfer via H

Motion = Navier-Stokes model

Mass transfer = Mixing

Turbulence = KES

· In properties of the element AIR > Physical processes > Heat transfer specify All terms = Yes. This
setting enables taking into account the heat generation due to viscous dissipation.

· In properties of the element AIR > Physical processes > Motion specify Visc. force supplement = Yes.
Solving the full equation allows the program to obtain heat flows that determine more realistic shape of the ice
body.

· In properties of the element AIR > Physical processes > Turbulence specify Roughness constant =
0.097. The value of the Roughness constant is tried individually for each computational case. This value
depends on geometry of the object, Y+, and LWC.

In the folder Models:

· Create Model #0.

· Sequentially (one by one) add phases ICE, AIR, and WATERDROPS into folder Model #0 > Phases.

· In properties of the element Model #0 > Phase interaction > Continuum-particles, which has
Phase0=ICE and Phase1=WATERDROPS, specify:

Is carrier phase = No

· In properties of the element Model #0 > Phase interaction > Continuum-particles, which has
Phase0=AIR and Phase1=WATERDROPS, specify:

Substance pair > [0] > Phase0 = Water_Gas (equilibrium)

Substance pair > [0] > Phase1 = Water_Liquid

Cd = Model1

Nu = Model1
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· For the element Init. data > Init. data #0 specify:

Velocity​​(AIR)

Value > X = 102.8 [m/s]

Mass frac. [Water_Gas (equilibrium)](AIR)

Value = 0.0016

VOF(AIR)

Value = 1

Phase volume(WATERDROPS)

Value = 1e-6

Velocity​​ (disp.)(WATERDROPS)

Value > X = 102.8 [m/s]

In properties of SubRegion #0, specify Model = Model #0.

5.4.2 Moving body

Add to the project a Moving Body modifier that will correspond to the airfoil and set its properties. This
Moving Body is to be built on the Imported object #0, which was added into the project before (see "Loading
the geometry and stages of the computation"). Follow these steps:

· In the folder SubRegion #0 > Modifiers create a Moving Body modifier on the loaded Imported object
#0.

· Rotate the new Moving Body #0 by the angle-of-attack α=5º. To do so, in properties of Moving Body #0,

click the button Initial position > Operations > 
 
(Relative rotation around local axis Z) and, in the

dialog box, which opens, set the rotation angle as -3.5 degrees (a negative value).

· In properties of Moving Body #0 click Apply and then click the screen button Operations >  (Place to
initial position).

· In properties of Moving Body #0 specify:

Activation

Type = Permanent

Update

Type = Disabled
(position and orientation of the wing, on which the icing will be simulated, will not change, so we disable
update of Moving Body #0)
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5.4.3 Boundary conditions

Specify boundary conditions according to the illustration:

Boundary 1

Name = Wing

Type = Wall, film

Variables

VOF(ICE) = Value

Value = 1

VOF(AIR) = Value

Value = 0

Boundary 2

Name = Symmetry

Type = Symmetry

Boundary 3
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Name = Inlet

Type = Inlet/Outlet

Variables

Temperature(ICE) = Temperature

Value = 0 [K]

VOF(ICE) = Value

Value = 0

Temperature(AIR) = Temperature

Value = 0 [K]

Velocity(AIR) = Velocity with pressure

Velocity > X = 102.8 [m/s]

Velocity > Y = 0 [m/s]

Velocity > Z = 0 [m/s]

Pressure = 0 [Pa]

Mass frac. [Water_Gas (equilibrium)](AIR) = Value at the inlet

Value = 0.0016

TurbEnergy(AIR) = Pulsations

Value = 0

TurbDissipation(AIR) = Turbulent scale

Value = 0 [m]

VOF(AIR) = Value

Value = 1

Phase volume(WATERDROPS) = Value

Value = 1е-6

Temperature (disp.)(WATERDROPS) = Value

Value = 0 [K]

Velocity (disp.)(WATERDROPS) = Particles velocity

Particles velocity > X =102.8 [m/s]

Particles velocity > Y = 0 [m/s]

Particles velocity > Z = 0 [m/s]

Boundary 4

Name = Outlet

Type = Free outlet

Variables

Temperature(ICE) = Temperature

Value = 0 [K]

VOF(ICE) = Zero gradient

Temperature(AIR) = Zero gradient

Velocity(AIR =Pressure

Value = 0 [Pa]

Mass frac. [Water_Gas (equilibrium)](AIR) = Zero gradient

TurbEnergy(AIR) = Zero gradient
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TurbDissipation(AIR) = Zero gradient

VOF(AIR) = Zero gradient

Phase volume(WATERDROPS) = Permeable surface

Temperature (disp.)(WATERDROPS) = Permeable surface

Velocity (disp.)(WATERDROPS) = Permeable surface

5.4.4 Initial grid

In properties of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.5 [m]

h_min = 0.0025 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.0025 [m]

kh- = 1
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kh+ = 1

for axis OY (click the button )

Specify the same parameters as for axis OX.

Click OK to close the Initial grid editor with saving the entered data.

As in this exercise the problem is simulated in 2D setting, there will be only one cell along axis OZ. Specify in
properties of the Initial grid:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

5.4.5 Parameters of calculation

Specify in the Solver tab:

· In properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = if(PhaseTime<231;10;-1)

Surface CFL = 1

Film CFL = 5

The computation will automatically stop after 231 seconds of icing.

· In properties of the Advanced settings element, specify:

o Multiphase C > Phase conservative = No. The mass conservation law effects not strictly at motion of

the boundary of the ice body. This is admissible because the flow is simulated in non-closed space.

o Multiphase C > CFL for VOF source = 0.1

o Multiphase C > Use for time step = No. The time step is calculated without taking into account the

velocity of the inter-phase surface.

o Multiphase D > Cloud boundary = 0.

o Multiphase D > Activation of disp. phase crystallization > Type = Start in steps

o Multiphase D > Activation of disp. phase crystallization > Start in steps = 401

o Turbulence > WF: profile T+ = 1. This parameter specifies the temperature profiles, which is used in the

computation.

o Smooth diff. fluxes = Yes. This setting enables smoothing the values of Heat flux on solid surfaces.

· In properties of the element Limiters > Limiters for calculation > Phase Limiters > AIR, specify:

Limiter

Density, min. = 0.01 [kg m-3]

Temperature abs, min. = 25 [K]

Temperature abs, max. = 550 [K]

Velocity, max. = 1000 [m/s]

Pressure abs, min. = 1000 [Pa]

· In properties of the element Limiters > Limiters for calculation > Phase Limiters > ICE, specify:

Small Cells

Criterion = Relative

When icing is simulated, it is recommended to use the Relative criterion for revealing small cells
for the solid-state Phase (ice body); this is set by the Small Cells > Criterion parameter in
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properties of the element Limiters > Limiters for calculation > Phase Limiters > Phase #N in
the project tree.

5.4.6 Visualizing results of the computation

Shape of the ice body

In the Postprocessor tab, on the object Computational space, create a new layer VOF #0 and specify in its
properties Phase = ICE.

Shape of the ice body at the moment when the computation stops (at the 231-rd second of the icing) is shown
on the illustration below:

Comparing to the ice shape from the experiment

Conditions of the icing simulating in this project correspond to experiments in the wind tunnel NASA Glenn
Icing Research Tunnel (IRT) [Wright, Rutkowski, 1999]: run 308.
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In the Postprocessor tab create a Set of sensors object based on the file Geom/run308_ice. To do so,

apply the  Operations > Overwrite sensors from file button in properties of the Set of sensors.

This allows you to visually compare results of the simulating and the experimental data:



415FlowVision Help

 

6 Coupling with other software
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6.1 Deformable valve in channel

Fluid-structure interaction (FSI) is interaction of motion or deforming body and internal or external flow. This kind
of analysis is important when you develop engineering systems and solve problems in areas of aircraft
engineering, design of motors, bridges, etc.

Problems of interaction between a constructions and a flow commonly are too difficult for analytical approach,
and these problems can be analyzed in an experiment or by numerical simulation. For numerical simulations of
FSI problems, two approaches can be used:

· jointless approach (equations for flow and equations for deformations are solved simultaneously by a
single solver);

· concurrent simulation (equations for flow and equations for deformations are solved by different
programs).

One of features of FlowVision is possibility of coupled computations with external programs. The current version
of FlowVision allows doing FSI computations with the Abaqus software package via Pre-Postprocessor, which
is being connected to Solver.

A correct start of joint computation requires manual modification of Abaqus' and FlowVision's files. Connection
between these programs is impossible without these modifications.

A flow of liquid is partially overlapped by a valve, which obstructs the flow. A joint computation in Abaqus and
FlowVision simulates the interdependent movement of the valve and parameters of the liquid's flow.

Parameters of the problem setting

Inflow parameters:

Velocity V = 10 [m s-1]

Fluid parameters:

Density r = 1000 [kg m-3]

Viscosity m = 0.001 [kg m-1s-1]

Parameters of the valve:

Density r = 3500 [kg m-3]

Young's modulus E = 5 × 109 [Pa]

Poisson's ratio n = 0.3

Files

Geometry model of the tube Valve_Channel.wrl

Project in Abaqus OneValve.inp

Project in FlowVision Valve_Channel
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6.1.1 Preparing the project in Abaqus

In Abaqus deformations of the valve are simulated according to the loads that are received from FlowVision.

In this exercise a ready Abaqus model can be used (file OneValve.inp).

To obtain experience of creation an Abaqus model, see descriptions in sections:

· Creation a geometry model in Abaqus

· Specifying an interface surface in Abaqus

· Specifying boundary conditions and loads in Abaqus

· Generating an inp-file

· Modifying the inp-file of the Abaqus' project

Here are the requirements to the geometry model in Abaqus:

1. Details of the model involved in the coupling analysis should be simulated using volume or flat
elements.

2. In the model interface surface(s) (which are interface regions of the SURFACE type) for the coupling
analysis (the direct coupling interface) must be defined.

3. An interface surface must be:
· closed
· determined on a continuous mesh. The mesh must have no "duplicate" nodes, modified

elements and must not contain a surface of two meshes connected with TIE-contact (see the
illustration)

          

6.1.1.1 Creating a geometry model in Abaqus

This section helps you to create the valve's model in Abaqus (version 2017) by your own. You can skip this
section if you use a ready model OneValve.inp and return to the section when you wish to receive

appropriate experience.

Follow the steps:

1. Click the icon  (Create Part). The Create Part dialog box will open, specify there:

Name = Valve

Modeling space = 3D

Type = Deformable

Base Feature > Shape = Solid

Base Feature > Type = Extrusion

Approximate size = 0.1

and click Continue.



418FlowVision Help

 

2. In the graphical work window, which opens, use the tool  (Create Isolated Point) to create points,
which will be used to create the valve's contour. To do so, enter the following coordinates: [-0.003,-0.01];[0.002,-

0.01];[0.002,0.04];[0,0.04];[-0.003,0.03]. Then use the tool  (Create Lines Connected) to outline the
contour by lines. To do so, click Done (the mouse wheel). Important note: the created contour must be
closed.
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Making a contour for the part Valve

3. The Edit Base Extrusion dialog box will open. Enter the value 20e-3 into the field Depth and click OK:

Creating the part Valve

4. Navigate to the module Property. Click  (Create Material) to create a new material.

5. The Edit Material dialog box will open; specify there:

Name = Metal (name of the material)

General > Density = 3500 (density of the material, [kg∙m-3])

Mechanical > Elasticity = Elastic

Mechanical > Young’s Modulus = 5E9 (Young's modulus, [Pa])

Mechanical > Poisson’s Ratio = 0.3 (Poisson's ratio)

and click OK.
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Specifying properties of the material

6. Create a section made of the material Metal. Click  to open the Create Section dialog box. Specify
there:

Name = Metal (name of the section)

Category = Solid

Type = Homogeneous

and click Continue.

The Edit Section dialog box will open. Select there Material = Metal and click OK.
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Creating and editing a section

7. Click  (Assign Section) and in the dialog box Edit Section Assignment assign the just created
section to the part, which you have created. Select the whole valve (it will be highlighted by red) and click
Done. In the dialog box, which opens, click OK.

Assigning a section to the part Valve

8. Navigate to the module Assembly. To create an instance, click  (Create Instance). A window will open
with a list of created parts. Select the part Valve and specify Instance type = Dependent. The just created
part will appear in the graphical work window. Click OK.
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9. Specify the procedure of analysis. The numerical simulation will consist of one step (co-simulation). Navigate

to the module Step, click  (Create Step). In the dialog box Create Step specify:

Name = FSI

Procedure Type = General

From the list below select Dynamic, Implicit and click Continue.
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Specifying the procedure of analysis. Creation the FSI step. (1)

10. The Edit Step dialog box will open where you have to specify parameters of the step, which will be used in
the analysis. In the Basic tab specify:

Time Period = 20

Nlgeom = On
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Specifying the procedure of analysis. Creation the FSI step. (2)

In the Incrementation tab specify:

Maximum numbers of increments = 1E6 (maximal number of increments)

Increment size > Initial = 0.001 (initial increment)

Increment size > Minimum = 1E-14 (minimal increment)

Maximum increment size > Specify = 0.1 (maximal increment)
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Specifying the procedure of analysis. Creation the FSI step. (3)

Click OK.

11. Navigate to the module Mesh and apply the tool  (Partition Cell: Extrude/Sweep Edges) to split the
valve into two parts. This allows obtaining more structured finite element mesh. Select a boundary that will be
used for splitting and the direction, along which the boundary will be moved (Sweep Along Edge). Click Done.

12. Apply the tool  (Seed part Instance) to split the valve into elements. The Global Seeds dialog box
will open. Specify there Approximate global size = 0.0015 and click OK.
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Specifying the size of finite elements

13. To start the grid generation, click  (Mesh Part Instance) and then click Yes.

6.1.1.2 Specifying an interface surface in Abaqus
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The next important step of creation the model for joint computation is specifying an interface surface between
Abaqus and FlowVision.

Abaqus simulates deformations of the valve and exports coordinates of nodes of the deformed surface.

Follow these steps:

In the model tree double-click Assembly > Surfaces (or select and use the Create command). The Create
Surface dialog box will open; specify there:

Name = DC-SURF1 (name of the interface surface)

Type = Geometry

Click Continue and select the whole valve. Click Done.

6.1.1.3 Specifying boundary conditions and loads in Abaqus

Abaqus imports loads (CF) that were calculated in FlowVision. Follow these steps:

1. Navigate to the module Load. Select  (Create Boundary condition) and create a boundary condition
on the bottom surface of the valve with the following parameters:

Name = FIX

Step = FSI

Category = Mechanical

Types for Selected Step = Symmetry/Antisymmetry/Encastre
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Click Continue.
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2. In the graphical work window select the bottom surface of the valve and click Done. In the Edit Boundary
Condition dialog box, which opens, select for the valve's face the boundary condition type ENCASTRE
(U1=U2=U3=UR1=UR2=UR3=0) that prohibits movement of this face for any degrees of freedom:
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6.1.1.4 Generating an inp-file

To generate an inp-file, follow these steps:

1. Navigate to the module Job and in the window Job Manager ( ) create a new analysis:

Click Create; after this the Create job dialog box will open; specify there the name OneValve for the new
analysis and click Continue.

2. In the Job Manager window select the line of the just created analysis and click Write Input to create an
input file, geometry of which will be imported to FlowVision. Also this input file will be required to make the
computation.
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3. Save and close the project.

6.1.1.5 Modifying the inp-file of the Abaqus' project

The ready file OneValve.inp, which is included into the delivery, has already been modified. If you use the file,

you can skip this section, but we recommend to open and browse contents of this file using any text editor.

The inp file, which has been generated, locates in the work directory of Abaqus. The work directory of Abaqus

can be specified by the File > Set Work Directory menu command:

You can specify any directory, which is available for writing, as a new work directory of Abaqus:

If you wish to create the OneValve.inp file by your own, follow these steps:



433FlowVision Help

 

· Open the inp-file of the Abaqus' project in a text editor.

· Add the following lines into the module STEP before the line *End Step:
**

*CO-SIMULATION CONTROLS, NAME= COSIM_CONTROLS, TIME INCREMENTATION=SUBCYCLE, TIME MARKS=YES

**

*CO-SIMULATION, PROGRAM=DIRECT, NAME=FlowVision, CONTROLS=FSI

*CO-SIMULATION REGION, IMPORT

ASSEMBLY_DC-SURF1, CF

*CO-SIMULATION REGION, EXPORT

ASSEMBLY_DC-SURF1, COORD

*CO-SIMULATION CONTROLS, NAME=FSI, TIME INCREMENTATION=SUBCYCLE, TIME MARKS=YES

**

These lines are used to identify the coupling analysis with another program.

Important notice: Add ASSEMBLY_ before the interface region's name in lines of the co-simulation. After the

modification the inp file have not to contain empty lines.

See also: More details about these settings (*CO-SIMULATION, *CO-SIMULATION CONTROLS, *CO-SIMULATION

REGION) you can found in the Abaqus Keywords Reference Manual.

6.1.2 Preparing the project in FlowVision

FlowVision simulates motion of the fluid in the channel.

Requirements to the FlowVision's project:
· The geometry of the deformable body has to be loaded from Abaqus into FlowVision, and this geometry

must completely comply to the deformable geometry in the Abaqus project.
· The geometry of the deformed body, loaded into FlowVision, must comply with the requirements to the

geometry in FlowVision (see User's guide).

6.1.2.1 Physical model

In this exercise, the Substance is water. The Substance will be loaded from the standard Substance
database.

· Open the context menu of the folder Substances and, by the command Create, create Substance #0.

· From the context menu of Substance #0 select the command Load from SD > Standard and load the
substance Water in its liquid phase.

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the subfolder Phase #0 > Substances.

· In properties of the folder Phase #0 > Physical processes specify:

Motion = Navier-Stokes model
Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· Specify motion of the liquid along the axis X with velocity 10 [m/s]. To do so, in properties of the element
Models > Model #0 > Init. data > Init. data #0 > Velocity (Phase #0) specify:

X = 10   [m s-1]
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In properties of SubRegion #0 specify Model = Model #0.

6.1.2.2 Imported valve as a Moving body

The valve is inserted into the project as a separate geometry Object, on which the Moving body modifier is
set.

Follow these steps:

In the folder Objects:

· From the context menu of the folder Objects select the command Create and in the Create new object
dialog box, which opens, select Object type = Imported object.

· Import your modified file OneValve.inp from your directory or import the provided file OneValve.inp from

the directory with examples.

· Imported object #0 will appear in the folder Objects.

When an object is imported from Abaqus, inconsistencies of the loaded geometry's scale or space
orientation can occur relating to other geometry objects from the FlowVision's project.

So you can see that, after inserting the imported valve, the valve requires a shift and rotation to be
placed in the flow channel of the tube.

It is important that, in co-simulation, the scaling, shift and rotation of an object must be specified in
properties of the Moving body modifier, which has been set on an Imported object. When you do so,
the specified scaling, shift and rotation will be automatically applied to all further replaces of the
geometry, received from Abaqus.

Create a Moving body modifier on Imported object #0:

· From the context menu of the folder Subregions > SubRegion #0 > Modifiers select the command Create
and in the Create new modifier dialog box, which opens, select:

Modifier type = Moving body

Objects = Imported object #0

The Moving body #0 modifier will appear in the folder Subregions > SubRegion #0 > Modifiers.

· In properties of the just created modifier Moving body #0 specify its initial position (the initial position of the
valve):

Initial position
Reference point

X 0 [m]
Y -0.001 [m]
Z -0.009 [m]

Axis Y
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X = 0
Y = 0
Z = -1

· Click Apply and then click the icon Operations >  (Place to initial position).

Note that outer dimensions of the valve are beyond geometry surface of the tube's flow channel. This is
requirement to the geometry of FlowVision for correct generation of the computational grid: it is not possible to
use same surfaces for the Region and a Moving body, the surfaces must have some mandatory gap between
them or some guaranteed overlap.

For correct operation of the joint computation, it is allowed to use only one Boundary condition per an
exchanged Moving body. For this Boundary condition you must specify a color, which differs from colors of
other Boundary condition in the computational domain.

6.1.2.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Inlet/Outlet

Color =  Red

Variables

Velocity​​(Phase #0) = Normal mass velocity

Mass velocity = 10000 [kg m-2 s-1]

TurbEnergy(Phase #0) = Pulsations 

Value = 0

TurbDissipation(Phase #0) = Turbulent scale 

Value = 0 [m]

Boundary 2

Type = Wall

Color =  Fuchsia

Variables
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Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Boundary 3

Type = Free Outlet

Color =  Green

Variables

Velocity​​(Phase #0) = Pressure

Value = 0 [Pa]

TurbEnergy(Phase #0) = Zero gradient

TurbDissipation(Phase #0) = Zero gradient

Boundary 4

Type = Symmetry

Color =  Gray

Variables

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry

TurbDissipation(Phase #0) = Symmetry

Boundary 5

Name = Valve

Type = Wall

Color =  Blue

Variables

Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall

Important note: one single boundary condition is set to carry out the joint computation on the whole surface of
the replaceable geometry object (the valve).

6.1.2.4 Parameters of co-simulation

· From the context menu of the External Connections folder select the Create command:

· In the Create new object dialog box, which opens, select Object type = Abaqus Direct Coupling:
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· An operating system's dialog box for access to files will open; select there the OneValve.inp file, which was

crested on the step Generating an inp-file.

· An Abaqus Direct Coupling child element will appear in the External Connections folder:

The Abaqus Direct Coupling element, in its turn, has a child element ASSEMBLY_DC-SURF1.

· In properties of the folder External Connections specify:
Exchange step > Method = User value
Exchange step > Constant step = 0.01
Exchange step > Coef. for time step = 1
Old offset = Yes
AutoSave = Yes

· In properties of the element Abaqus Direct Coupling specify:
Activation = Yes
ABAQUS > Run ABAQUS = Yes
ABAQUS > MPM Agent > Address = Host name or IP address of the computer, on which MPM Agent

will run. MPM Agent will start Abaqus.
ABAQUS > MPM Agent > Port = value of this field is filled automatically
ABAQUS > ABAQUS-project = network path and name of the file with the Abaqus project (when it

runs on a remote computer, specify the path to the project on the remote computer)
ABAQUS > IP Source = IP of MPM Agent
ABAQUS > Port = 5555
Loads relaxation > Scale factor = 1
Loads relaxation > Start in steps = 0
Loads relaxation > End in steps = 10
Loads relaxation > Initial coefficient = 0
Loads relaxation > Final coefficient = 1
Heat relaxation > Scale factor = 1
Heat relaxation > Start in steps = 0
Heat relaxation > End in steps = 0
Heat relaxation > Initial coefficient = 1
Heat relaxation > Final coefficient = 1

· In properties of the element  ASSEMBLY_DC-SURF1 specify Moving body = Moving body #0.

Don't change other settings.

6.1.2.5 Initial grid
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In properties of the Initial grid specify:

Grid structure = 2D

Plane = XZ

nX = 60

nZ = 20

In the Properties window of the Initial grid click Apply.

6.1.2.6 Adaptation

In this simulation, it is necessary to split grid cells near surface of the valve and merge the previously adapted
cells, which locate away from the moving valve.

To refine the computational grid near the valve, an adaptation over the surface of an imported object is used.
Specify this adaptation as it is described in the following steps:

· Create the element Computational grid > Adaptation > Adaptation #0.

· Add Imported object #0 into the folder Computational grid > Adaptation > Adaptation #0 > Objects.

· In properties of Adaptation #0 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 4

Layers for Level N-1 = 4

When the valve moves, the area around it, where adaptation is being done, also moves. To avoid useless
adaptation away from the valve, you should specify merging of cells there. During the merging the previously
adapted cells are restored to their initial level of adaptation. Thus only those cells remain adapted, which locate
near the valve.

Specify merging of the previously split cells:

· Create the element Computational grid > Adaptation > Adaptation #1.

· Add the geometry object Computational space to the folder Computational grid > Adaptation >
Adaptation #1 > Objects.

· In properties of Adaptation #1 specify:

Enabled = Yes

Max level N = 0

Split/Merge = Merge

6.1.2.7 Parameters of calculation in FlowVision

For simulations that include motion of moving bodies (FSI computations are such ones), we recommend to
specify the time step by the CFL number (specify the surface CFL as 1 and convective CFL in the range from 1
to 100 depending on the problem).

In the Solver tab, in properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = 100

Surface CFL = 1
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6.1.2.8 Visualization

Viewing the results of the computation is possible both during the computation (using the Viewer module of
FlowVision) and after finishing the computation.

To view the dynamics of the solution during the computation, prior to the computation, specify visualizations of:

1. Velocity distribution in the plane of the flow.

2. Pressure distribution on the surface of the valve

In its current version Pre-Postprocessor can not visualize deformed geometry during the computation (this
functionality is under construction). Visualization of the deforming geometry during the computation can be
done using the FlowVision's Viewer module. When Pre-Postprocessor works with a completed computation,
the deforming geometry is visualized.

6.1.2.8.1  Velocity distribution

Vectors of velocities in the plane of the flow

· In the properties of Plane #0, specify:

Object

Normal

X = 0

Y = 1

Z = 0

Shift = 0.01

· Create the layer Vectors #0 on Plane #0.

· In the properties of the layer Vectors #0, specify*):

Grid

Size 1 = 50

Size 2 = 20

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 35

Min = 0

Palette

Operations
Click  (Load palette from file) and then select the file heat.fvpal (this

file locates in the directory where FlowVision is installed).
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*)The program will automatically specify the variable, which is used to build the vectors: Variable > Variable =
Velocity.

Notes:

· To display the palette, which is used for coloring the layer (in our case this is coloring the vectors by their
absolute values), you can use the Info window or, in properties of the layer, set Appearance > Enabled =

Yes. To open the Info window, you have to select the layer in the tree of Postprocessor and click the 
 button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.

6.1.2.8.2  Pressure distribution

Distribution of pressure on the surface of the valve

· Create a Color contours layer on Imported object #0.

· In the properties of the just created layer Color contours #0, specify:

Variable

Variable = Pressure

Value range

Mode = Manual

Max = 1000000

Min = -25000
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Notes:

· To display the palette, which is used for coloring the layer, you can use the Info window or, in properties of
the layer, set Appearance > Enabled = Yes. To open the Info window, you have to select the layer in the

tree of Postprocessor and click the  button.

· If you wish to hide some layers or objects displayed in the View window, use the Hide command from their
context menus.

6.1.3 Starting and stopping the computation

Before starting the computation you have to run MPM-Agent.

MPM-Agent has to receive the path to the executable file of Abaqus. If the path has not been provided, you can
specify it in the FlowVision's module Configurator. To do so, click in Configurator the View button on the
right near the MPM Agent field in the Configuration files pane in the Configuration/Logs tab and specify the
data in the MPM Agent configuration dialog box, which opens:

The project's computation is started from Pre-Postprocessor, see description of a standard starting in the
section Detailed description of a simplest model > Laminar flow in a tube > Starting the computation.

Stopping after 20 seconds of the simulated time is set in Abaqus. Also you can stop the project using the 
(Stop computation) button, and then resume the computation after editing the project.
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6.2 Two valves in a channel

In this exercise we examine FlowVision-Abaqus co-simulation of motion of two deformable valves, which
obstruct the flow.

For this the computation uses two Moving bodies.

Problem setting

Two valves, which are placed into the channel, obstruct the flow of the liquid. The joint computation made by
Abaqus and FlowVision simulates motion of the valves and parameters of the flow in mutual interaction.

This exercise it a modification of the previous exercise (Deformable valve in channel), to which another
Imported object is added representing the second valve.

Files:

Geometry model of the tube Valve_Channel.wrl

Geometry of valves Valve1.stl, Valve2.stl

Project in Abaqus TwoValves.inp

Project in FlowVision Two_Valves_Channel

6.2.1 Preparing the project in Abaqus

Follow the steps described in the sections below:
· Creating the Abaqus project
· Export of geometries
· Modifying the inp-file of the Abaqus' project

6.2.1.1 Creating the Abaqus project

Begin creation of the Abaqus project for two valves with repeating the procedure, which has been described in
the "Deformable valve in channel" exercise.

Then, in the Part module, create a second part with following coordinates:
(-0.003,0.13);
(0.002,0.13);
(0.002,0.08);
(0,0.08);
(-0.003,0.09)

and with width 20e-3.

In the Property module, assign to this part the section, which was created before in the exercise with one
valve.

In the Mesh module, create a finite element mesh for this part similarly as it was done for the first valve.

In the Assembly module, add the second valve into the assembly.
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Create a separate close surface for the second valve. Name this surface as DC-SURF2.

Assign to this valve the same boundary condition as those, which has been assigned to the first valve.
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6.2.1.2 Export of geometries

In co-simulations, FlowVision can use any supported file formats that for finite element meshes: stl, dat,

nas, cdb, cel, inp, mesh, ngeom, vtk, wrl.

Because the ready inp-file already contains geometries of both valves, you have to do a separate import for

each of the valves. Otherwise FlowVision would import these valves as a single moving body.

One of the methods for exporting the geometry is creation stl files.

In the Assembly module, in the context menu of the second valve, select Suppress. The second valve will be
hidden in the assembly.

Select the Plug-ins > Tools > STL Export menu item and export the first valve with name Valve1.stl.

Then display the second valve (select Resume from its context menu) and hide the first valve (select Suppress
from its context menu). Export the second valve with name Valve2.stl.

After exporting the geometries, display the first valve and generate the file TwoValves.inp.

6.2.1.3 Modifying the inp-file of the Abaqus' project

The ready file TwoValves.inp, which is included into the delivery, has already been modified. If you use the file,

you can skip this section, but we recommend to open and browse contents of this file using any text editor.

The inp file, which has been generated, locates in the work directory of Abaqus. The work directory of Abaqus

can be specified by the File > Set Work Directory menu command:
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You can specify any directory, which is available for writing, as a new work directory of Abaqus:

If you wish to create the TwoValves.inp file by your own, follow these steps:

· Open the inp-file of the Abaqus' project in a text editor.

· Add the following lines into the module STEP before the line *End Step:
*CO-SIMULATION, PROGRAM=MULTIPHYSICS, Name=FlowVision

*CO-SIMULATION REGION, IMPORT

ASSEMBLY_DC-SURF1, PRESS

ASSEMBLY_DC-SURF2, PRESS

*CO-SIMULATION REGION, EXPORT

ASSEMBLY_DC-SURF1, U

ASSEMBLY_DC-SURF2, U
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These lines are used to identify the coupling analysis with another program.

Note that two interface surfaces (DC-SURF1 and DC-SURF2) are simulated in this computation. Save and

close the project.

Important notice: Add ASSEMBLY_ before the interface region's name.

See also: More details about these settings (*CO-SIMULATION, *CO-SIMULATION REGION) you can found in the

Abaqus Keywords Reference Manual.

6.2.2 Preparing the project in FlowVision

Follow the steps described in the sections below:
· Physical model
· Imported objects
· Boundary conditions
· Settings for co-simulation
· Generating the CSE Director's configuration file
· Computational grid and its adaptation
· Parameters of FlowVision's calculation

6.2.2.1 Physical model

In this exercise, the Substance is water. The Substance will be loaded from the standard Substance
database.

· Open the context menu of the folder Substances and, by the command Create, create Substance #0.

· From the context menu of Substance #0 select the command Load from SD > Standard and load the
substance Water in its liquid phase.

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Substance #0 into the subfolder Phase #0 > Substances.

· In properties of the folder Phase #0 > Physical processes specify:

Motion = Navier-Stokes model

Turbulence = KES

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· Specify motion of the liquid along the axis X with velocity 10 m/s. To do so, in properties of the element
Models > Model #0 > Init. data > Init. data #0 > Velocity (Phase #0) specify:

X = 10   [m s-1]

In properties of SubRegion #0 specify:

Model = Model #0
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6.2.2.2 Imported objects

The valves are included into the project as separate geometry Objects, on which Moving body modifiers are
set.

Follow these steps:

In the folder Objects:
· From the context menu of the Objects folder select the Create command and in the Create new object

dialog box, which opens, select Object type = Imported object.
· In the dialog box, which opens, select the file Valve1.stl.

· Imported object #0 will appear in the Objects folder.
· Similarly import the second valve from the file Valve2.stl.

· Imported object #1 will appear in the Objects folder.

Create Moving body modifiers on the Imported objects:

· From the context menu of the folder Subregions > SubRegion #0 > Modifiers select the Create
command and in the Create new modifier dialog box, which opens, select:

Modifier type = Moving body

Objects = Imported object #0

· Similarly create another Moving body on Imported object #1.

· In properties of Moving body #0 specify:

Initial position > Reference point > X = 0

Initial position > Reference point > Y = -0.001

Initial position > Reference point > Z = -0.009

Initial position > Axis Y > X = 0

Initial position > Axis Y > Y = 0

Initial position > Axis Y > Z = -1

· Click Apply and then click the Operations >  (Place to initial position) button.

· In properties of Moving body #1 specify:

Initial position > Reference point > X = 0.07

Initial position > Reference point > Y = -0.001

Initial position > Reference point > Z = 0.029

Initial position > Axis Y > X = 0

Initial position > Axis Y > Y = 0

Initial position > Axis Y > Z = -1

· Click Apply and then click the Operations >  (Place to initial position) button.
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6.2.2.3 Boundary conditions

For the tube and the first valve use the same Boundary conditions as there were in the previous exercise
(Deformable valve in channel).

Create a new Boundary condition for the second valve:

· copy the Boundary condition of the first valve

· specify another Color for it (for example, yellow)

· assign the new Boundary condition to the second valve

6.2.2.4 Computational grid and its adaptation

In the Properties window of the Initial grid specify:

Grid structure = 2D

Plane = XZ

nX = 60

nZ = 20

In the Properties window of the Initial grid click Apply.

In this simulation, it is necessary to split grid cells near surfaces of the valves and merge the previously
adapted cells, which locate away from the moving valves.

To refine the computational grid near the valves, an adaptation over the surface of imported objects is used.
Specify this adaptation as it is described in the following steps:
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· Create the element Computational grid > Adaptation > Adaptation #0.

· Add Imported object #0 and Imported object #1 into the folder Computational grid > Adaptation >
Adaptation #0 > Objects.

· In properties of Adaptation #0 specify:

Enabled = Yes

Max level N = 2

Layers

Layers for Level N = 4

Layers for Level N-1 = 4

When the valves move, areas around them, where adaptation is being done, also move. To avoid useless
adaptation away from the valves, you should specify merging of cells there. During the merging the previously
adapted cells are restored to their initial level of adaptation. Thus only those cells remain adapted, which locate
near the valves.

Specify merging of the previously split cells:

· Create the element Computational grid > Adaptation > Adaptation #1.

· Add the Computational space geometry object into the  folder Computational grid > Adaptation >
Adaptation #1 > Objects.

· In properties of Adaptation #1 specify:

Enabled = Yes

Max level N = 0

Split/Merge = Merge

6.2.2.5 Parameters of co-simulation

In this exercise a communication connector (co-simulation engine) is used. This connector operates with
independent software components, its name is CSE Director.

CSE Director defines all aspects of inter-operation between programs and follow the necessary instructions to
implement schemes of joint computations.

· In the context menu of the External Connections folder select the Create command:

· In the Create new object dialog box, which opens, select Object type = Abaqus CSE:

· The operating system's dialog box for access to files will open; select there your own file TwoValves.inp,

which you have created created before, or ready TwoValves.inp file from the directory with examples. (see

section Preparing the project in Abaqus).

· An Abaqus CSE child element will appear in the External Connections folder:

The Abaqus CSE element, in its turn, has two child elements, ASSEMBLY_DC-SURF1 and
ASSEMBLY_DC-SURF2.

· In properties of the folder External Connections specify:
Exchange step > Method = User value
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Exchange step > Default time step = 0.01
Exchange step > Coef. for time step = 1
Old offset = Yes

· In properties of the element Abaqus CSE specify:
Activation = Yes
ABAQUS > Run ABAQUS = No
ABAQUS > IP Source = User
ABAQUS > Address = Host name or IP address of the computer, on which Abaqus will run
ABAQUS > Port = 5555
Loads relaxation > Scale factor = 1
Loads relaxation > Start in steps = 0
Loads relaxation > End in steps = 10
Loads relaxation > Initial coefficient = 0
Loads relaxation > Final coefficient = 1
Heat relaxation > Scale factor = 1
Heat relaxation > Start in steps = 0
Heat relaxation > End in steps = 0
Heat relaxation > Initial coefficient = 1
Heat relaxation > Final coefficient = 1

· In properties of the element ASSEMBLY_DC-SURF1 specify Moving body = Moving body #0.

· In properties of the element ASSEMBLY_DC-SURF2 specify Moving body = Moving body #1.

Don't change other settings.

6.2.2.6 Generating the CSE Director's configuration file

To connect the programs, CSE Director uses a configuration xml file, which stores parameters of the joint

computation, transferred data and connection between regions.

In FlowVision you can generate this file according to your settings. To do so, in properties of the External
Connections > Abaqus CSE element, click the Operations >  (Save configuration file for CS-service)

button.

The Export to configuration file dialog box will open; specify there parameters:
· Cosolution scheme = Gauss-Seidel with prediction
· Exchange Step = Let master program choose
· Master program = FlowVision
· Time stopping criteria = 20

Click OK. In the directory, which contains the client part of the project, the TwoValves.xml file will appear.
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6.2.2.7 Parameters of FlowVision's calculation

For simulations that include motion of moving bodies and, particularly, for FSI computations, we recommend to
specify the time step by the CFL number (specify the surface CFL as 1 and the convective CFL in the range
from 1 to 100 depending on specifics of the problem).

In the Solver tab, in properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = 100

Surface CFL = 1

6.2.2.8 Visualization

Apply your skills, formed in the previous exercise (Deformable valve in channel, see the sections Velocity
distribution and Pressure distribution), to specify visualization of:

· vectors of Velocity of the flowing liquid
· pressure on Imported objects
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6.2.3 Start of joint computation

· Manual start of Abaqus
· Starting the computation from FlowVision

For this exercise it is possible to start a joint computation using MPM-Agent (in FlowVision 3.13.01 or
newer versions). In older FlowVision versions only manual start of a joint computation is possible.

To run this exercise using MPM-Agent, apply settings described in the exercise Deformable valve in
channel (see details in the section Starting and stopping the computation).

6.2.3.1 Manual start of Abaqus

Follow these steps:

· Place the file TwoValves.xml into the directory, in which the file TwoValves.inp locates.

· Open the Windows' command line or Linux's terminal and navigate to the directory with the project.

· Start the CSE Director program, which connects Abaqus and FlowVision. Use the command:

call abq2019 cse -config TwoValves -listenerport 5555

The cse.log file will appear in the directory with the project. This file contains information that CSE Director

has begun its operation.

· Start Abaqus using the command:

abq2019 -job TwoValves ask_delete -csedirector localhost:5555

The TwoValves.log file will appear in the directory with the project. This wile contains information about start

of Abaqus and connecting Abaqus to FlowVision.

6.2.3.2 Starting the computation from FlowVision

The project's computation is started from Pre-Postprocessor, see description of a standard starting in the
section Detailed description of a simplest model > Laminar flow in a tube > Starting the computation.

Stopping after 20 seconds of the simulated time is set in Abaqus. Also you can stop the project using the 
(Stop computation) button, and then resume the computation after editing the project.
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6.3 Use of inverted geometry and tuning the artificial compressibility

Here you will become familiar with a simulation that uses an inverted Moving body.

Problem setting

In this exercise the program simulates a hydraulic damper, which is capable to damp oscillations arising in an

external device or an assembly. The damper is a steel cylinder, wall of which is as thick as t, and superelastic

diaphragms at bases. The interior of the damper is filled with water.

The steel shell is rigidly fixed while movement of the superelastic diaphragms is not limited. A load of 10kg is
placed on the top surface of the upper superelastic diaphragms. Placing the load causes damped oscillations in
the damper.

External boundaries of the computational domain will be changing during the simulation. FlowVision implements
this behavior via an inverted Moving body modifier, which walls move according to the joint computation of
Abaqus and FlowVision with replacing the geometry. The reversed geometry of the Moving body allows the
program to use the computational domain inside the Moving body, not outside of it.

Coupling between Abaqus and FlowVision allows estimating of interaction a moving (or deforming) body and an
internal or external flow.

Coupling simulations can be implemented by the following approaches:
· Monolithic approach: equations of hydroaerodynamics and equations for strength design are calculated by

the same solver (a single one)
· Partitioned approach: equations are solved by two different solvers; some equations are solved by one solver

while other equations are solved by the other solver. This approach is implemented in the FlowVision-
Abaqus coupling.

In the monolithic approach interaction between the fluid and the structure on their boundary is considered
synchronously. This approach allows keeping the energy being conservative in the system that improves
numerical stability of the simulation. But such approach is focused on solving some specific type of problems.
When the monolithic approach is used, tasks with other conditions and tasks of other types require modifying
or re-engineering the solver and additional investigations.

So most of the tasks require specialized solvers, for example, rigidity of shells is simulated by a strength
design solver while a hydrodynamic solver calculates an internal stream in the interior of the shells. Generally
this interaction between the two solvers is a sequential process, which takes into account modular structure of
the software and interrelations between the programs (such as FlowVision and Abaqus). In the partitioned
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approach equations for hydroaerodynamics and for structure are integrated alternatively and conditions for the
interaction are not synchronized. This increases energy in the system and these schemes are often not not
stable. Reducing the numerical instability is reached by decreasing the time step and/or by use of damping
coefficients. 

Improving stability of the computation due to adding the artificial compressibility in
FlowVision

The artificial compressibility is added to reduce instability near a deformable wall specified in a CFD code. The
artificial compressibility prevents sharp changes of pressure that can cause instability of the computation.

The equation
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where

C=dl / dP is the flexibility

B=Aw / m is the mobility

shows that the instability appears due to changing velocity of the wall, that is using for calculating the Navier-
Stokes equations.

The artificial compressibility is specified by two coefficients, flexibility and mobility. Both the coefficients can be
used either together or separately.

The material's flexibility characterizes the ability of a structure (wall) to move under applied pressure. Use of
this setting is reasonable when the time step changes slightly during the simulation. In this case the initially
specified coefficient will work stable during the computation.

The material's mobility characterizes acceleration of the wall under applied pressure and depends strongly on
changing the time step during the computation. Use of this setting is effective when the time step changes
substantially (by a decade or more) during the computation.

Formulae for these coefficients give the initial estimate of the artificial compressibility. This estimate can be
excessive (cause a substantial change of weight or heavy damping) or can be inadequate (cause unstable
simulation) and require additional assessment by tuning the coefficients. The value might change in the range of
1-3 orders.

Files:

Geometry model CylFSI.wrl

Project in Abaqus CylFSI.inp

Project in FlowVision CylFSI

6.3.1 Preparing the project in FlowVision

Follow the steps described in the sections below:
· Creating an auxiliary external subregion
· Physical model
· Creating an Imported Object and a «Moving body» modifier
· Boundary conditions
· Computational grid
· Parameters of FlowVision's calculation
· Visualization
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6.3.1.1 Creating an auxiliary external subregion

FlowVision allows creating simple geometry for regions without use of external software. Creation a Cylinder
object is enough for this exercise.

Open Pre-Postprocessor, apply the File > Create command from the main menu, and in the New project
dialog box, which opens, select Create empty project:

The Cylinder, which is to be created, will be used as a region, into which an inverted Moving body will be
placed. This means that the computational domain will locate not in the Cylinder but inside the Moving body.
As the Moving body will change its shape during the computation, size of the Cylinder is to be enough for
this movability.

In the Geometry tab apply the Create command from the context menu of the Initial geom. models folder to
create the Cone/cylinder #0 object and specify the following parameters in its properties:

Object > Location

Reference point

X = 0

Y = -0.05

Z = 0

Axis X

X = 0

Y = 1

Z = 0

Axis Y

X = 0

Y = 0

Z = 1

Object > Parameters

Height = 0.1

Radius 1 = 0.05

Radius 2 = 0.05

Base ratio = 1

From the context menu of Cone/cylinder #0 select Create consistent mesh. In the project tree the
Cone/cylinder #0 element will obtain a child element mesh.
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From the context menu of the created consistent mesh select Use in SubRegion Composer. The
Cone/cylinder #0 - mesh element will appear in the subfolder SubRegion Composer > Objects.

From the context menu of the element SubRegion Composer > Composed subregions select Compose.
The Cone/cylinder #0 - mesh element will appear in the subfolder SubRegion Composer > Composed
subregions.

After the composing, the object Cone/cylinder #0 - mesh can be used as the Region's geometry in the
Preprocessor tab. From the context menu of the folder Composed subregions select Use as Region main
geometry.

The Preprocessor tab will open, where the Cone/cylinder #0 - mesh subregion will appear in the Subregions
folder.

6.3.1.2 Physical model

Specify parameters of the physical model in the Preprocessor tab.

In this exercise, the Substance is water. Properties of the Substance will be loaded from the standard
Substance database.

· Open the context menu of the folder Substances and, using the Create command, create Substance #0.

· From the context menu of Substance #0 select the command Load from SD > Standard and load the
substance Water in its liquid phase. Substance #0 will change its name to Water_Liquid and its child
elements (Molar mass, Density, Viscosity, Thermal conductivity, ...) will receive their values from the
Substance database.

· In properties of the element Water_Liquid > Density specify:

Value = 1000 (specify the value by a constant)

dRho/dP = 1e-20 (this parameter will be available after the density's value is specified by a
constant)

In the folder Phases:

· Create a continuous Phase #0.

· In Phase #0 add Water_Liquid into the subfolder Phase #0 > Substances.

· In properties of the folder Phase #0 > Physical processes specify:
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Motion = Navier-Stokes model

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

In properties of the element Subregions > Cone/cylinder #0 - mesh specify:

· Model = Model #0

6.3.1.3 Creating an Imported Object and a «Moving body» modifier

In the Preprocessor tab, from the context menu of the Objects folder, select Create.

The Create new object dialog box will open. Specify there Object type = Imported object and click OK.

Then select the file CylFSI.wrl, as the file, which contains geometry of the new Imported object.

The program will create Imported object #0.

In the folder Subregions > Cone/cylinder #0 - mesh > Modifiers create a Moving body modifier; specify in
the Create new modifier:

Modifier type = Moving Body
Objects = Imported object #0

The program will create Moving Body #0.

From the context menu of Moving Body #0 select Turn inside out.

When the inverted geometry used, the computational domain is created within a Moving body.

Please notice parameters FSI > Artificial compressibility, FSI > Flexibility and FSI > Mobility in
properties of Moving Body #0.

When you specify the artificial compressibility, you have to set Artificial compressibility = Yes and
numerical values of parameters Flexibility and Mobility.
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6.3.1.4 Boundary conditions

In this exercise the project contains two boundary conditions and they both are walls. The boundary conditions
was created automatically after carrying out the following actions:

· The first boundary condition (B.Cond. #0, which is aqua) was created automatically at creation the
subregion Cone/cylinder #0 - mesh.

· The second boundary condition (B.Cond. #1, which is blue) was created automatically at adding the
Moving Body #0 modifier into the project.

So the boundary conditions are already created.

Before the joint computation the model looks like this:
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6.3.1.5 Computational grid

In properties of the Initial grid specify:
nX = 40
nY = 40
nZ = 40

In the Properties window of the Initial grid click Apply.

6.3.1.6 Parameters of co-simulation

From the context menu of the folder External connections select the Create command to create a new
connector of the Abaqus CSE type. A dialog box will open where you have to select an inp-file; select there

the file CylFSI.inp.

In properties of the folder External connections specify:
Exchange step > Method = FlowVision
Exchange step > Default time step = 0.001
Exchange step > Coef. for time step = 1
Old offset = Yes

In properties of the element External connections > Abaqus CSE specify:
Activation = Yes
Abaqus > Run ABAQUS = No
Abaqus > IP Source = User
Abaqus > Address = host name or IP address of the computer, on which Abaqus will run.
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Abaqus > Port = 5555
Abaqus > Timeout [c] = 30
Loads relaxation > Scale factor = 1
Loads relaxation > Start in steps = 0
Loads relaxation > End in steps = 0
Loads relaxation > Initial coefficient = 1
Loads relaxation > Final coefficient = 1
Heat relaxation > Scale factor = 1
Heat relaxation > Start in steps = 0
Heat relaxation > End in steps = 0
Heat relaxation > Initial coefficient = 1
Heat relaxation > Final coefficient = 1

In properties of the element ASSEMBLY_EXSURF specify: Moving body = Moving body #0.

Do not change other settings.

6.3.1.7 Generating the CSE Director's configuration file

To generate the CSE Director's configuration xml-file, follow these steps:

In the Properties window of the External Connections > Abaqus CSE folder click the Operations > 

(Save configuration file for CS-service) button. The Export to configuration file dialog box will open.
Specify parameters there:

Cosolution scheme = Gauss-Seidel with prediction
Exchange Step = Let master program choose
Master program = FlowVision
Time stopping criteria = 20

Click OK. In the directory, which contains the client part of the project, the CylFSI.xml file will appear.

6.3.1.8 Parameters of FlowVision's calculation

The joint computation requires limiting the time step. As the body doesn't move at initial iterations, FlowVision
will start the computation with the default time step, which is equal to 1 [s]. Accordingly, the exchange step
with the FSI software will be also 1 and exchange between the programs will not begin for a long time.

To fix this issue, you have to limit the time step for the initial 10-100 iterations. Value of the maximal time step
is recommend to be set the same as the value of the initial step in Abaqus.

In the Solver tab, in properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = 20

Surface CFL = 1

Max step = 0.001

6.3.1.9 Visualization

Open the Postprocessor tab.

From the context menu of 3D-scene > Objects > Plane #0 select Clipping object.

From the context menu of the folder 3D-scene > Objects > Computational space > Solids select Apply
clipping.

Then set the visualization as described in subsections below.

Variation of volume, maximal pressure, and minimal pressure

Open the Preprocessor tab.

In the Characteristics folder create Characteristics on the Computational space.
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In properties of the just created Characteristics #0 (Computational space) specify Variable > Variable =
Pressure.

Open the Solver tab.

From the context menu of the folder Stopping conditions > User values select Create to create Stop
criterion #0.

In properties of the just created Stop criterion #0 specify:
Name = Volume
Object = Characteristics #0 (Computational space)
Variable = Volume (this parameter will be available when you specify the Object parameter above)

Create another Stop criterion with the following properties:
Name = Maximal pressure
Object = Characteristics #0 (Computational space)
Variable = Maximum (this parameter will be available when you specify the Object parameter above)

Create the third Stop criterion with the following properties:
Name = Minimal pressure
Object = Characteristics #0 (Computational space)
Variable = Minimum (this parameter will be available when you specify the Object parameter above)

Variations of the variables, which were used for specifying the Stop criteria, will be displayed during the
computation in the Plot tab of the Monitoring window.

Pressure distribution

Open the Postprocessor tab.

From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Color contours
Objects = Plane #0

In properties of the new Layer specify:
Name = Pressure, Pa
Variable > Variable = Pressure
Value range > Mode = Manual
Value range > Max = 2000
Value range > Min = -500
Palette > Appearance > Enabled = Yes
Palette > Appearance > Title = Yes
Palette > Appearance > Style = Style 1
Palette > Appearance > Color = Black

Velocity distribution

From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Vectors
Objects = Plane #0

In properties of the new Layer specify:
Name = Velocity, m/s
Variable > Variable = Velocity
On regular grid = No
Coloring > Variable > Variable = Velocity
Coloring > Value range > Mode = Manual
Coloring > Value range > Max = 1
Coloring > Value range > Min = 0
Coloring > Palette > Appearance > Enabled = Yes
Coloring > Palette > Appearance > Title = Yes
Coloring > Palette > Appearance > Style = Style 1
Coloring > Palette > Appearance > Color = Black

Cross-section of the computational grid
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Cross-section of the computational grid visualizes the area, where the computation will run.

From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Computational grid section
Objects = Plane #0

6.3.2 Start of joint computation

· Manual start of Abaqus
· Starting the computation from FlowVision

For this exercise it is possible to start a joint computation using MPM-Agent (in FlowVision 3.12.04 or
newer versions). In older FlowVision versions only manual start of a joint computation is possible.

To run this exercise using MPM-Agent, apply settings described in the exercise Deformable valve in
channel (see details in the section Starting and stopping the computation).

6.3.2.1 Manual start of Abaqus

Follow these steps:

· Place the file CylFSI.xml into the directory, in which the file CylFSI.inp locates.

· Open the Windows' command line or Linux's terminal and navigate to the directory with the project.

· Start the CSE Director program, which connects Abaqus and FlowVision. Use the command:

call abq2019 cse -config CylFSI -listenerport 5555

The cse.log file will appear in the directory with the project. This file contains information that CSE Director

has begun its operation.

· Start Abaqus using the command:

abq2019 -job CylFSI ask_delete -csedirector localhost:5555

The CylFSI.log file will appear in the directory with the project. This wile contains information about start

of Abaqus and connecting Abaqus to FlowVision.

6.3.2.2 Starting the computation from FlowVision

The project's computation is started from Pre-Postprocessor, see description of a standard starting in the
section Detailed description of a simplest model > Laminar flow in a tube > Starting the computation.

Stopping after 20 seconds of the simulated time is set in Abaqus. Also you can stop the project using the 
(Stop computation) button, and then resume the computation after editing the project.

Run the project. The project will end with crash of the solver after several exchanges. The crash of the solver is
caused by a sharp growth of pressure in the enclosed volume and subsequent stop of the computation.

To fix this issue, you have to tune artificial compressibility coefficients that provide stable solution.

Before you begin to tune the artificial compressibility coefficients, specify in the Preprocessor tab, in
properties of the element Region > Substances > Water_Liquid > Density specify dRho/dP = 0 (here we
change the previously set value dRho/dP=1e-20 with a zero value, which, at the enabled artificial
compressibility, will not cause crash of the computation.

6.3.3 Tuning the artificial compressibility

· Estimate of flexibility in Abaqus
· Estimate of mobility in FlowVision
· Investigation of artificial compressibility
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6.3.3.1 Estimate of flexibility in Abaqus

The Abaqus model is a cylinder consisting of two materials (thickness of the walls corresponds to materials
used).

Most flexible part in this model is a hyperelastic element. Deformation of steel will be too small even under
large loadings. So it is reasonable to estimate flexibility of the hyperelastic material only.

In Abaqus/CAE apply the command File > Import > Model and import the file CylFSI.inp.

To estimate the flexibility, you have calculate change of the load and displacement under this load during a
small time shift. When obtaining the coefficient, you have to use a small time step in the Abaqus project.

Navigate to the module Steps and specify the following parameters for the FSI step:
Basic > Time period = 1
Incrementation > Initial increment size = 1E-6
Incrementation > Maximum increment size = 1E-6

From the context menu of  Loads > Gravity select Suppress. This load will be hidden from the analysis.

Instead of this load create a pressure and apply it to the surface as shown on the illustration below. Magnitude
of the pressure is to be selected as to 3000 [Pa]. Also the existing value AMP-1 is to be selected in the
Amplitude field.
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Run the simulation. It is not necessary to wait ending of the simulation, it is enough to wait for 30-50 iterations.

Open the ODB-file of the simulation. Use Create XY Data > ODB Field Output to create following plots:
· plot of pressure (output variable is P, position is Element Face)
· plot of displacement along axis Y (output variable is U.U2, position is Unique Nodal)
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These plots can be exported to Excel by the command Plugins > Tools > Excel Utilities.
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Use the obtained data to calculate the value of flexibility as ration of change of displacement to change of
pressure.

The flexibility is calculated by the formula: C=dl/dP.
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The flexibility is recommended to be calculated starting from 30th - 50th iteration because of too small pressure
is applied at the beginning of the simulation:

The flexibility C is approximately equal to 5·10-11 [m/Pa].

As in this case the displacement vector is directed against the Y axis, the absolute value of the calculated
value of the flexibility is to be taken.

6.3.3.2 Estimate of mobility in FlowVision

To estimate the mobility, it necessary to know surface area and mass of the body, which will interact with the
liquid.

Mass of the body (of the hyperelastic elements) can be received from Abaqus/CAE. Import the CylFSI.inp

file.

To display the hyperelastic element, navigate to Tools > Display Group > Create > Item: Sets and select
PART-1-1.SET-2. In the dialog box Perform a Boolean on the viewport contents and the selection click
Replace and close the Create Display Group dialog box.

Navigate to the Mesh module. Use Tools > Query > Mass Properties and find the mass of the hyperelastic
elements, which is 0.0511 [kg].

Area of the surface can be found in FlowVision. Use the File > Preferences command to open the
Preferences dialog box and specify there Display > Show all groups = Yes. In the project tree below the
element Region > Subregion > Cone/cylinder #0 - mesh > Geometry > Moving body #0 find the group
that matches to the surface of hyperelastic element and its properties look for its area, which is to be 0.0055

[m2]. Area of both hyperelastic elements is to be 0.011 [m2].

The estimate of mobility is calculated by the formula B=Aw /m and is to be 0.21 [m2/kg].

6.3.3.3 Investigation of artificial compressibility

Obtained estimates of flexibility and mobility are to be specified in the project tree in properties of the Region >
Subregion > Cone/cylinder #0 – mesh > Modifiers > Moving Body #0 element:

· FSI > Artificial compressibility = Yes
· FSI > Flexibility = 5E-11
· FSI > Mobility = 0.21

Run the joint simulation and wait until the volume begins to convergence:
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The obtained plot can be used to evaluate the error caused by entering artificial compressibility into the
computation.

Decreasing coefficients of the artificial compressibility can cause reducing the error but too small coefficients
can cause nonconvergence of the simulation. To tune the coefficients correctly, you have to run the simulation
several times for several iterations using different coefficients of artificial compressibility at each run (the
coefficients should be increased/decreased by an order or twice/three times more/less).

Value of the error is to be estimated by the formula δV=(V
max

-V
min

) /V
0
.
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After several trial runs with various coefficients the following combination is to be selected, which provides the
computational error 0.77% (shown by the dark blue line on the plot):

· flexibility C = 7.5·10-15 [m/Pa]

· mobility B = 0.003025 [m2/kg]

Use of these coefficients gives minimal errors and provides stable and accurate solution. Smaller coefficients
will cause an unstable simulation. When the coefficients are too large, the artificial compressibility will
substantially affect the solution, which will become unphysical.
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6.4 External heat exchange in the FlowVision-Abaqus conjunction

Problem setting

Solving the problem of heat transfer as a joint simulation with an third-party finite-element analysis (FEA)
software allows you to evaluate deformation of a structure, which is under the influence of external heat flows.
Also the FEA software allows you to take into account anisotropic properties of the material; this provides
better evaluation of heat transfer in the deformed body.

The heating process will be simulated in Abaqus. Temperature of 100°С applied to the base of the brick, which
is the deformed body, at the first step of the computation. The joint simulation of heat transfer on the brick's
boundaries in the FlowVision-Abaqus conjunction starts at the second step of the computation. FlowVision
simulates the forward flow heated by walls of the brick and dynamics of the temperature's field. Abaqus
simulates heat transfer in the solid body and deformations caused by the temperature expansion.

As in the previous exercises, in this exercise we study creation of projects both in Abaqus and FlowVision, and
also study their interrelations and starts. If you use a ready model BrickABQ.inp, you can skip the section

about preparing the Abaqus project.

Files:

Project in Abaqus BrickABQ.inp

Project in FlowVision Brick

6.4.1 Preparing the project in Abaqus

Follow the steps described in the sections below:
· Preparing the geometry model of the brick in Abaqus
· Specifying an interface surface in Abaqus
· Specifying boundary conditions and loads in Abaqus
· Generating an inp-file
· Modifying the inp-file of the Abaqus' project
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6.4.1.1 Preparing the geometry model of the brick in Abaqus

This section describes how you can create the model of a brick in Abaqus (version 2019) by your own. You can
skip this section if you use a ready model BrickABQ.inp and return to this section when you wish to receive

appropriate experience.

1. Open Model > Edit Model Attributes > Model-1 and specify the absolute zero temperature:
Absolute zero temperature = -273

2. Click the icon  (Create Part). The Create Part dialog box will open, specify there:
Name = Brick
Modeling space = 3D
Type = Deformable
Base Feature > Shape = Solid
Base Feature > Type = Extrusion
Approximate size = 0.25

and click Continue.

2. In the graphical work window, which opens, use the tool  (Create Isolated Point) to create points,
which will be used to create the brick's contour. To do so, enter the following coordinates: [-0.003,0.03];[-

0.003,-0.01];[0.098,0.03];[0.098,-0.01]. Then use the tool  (Create Lines Connected) to outline the
contour by lines. To do so, click Done (the mouse wheel).
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Making a contour for the part Brick

3. The Edit Base Extrusion dialog box will open. Enter the brick's thickness, enter the value 20e-3 into the
Depth field and then click OK:

Creating the part Brick

4. Specify properties of the material. Navigate to the module Property. Click  (Create Material) to create
a new material.

5. The Edit Material dialog box will open; specify there:

Name = Steel (name of the material)

General > Density = 7890 (density of the material, [kg∙m-3])

Mechanical > Elasticity = Elastic

Mechanical > Type = Isotropic

Mechanical > Young’s Module = 2E11 (Young's modulus, [Pa])

Mechanical > Poisson’s Ratio = 0.3 (Poisson's ratio)

Mechanical > Expansion > Type = Isotropic

Mechanical > Expansion > Expansion Coeff = 7.2E-6

Thermal > Conductivity > Type = Isotropic
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Thermal > Conductivity > select the checkbox Use temperature-dependent data 

Thermal > Conductivity > specify the data:

λ, [W ⁄ (m °C)] T, [°C]

48.5 0

46.5 100

44 200

40.8 300

Thermal > Specific Heat > Type = Constant Volume

Thermal > Specific Heat > select the checkbox Use temperature-dependent data

Thermal > Specific Heat > Number of field variables = 0

Thermal > Specific Heat > specify the data:

Cp , [J ⁄ °C] T, [°C]

466 0

486 100

507 200

523 300

and click OK.

6. Create a section made of the material Steel. Click  to open the Create Section dialog box. Specify
there:

Name = Steel (name of the section)
Category = Solid
Type = Homogeneous

and click Continue.

The Edit Section dialog box will open. Select there Material = Steel and click OK.

 

Creating and editing a section

7. Click  (Assign Section) and in the dialog box Edit Section Assignment assign the just created
section to the part, which you have created. Select the whole brick (it will be highlighted by red) and click
Done. In the dialog box, which opens, click OK.
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Assigning a section to the part Brick

8. Creating an assembly and setting the analysis. Navigate to the module Assembly. To create an instance,

click  (Create Instance). A window will open with a list of created parts. Select the part Brick and specify
Instance type = Dependent. The just created part will appear in the graphical work window. Click OK.

9. Specify the procedure of analysis for the preliminary computation. The numerical simulation will consist of
two steps, the first step is used for the preliminary computation of heating the brick. Navigate to the module

Step, click  (Create Step). In the dialog box Create Step specify:
Name = Preload
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Procedure Type = General
From the list below select Coupled temp-displacement and click Continue.

10. The Edit Step dialog box will open where you have to specify parameters of the step, which will be used in
the analysis. In the Basic tab specify:

Response = Steady-state
Time Period = 0.1
Nlgeom = Off

Don't change the default settings in the Incrementation tab.

11. Create the second step of the analysis. At this step the FSI computation will be done. In the dialog box
Create Step specify:

Name = FSI
Procedure Type = General
From the list below select Coupled temp-displacement and click Continue.
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12. The Edit Step dialog box will open. Specify there in the Basic tab:
Response = Steady-state
Time Period = 20
Nlgeom = Off

In the Incrementation tab specify:
Maximum numbers of increments = 100000 (maximal number of increments)
Increment size > Initial = 0.01 (the initial increment)
Increment size > Minimum = 1E-10 (the minimal increment)
Maximum increment size > Specify = 10 (the maximal increment)

Click OK.

13. Navigate to the module Mesh Object: Part. Apply the tool  (Seed part Instance) to split the brick into
elements. Specify Approximate global size = 0.0015 and click OK.

Apply the tool  (Seed edges) and specify 1 element on each face along the axis Z.



478FlowVision Help

 

Splitting the geometry

For this type of analysis you have to select the appropriate type of elements (С3В8T). Click  (Assign
Element Type) and specify the following settings:

Element Library = Standard
Geometric Order = Linear
Family = Coupled Temperature-Displacement
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13. To start the grid generation, click  (Mesh Part Instance) and then click Yes.
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6.4.1.2 Specifying an interface surface in Abaqus

The next important step of creation the model for joint computation is specifying an interface surface between
Abaqus and FlowVision.

Abaqus simulates deformations and thermal flows within the brick and exports temperature from nodes on the

brick's surface to FlowVision.

Follow these steps:

In the model tree double-click Assembly > Surfaces (or select and use the Create command). The Create
Surface dialog box will open; specify there:

Name = DC-SURF (name of the interface surface)
Type = Geometry
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Click Continue and select the whole brick. Click Done.

6.4.1.3 Specifying boundary conditions and loads in Abaqus

Follow these steps:

1. Navigate to the module Load. Select  (Create Boundary condition) and create a boundary condition
on the bottom surface of the brick with the following parameters:

Name = FIX
Step = Preload
Category = Mechanical
Types for Selected Step = Symmetry/Antisymmetry/Encastre

Click Continue.
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2. In the graphical work window select the bottom surface of the brick and click Done. In the Edit Boundary
Condition dialog box, which opens, select for the brick's face the boundary condition type ENCASTRE
(U1=U2=U3=UR1=UR2=UR3=0) that prohibits movement of this face for any degrees of freedom:

3. Create a new boundary condition (on the same surface of the brick) with the following parameters:
Name = Temperature
Step = Preload
Category = Other
Types for Selected Step = Temperature

Click Continue.

4. In the graphical work window select the bottom surface of the brick and click Done.

In the Edit Boundary Condition dialog box, which opens, specify Magnitude=100.
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6.4.1.4 Generating an inp-file

To generate an inp-file, follow these steps:

1. Navigate to the module Job and in the window Job Manager ( ) create a new analysis.

Click Create; after this the Create job dialog box will open; specify there the name BrickABQ for the new
analysis and click Continue.

2. In the Job Manager window select the line of the just created analysis and click Write Input to create an
input file, geometry of which will be imported to FlowVision. Also this input file will be required to make the
computation.

3. Save and close the project.

6.4.1.5 Modifying the inp-file of the Abaqus' project

The ready file BrickABQ.inp, which is included into the delivery, has already been modified. If you use the

file, you can skip this section, but we recommend to open and browse contents of this file using any text editor.

If you wish to create the BrickABQ.inp file by your own, follow these steps:

· Open the inp-file of the Abaqus' project in a text editor.

· Add the following lines into the module STEP for the step **Step: FSI the following lines before the line

*End Step:
*CO-SIMULATION, PROGRAM=DIRECT, NAME=FlowVision, CONTROLS=FSI

*CO-SIMULATION REGION, IMPORT

ASSEMBLY_DC-SURF, CFL

*CO-SIMULATION REGION, EXPORT

ASSEMBLY_DC-SURF, NT

*CO-SIMULATION CONTROLS, NAME=FSI, TIME INCREMENTATION=SUBCYCLE, TIME MARKS=YES

These lines are used to identify the coupling analysis with another program.

Important notice: you have to add ASSEMBLY_ before the interface region's name in lines of the co-simulation.

After the modification the inp file have not to contain empty lines.

See also: More details about these settings (*CO-SIMULATION, *CO-SIMULATION CONTROLS, *CO-SIMULATION

REGION) you can found in the Abaqus Keywords Reference Manual.
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6.4.2 Preparing the project in FlowVision

FlowVision simulates motion and heating the cold air in the channel.

Requirements to the FlowVision's project:
· The geometry of the deformable body has to be loaded from Abaqus into FlowVision, and this geometry

must completely comply to the deformable geometry in the Abaqus project.
· The geometry of the deformed body, loaded into FlowVision, must comply with the requirements to the

geometry in FlowVision (see User's guide).

6.4.2.1 Geometry

Geometry for this exercise is created in the Geometry tab in Pre-Postprocessor.

Open Pre-Postprocessor, apply the File > Create command from the main menu, and in the New project
dialog box, which opens, select Create empty project.

In the Geometry tab apply the Create command from the context menu of the Initial geom. models folder to
create a Box object.

In the Properties window of the new Box specify:

Object > Location

Reference point

X = 0.075 [m]

Y = 0 [m]

Z = 0 [m]

Axis X

X = 1

Y = 0

Z = 0

Axis Y

X = 0

Y = 1

Z = 0

Object > Size

X = 0.45 [m]

Y = 0.018 [m]

Z = 0.1 [m]
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From the context menu of Box #0 select the command Create consistent mesh and specify Approximation
parameters for the new consistent mesh:

Size 1 = 1
Size 2 = 1
Size 3 = 1

From the context menu of the new consistent mesh select the command Use in SubRegion Composer. The
Box #0 - mesh element will appear in the subfolder SubRegion Composer > Objects.

From the context menu of the element SubRegion Composer > Composed subregions select Compose.
The Cone/cylinder #0 - mesh element will appear in the subfolder SubRegion Composer > Composed
subregions.

After the composing, the object Box #0 - mesh can be used as the Region's geometry in the Preprocessor
tab. Rename the object Box #0 - mesh as Subregion #0. From the context menu of the folder Composed
subregions select Use as Region main geometry.

6.4.2.2 Physical model

In this exercise, the Substance is air. The Substance will be loaded from the standard Substance database.
· Open the context menu of the folder Substances and, by the command Create, create Substance #0.
· From the context menu of Substance #0 select the command Load from SD > Standard and load the

substance Air in its gas phase.

In the folder Phases:
· Create a continuous Phase #0.
· In Phase #0 add Substance #0 into the subfolder Phase #0 > Substances.
· In properties of the folder Phase #0 > Physical processes specify:

Heat transfer = Heat transfer via h
Motion = Navier-Stokes model
Turbulence = KES

In the folder Models:
· Create Model #0.
· Add Phase #0 into subfolder Model #0 > Phases.
· Specify motion of the fluid along the axis X with velocity 2 [m/s]. To do so, in properties of the element

Models > Model #0 > Init. data > Init. data #0 > Velocity (Phase #0) specify:

X = 2 [m s-1]

In properties of SubRegion #0 specify Model = Model #0.

6.4.2.3 Creating the Imported object and the Moving body

The brick is inserted into the project as an imported geometry Object, on which the Moving body modifier is
set.

Follow these steps:

In the folder Objects:
· From the context menu of the folder Objects select the command Create and in the Create new object

dialog box, which opens, select Object type = Imported object.
· From the dialog box, which opens, select the file BrickABQ.inp. Imported object #0 will appear in the

folder Objects.

Create a Moving body modifier on Imported object #0:

· From the context menu of the folder Subregions > SubRegion #0 > Modifiers select the command Create
and in the Create new modifier dialog box, which opens, select:

Modifier type = Moving body
Objects = Imported object #0

The Moving body #0 modifier will appear in the folder Subregions > SubRegion #0 > Modifiers.

· In properties of the just created modifier Moving body #0 specify its initial position:
Initial position

Reference point
X = -0.04 [m]
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Y = 0.01 [m]
Z = -0.041 [m]

Axis Y
X = 0
Y = 0
Z = 1

· Click Apply and then place Moving body #0 to its initial position (click the icon Operations > ).

6.4.2.4 Boundary conditions

Specify boundary conditions and assign them according to the illustration above.

Boundary 1

Name = Symmetry

Type = Symmetry

Color =  Fuchsia

Boundary 2

Name = Inlet

Type = Inlet/Outlet

Variables

Temperature (Phase #0) = Temperature

Value = 0 [°C]

Velocity (Phase #0) = Fixed velocity

Value > X = 2 [m/s]

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Color =  Red

Boundary 3
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Name = Outlet

Type = Free Outlet

Variables

Temperature (Phase #0) = Zero gradient

Velocity (Phase #0) = Total pressure

Value = 0 [Pa]

TurbEnergy (Phase #0) = Zero gradient

TurbDissipation (Phase #0) = Zero gradient

Color =  Blue

Boundary 4

Name = Wall

Type = Wall

Variables

Temperature (Phase #0) = Zero gradient

Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Color =  Gray

Boundary 5

Name = Brick

Type = Wall

Variables

Temperature (Phase #0) = External conjugate

Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Color =  Yellow

6.4.2.5 Parameters of co-simulation

· From the context menu of the External Connections folder select the Create command.

· In the Create new object dialog box, which opens, select Object type = Abaqus Direct Coupling.

· A dialog box for access to files will open; select there the BrickABQ.inp file.

· An Abaqus Direct Coupling child element will appear in the External Connections folder:

The Abaqus Direct Coupling element, in its turn, has a child element ASSEMBLY_DC-SURF.

· In properties of the folder External Connections specify:
Exchange step > Method = FlowVision
Exchange step > Default time step = 0.01
Exchange step > Coef. for time step = 1
Old offset = Yes
AutoSave = Yes

· In properties of the element Abaqus Direct Coupling specify:
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Activation = Yes
ABAQUS > Run ABAQUS = Yes
ABAQUS > MPM Agent > Address = host name or IP address of the computer, on which MPM

Agent will run that will start Abaqus.
ABAQUS > MPM Agent > Port = the default port, which is used by MPM Agent of the current version
ABAQUS > IP Source = IP of MPM Agent
ABAQUS > Port = 5555
ABAQUS > Timeout [s] = 100
Loads relaxation > Scale factor = 1
Loads relaxation > Start in steps = 0
Loads relaxation > End in steps = 0
Loads relaxation > Initial coefficient = 1
Loads relaxation > Final coefficient = 1
Heat relaxation > Scale factor = 1
Heat relaxation > Start in steps = 0
Heat relaxation > End in steps = 20
Heat relaxation > Initial coefficient = 0
Heat relaxation > Final coefficient = 1

· In properties of the element ASSEMBLY_DC-SURF specify Moving body = Moving body #0.

Don't change other settings.

6.4.2.6 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.01 [m]

h_min = 0.0025 [m]

Insert a reference line with coordinate:

x = 0.15 [m]

Specify Reference line parameters for the reference line with coordinate x=-0.15:

h = 0.0025 [m]

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0.15:

h = 0.0025 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate x=0.3:

h = 0.01 [m]

Specify in properties of the Initial grid:
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Grid structure = 2D
Plane = XZ
nZ = 40

In the Properties window of the Initial grid click Apply.

6.4.2.7 Adaptation of the grid

Creating the Adaptation

We need to apply the adaptation of the computational grid gradually; refinement of the grid will increase in the
boundary layer during the computation.

This is achieved by gradual adaptation of the grid from the 1st to the 3rd level within 300 steps; each new level
of adaptation turns on after next 100 steps of computation.

Follow these steps to specify the adaptation:

· Create the element Computational grid > Adaptation > Adaptation #0.

· Add the boundary condition Brick into the folder Computational grid > Adaptation > Adaptation #0 >
Objects.

· In properties of Adaptation #0 specify the Max level N parameter as a table of dependency on the Current

step number. Select  Table f(x) on the right from the Max level N field and then click the  button

to open the Table editor. In the Table editor, in the argument column (Arg#0), click button
  

and then

select  (Bind to variable). Then, in the Variable selection dialog box, which opens, select Integral >

Internal characteristics > Current step number and specify the tabulated function:

x f(x)

0 0

100 1

200 2

300 3

· In our case the adaptation keeps thickness of the adapted layer. Adaptation layers will also be specified by
tables. When a new adaptation layer is enabled, boundary of the 1st level of adaptation don't change and all
new adaptations will be created within the 1st layer, spending the required number of cells. The argument
variable, which will be used for tabulated values of numbers of adaptation layers, will also be Current step

number. Click twice the button  (Append item to the array) in the Layers line in properties of

Adaptation #0 to create parameters Layers > Layers for Level N-1 and Layers > Layers for Level N-2:

· Specify the tabulated dependency of Layers for Level N on Current step number:
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x f(x)

0 0

100 7

200 6

300 4

· Specify the tabulated dependency of Layers for Level N-1 on Current step number:

x f(x)

0 0

200 4

· Specify the tabulated dependency of Layers for Level N-2 on Current step number:

x f(x)

0 0

300 4

6.4.2.8 Parameters of calculation in FlowVision

This FSI simulation assumes only heat exchange in the interaction between FlowVision and Abaqus.

Because of there is no import of coordinates into FlowVision, the time step will be defined only by convective
and diffusive CFLs. The surface CFL is not taken into account because of there are no replacing or motion of
the Moving body.

In the Solver tab, in properties of the Time step element, specify:

Method = Via CFL number

Convective CFL = 100

Surface CFL = 1E+20

Diffusive CFL = 100

6.4.2.9 Visualization

Visualization is shown for the step number near 650.

Open the Postprocessor tab.

In properties of the object Objects > Plane #0 specify:

Object

Normal

X = 0

Y = 1

Z = 0

Velocity distribution
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From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Vectors
Objects = Plane #0

In properties of the new Layer specify:
Name = Velocity, m/s
Variable > Variable = Velocity
On regular grid = Yes
Grid > Size 1 = 70
Grid > Size 2 = 40
Scaling > Mode = Manual
Scaling > Maximum = 5
Scaling > Reference length = 0.005
Coloring > Variable > Variable = Velocity
Coloring > Value range > Mode = Manual
Coloring > Value range > Max = 5
Coloring > Value range > Min = 0
Coloring > Palette > Appearance > Enabled = Yes
Coloring > Palette > Appearance > Title = Yes
Coloring > Palette > Appearance > Style = Style 1
Coloring > Palette > Appearance > Color = Black

Temperature distribution on Plane #0

From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Color contours
Objects = Plane #0
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In properties of the new Layer specify:
Name = Temperature, C
Variable > Variable = Temperature
Value range > Mode = Manual
Value range > Max = 100
Value range > Min = 0
Palette > Appearance > Enabled = Yes
Palette > Appearance > Title = Yes
Palette > Appearance > Style = Style 1
Palette > Appearance > Color = Black

Temperature distribution on the Imported Object

From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Color contours
Objects = Imported object #0

In properties of the new Layer specify:
Name = Twall, C
Variable > Variable = Temperature
Value range > Mode = Manual
Value range > Max = 100
Value range > Min = 90
Palette > Appearance > Enabled = Yes
Palette > Appearance > Title = Yes
Palette > Appearance > Style = Style 1
Palette > Appearance > Color = Black

Cross-section of the computational grid
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From the context menu of the folder Layers select Create, and in the dialog box Create new layer specify:
Layer type = Computational grid section
Objects = Plane #0

In properties of the new Layer specify:
Name = Computational grid section
Appearance > Mode = Lines

6.4.3 Starting and stopping the computation

Before starting the computation you have to run MPM-Agent.

MPM-Agent has to receive the path to the executable file of Abaqus. If the path has not been provided, you can
specify it in the FlowVision's module Configurator. To do so, click in Configurator the View button on the
right near the MPM Agent field in the Configuration files pane in the Configuration/Logs tab and specify the
data in the MPM Agent configuration dialog box, which opens:

The project's computation is started from Pre-Postprocessor, see description of a standard starting in the
section Detailed description of a simplest model > Laminar flow in a tube > Starting the computation.

Stopping after 20 seconds of the simulated time is set in Abaqus. Also you can stop the project using the 
(Stop computation) button, and then resume the computation after editing the project.
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6.5 Joint simulating flow of liquid and heat exchange by FlowVision
and APM WinMachine

This exercise demonstrates abilities of joint simulating made by FlowVision and a third-party FEA software
APM WinMachine.

APM WinMachine is a CAE-software for automated analysis and design of mechanical equipment,
developed with the latest advances in computational mathematics, calculus and software coding, and
also theoretical and trial engineering solution.

In this problem setting we examine flow of liquid in steel tube under high pressure. The high pressure is applied
to walls and causes deformations of flow passage of the tube and increases the liquid flow rate.

Besides simulating the strain-stress state, heat transfer is also simulated in this problem. The temperature drop
between the outer part of the tube and the flow passage of the tube causes temperature strains of the
assembly.

The applied approach allows you to evaluate deformations of the assembly along with liquid flow rate through
the tube's flow passage calculated with the deformations taken into account.

The project is created using the following software products:
· APM Studio 19: creation geometry and mathematical FEA model.
· APM Structure3D 19: creation the exchange surface, starting the joint computation in APM WinMachine

and calculations of the FEA model:
o calculation of the strain-stress state

o simulating the heat transfer to outside environment.

· FlowVision: preparing a project, starting the joint computation in FlowVision, and computation of the liquid's
flow in the flow passage.

Files

Geometry model that is to be imported by APM Studio PipeAPM.stp

Geometry model of the Imported object in FlowVision ClosedSurf.mesh

Project in FlowVision APM_HeatExchange
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6.5.1 Preparing a project in APM Studio

Open APM Studio and follow steps described in subsections below:
· Importing the geometry model to АРМ Studio
· Boundary and initial conditions for the thermal calculation
· Specifying restraints for strength calculation
· Specifying properties of material of the part
· Creating and saving the finite-element mesh

6.5.1.1 Importing the geometry model to АРМ Studio

In the APM Studio software apply the command File > Import and select the file PipeAPM.stp, which

contains the geometry model to be imported.

The STEP-File Header Data dialog box will open with settings of geometry model import:

Do not change the settings. Click OK.

The program will load the geometry model of the tube:
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6.5.1.2 Boundary and initial conditions for the thermal calculation

Boundary conditions of heat exchange with surrounding medium

Before specifying the boundary and initial conditions for the thermal calculation, you have to activate the
appropriate toolbar.

Apply the command Tools > Application properties. The Application properties dialog box will open:

In this dialog box open the tab Analysis Types and select the Heat transfer checkbox.

You have to specify convection on the outer surface. To do so, select Transient thermal conductivity >

Convection ( ) in the toolbar. The Convection dialog box will open:
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In this dialog box specify:
· faces, to which the loads will be applied (select outer faces only)

· Heat transfer coefficient = 8e-06 [W/(mm2·°C)]
· Ambient temperature = 0 [°C]

Initial conditions
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To carry out an unsteady-state thermal calculation, you have to specify the initial temperature on the whole
part.

Select Transient thermal conductivity > Initial temperature ( ). The Initial Temperature dialog box will
open:

In this dialog box select Set on > Part and specify Temperature = 100 [°C].
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6.5.1.3 Specifying restraints for strength calculation

To carry out a strength calculation, you have to secure the part using the command Fixations > Fixation ( ).
The Restraints dialog box will open:

In this dialog box specify the face, which will be restrainted. Select the rim on the upper plane as shown on the
illustration below:

Apply the command Fixations > Normal ( ). The Normal Restraint dialog box will open:
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In this dialog box specify the faces that are restrainted along their normals. Do not change the default value of
the displacement along a normal, 0 [mm].
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6.5.1.4 Specifying properties of material of the part

To specify properties of the part's material, select Properties > Material ( ). The Material dialog box will
open:

In this dialog box you have to specify properties of the part. Select Assign to > Part.

Click the Edit screen button. The Material Parameters dialog box will open where you have to specify
parameters required for the computation.

By default the program uses parameters of Steel.
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To carry out the thermal calculation, you have to specify thermal properties. Click the THT Properties screen
button to open the dialog box for entering additional properties:

Enter values of Heat capacity and Heat conduction and click OK. Then click OK in dialog boxes Material
Parameters and Material.

6.5.1.5 Creating and saving the finite-element mesh

Creating the finite-element mesh

To create the finite-element mesh, select Finite-element mesh > Generate ( ) in the toolbar. The Mesh
Parameters of Solid Model dialog box will open:

In this dialog box specify:
· Solid type = 4-noded Tetrahedron
· Maximum length of element side = 20 [mm]
· Minimum length of element side = 0.05 [mm]
· Maximum condensation ratio on surface = 2
· Rarefaction ratio on volume = 1.5

Click OK. The Meshing results informational box will open. Don't close this box and follow to saving the finite-
element mesh (see subsection below).
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Saving the finite-element mesh

To save the finite-element mesh, select the command File > Save FEM. A dialog box will open where you have
to specify a file, in which the APM Structure3D project will be saved (enter the name of the project's file).

After saving the file, close APM Studio. The further actions will be done in APM Structure3D.

6.5.2 Preparing the project in APM Structure3D

APM Structure3D is one of modules of the APM WinMachine software package.

APM Structure3D allows you to:
· Prepare a FEA model to computation
· Create an exchange surface for further exchange with FlowVision
· Start the prepared in APM Studio project to joint computation
· Visualize and process the results

Open APM Structure3D and follow steps described below in subsections:
· Naming a layer
· Saving the project and exporting the model

6.5.2.1 Naming a layer

Open the FE mesh in the project using the command File > Open. The file is to have extension .frm and

locate in the same place where it has been saved at saving the finite-element mesh in APM Studio.

Select Current Parameters > Layers Manager ( ) from the toolbar. The Layers dialog box will open:

In this dialog box examine number of layers and names of layers. Remove all empty layers. The remaining layer
is to be named as DC-SURF0 (don't change its name).

To rename a layer, you can press the button F2 on the keyboard.

6.5.2.2 Saving the project and exporting the model

To create a connector in FlowVision, you have to export an .inp file from APM Structure3D.

Apply the command Tools > Analysis server > Analysis server TCP/IP. The Calculation Server dialog box
will open:
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In this dialog box specify all required settings and then create a file for data exchange between the programs.
To do so, click the Export screen button and, in the dialog box, which opens, specify:

· location where the file will be placed
· the file name
· the file type specify as Flow Vision mesh files (APMFV.inp)

6.5.3 Preparing the project in FlowVision

Preparing the project in FlowVision is described in subsections below:
· Geometry of the region
· Physical model
· Creating the computational domain
· Boundary conditions
· Parameters of co-simulation
· Inspection of the transferred data
· Computational grid
· Parameters of calculation in FlowVision
· Visualization

o Velocity distribution on a plane

o Pressure distribution on a plane

o Temperature distribution on the moving body

o Integral heat flow rate on the exchange surface

6.5.3.1 Geometry of the region

Open Pre-Postprocessor and apply the command File > Create from the main menu. In the New project
dialog box, which opens, select Create empty project.

The created Box will be the region that contains an inverted Moving body. The computational domain will
locate inside the Moving body only. As shape of the Moving body will be changing during the computation,
you have to specify the Box with some reserve by size.
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In the Geometry tab in the folder Initial geom. models apply the Create command from its context menu
and create the Box #0 object and in its properties specify:

Object > Location

Reference point

X = 0.15 [m]

Y = -0.1 [m]

Z = 0 [m]

Object > Size

X = 0.75 [m]

Y = 0.9 [m]

Z = 0.3 [m]

From the context menu of Box #0 select the command Create consistent mesh and in the Approximation
parameters dialog box, which opens, specify:

Size 1 = 1
Size 2 = 1
Size 3 = 1

In the project tree the element Box #0 will obtain a child element mesh.

From the context menu of this element mesh select the Use in SubRegion Composer command. In the
subfolder SubRegion Composer > Objects the element Box #0 – mesh will appear.

From the context menu of this element SubRegion Composer > Composed subregions select the
Compose command. In the subfolder SubRegion Composer > Composed subregions the Box #0 - mesh
child element will appear.

When the composing is done, the Box #0 - mesh object can be used as geometry of the Region in the
Preprocessor tab. From the context menu of the element Composed subregions select the command Use
as Region main geometry.

The Preprocessor tab will open where the Subregions folder will contain a child element corresponding to the
Box #0 - mesh subregion.
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6.5.3.2 Physical model

As during the data transfer APM converts all variables into absolute values, you have to specify value of the
reference temperature.

It is not allowed the user to specify zero value of the reference temperature in FlowVision, so you have to
specify small (but not zero) value of it (0.001 K). In properties of the element General settings specify the
reference values:

· Temperature = 0.001 [K]
· Pressure = 101000 [Pa]

In this exercise the Substance is water (it is downloaded from the standard Substance database).
· Open the context menu of the folder Substances and, applying the Create command, create Substance

#0.
· From the context menu of Substance #0 apply the command Load from SD > Standard and download

the substance Water in its liquid phase. Substance #0 will change its name to Water_Liquid and its child
elements (Molar mass, Density, Viscosity, Thermal conductivity, ...) will receive their values from the
Substance database.

In the folder Phases:
· Create a continuous Phase #0.
· In Phase #0 add the substance Water_Liquid to the subfolder Phase #0 > Substances.
· In properties of the folder Phase #0 > Physical processes specify:

Heat transfer = Heat transfer via h
Motion = Navier-Stokes model
Turbulence = KES

In the folder Models:
· Create Model #0.
· Add Phase #0 into subfolder Model #0 > Phases.
· Specify initial temperature and pressure:

o in properties of the element Models > Model #0 > Init. data > Init. data #0 > Temperature(Phase

#0) specify Value = 394 [K]
o in properties of the element Models > Model #0 > Init. data > Init. data #0 > Pressure(Phase #0)

specify Value = 69000000 [Pa]

In properties of the element Subregions > Box #0 - mesh specify Model = Model #0.
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6.5.3.3 Creating the computational domain

The computational domain will be created within an inverted Moving body.

In the Preprocessor tab, from the context menu of the folder Objects, select the Create command.

The Create new object dialog box will open. Specify there Object type = Imported object and click OK.

Then select the file ClosedSurf.mesh that contains geometry of Imported object, which will be created.

The program will create Imported object #0.

In the folder Subregions > Box #0 - mesh > Modifiers create a Moving body modifier, specifying in the
Create new modifier dialog box:

· Modifier type = Moving body
· Objects = Imported object #0

The program will create Moving body #0.

From the context menu of Moving body #0 select the Turn inside out command.
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6.5.3.4 Boundary conditions

When inverted geometry is used, the computational domain is created within a Moving body.

Specify the boundary conditions:

Boundary 1 (outer wall)

Name = Outer wall

Type = Wall

Variables

Temperature (Phase #0) = Zero gradient

Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Color =  Aqua

Boundary 2 (inner wall)

Name = Inner wall

Type = Wall

Variables

Temperature (Phase #0) = External conjugate

Velocity (Phase #0) = Logarithm law

TurbEnergy (Phase #0) = Value in cell near wall

TurbDissipation (Phase #0) = Value in cell near wall

Color =  Gray

Boundary 3 (inlet)

Name = Inlet

Type = Inlet/Outlet
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Variables

Temperature (Phase #0) = Temperature

Value = 394 [K]

Velocity (Phase #0) = Total pressure

Value = 69000000 [Pa]

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Color =  Red

Boundary 4 (outlet)

Name = Outlet

Type = Inlet/Outlet

Variables

Temperature (Phase #0) = Temperature

Value = 394 [K]

Velocity (Phase #0) = Total pressure

Value = 68000000 [Pa]

TurbEnergy (Phase #0) = Pulsations

Value = 0

TurbDissipation (Phase #0) = Turbulent scale

Value = 0 [m]

Color =  Blue

6.5.3.5 Parameters of co-simulation

Joint computations of APM and FlowVision use the Abaqus Direct Coupling connector. This connector allows
the software to transfer data directly from one program to another and it is convenient for use.

· From context menu of the folder External Connections select the command Create.

· In the Create new object dialog box, which opens, select Object type = Abaqus Direct Coupling.

· A dialog box for selection an inp file will open. Select there the saved before file APMFV.inp.

· In the Editing .inp file dialog box select the checkboxes CF, CFL, COORD, and NT.

· A child element Abaqus Direct Coupling will appear in the folder External Connections. The element
Abaqus Direct Coupling, in its turn, also has a child element, ASSEMBLY_DC-SURF0.

· In properties of the folder External Connections specify:
Exchange step > Method = FlowVision
Exchange step > Default time step = 0.005
Exchange step > Coef. for time step = 1
Old offset = Yes

· In properties of the element Abaqus Direct Coupling specify:
Activation = Yes
ABAQUS > Run ABAQUS = No
ABAQUS > IP Source = User
ABAQUS > Address = network name or IP-address of the computer, on which APM Structure3D will

run
ABAQUS > Port = 30945
ABAQUS > Timeout [s] = 100
Loads relaxation > Scale factor = 1
Loads relaxation > Start in steps = 0
Loads relaxation > End in steps = 100



510FlowVision Help

 

Loads relaxation > Initial coefficient = 0
Loads relaxation > Final coefficient = 1
Heat relaxation > Scale factor = 1
Heat relaxation > Start in steps = 0
Heat relaxation > End in steps = 0
Heat relaxation > Initial coefficient = 1
Heat relaxation > Final coefficient = 1

· In properties of the element ASSEMBLY_DC-SURF0 specify:
Name > DC-SURF0
Moving body = Moving body #0
Mapping > Enabled = Yes
Mapping > Surface = Initial
Mapping > Rebuild mapper = Yes

Do not change other settings.

The mapping is used to map the mesh from the CFD surface to the FEA mesh. See details about this in the
FlowVision's "User's guide" document (section Mapping).

6.5.3.6 Inspection of the transferred data

You have to check that all data are transferred.

The imported and exported data are shown in properties of the element ASSEMBLY_DC-SURF0 in fields Send
data and Receive data.

FlowVision exports concentrated force (CF) and heat flux (CFL), and imports coordinates (COORD) and
temperature from nodes (NT).
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6.5.3.7 Computational grid

Initial grid

Set uniform initial computational grid. In properties of the element Computational grid > Initial grid specify:
nX=80
nY=96
nZ=32

Adaptation of the initial grid

You have to specify refining of the computational grid near deformable walls. Follow these steps:
· From the context menu of the folder Computational grid > Adaptation select the Create command and

create the element Adaptation #0.
· In properties of the element Adaptation #0 specify:

Max level N = 1
Split/Merge = Split
Layers > Layers for Level N = 4

The subregion Box #0 - mesh will be automatically set as the Subregion, in which the adaptation will be
active.

As an Object for the adaptation you have to select the boundary condition Inner wall (from the context menu
of the folder Computational grid > Adaptation > Adaptation #0 > Objects select the command
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Add/Remove Boundary Conditions and in the dialog box, which opens, select the boundary condition Inner
wall).

6.5.3.8 Parameters of calculation in FlowVision

Specify parameters of calculation of FlowVision in the Solver tab.

To provide stable solution and convergence, CFL numbers and limiter on the maximal time step are specified by
tables.

In the Solver tab, in properties of the element Time step, specify:

Method = Via CFL number

Convective CFL Specify it by a table that contains dependency on the Current time step (see
below)

Surface CFL = 1

Diffusive CFL Specify it by a table that contains dependency on the Current time step (see
below)

Max step Specify it by a table that contains dependency on the Current time step (see
below)

Dependency of Convective CFL on the Current time step

x f(x)

0 1

20 1

50 100

70 100

100 500

120 500

150 2000

170 2000

200 5000

220 5000

250 7500

270 7500

300 10000

320 10000

400 12000

If you wish, you can import this table from the text file ConvCFL.txt that is included in files of this exercise.

Dependency of Diffusive CFL on the Current time step

x f(x)

0 1

20 1

50 10

70 10

100 50

120 50

150 200

170 200

200 500

220 500

250 750

270 750

300 1000

320 1000

400 1200
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If you wish, you can import this table from the text file DiffCFL.txt that is included in files of this exercise.

Dependency of Max step on the Current time step

x f(x)

0 0.001

50 0.001

100 1

200 1

250 5

350 5

400 10

If you wish, you can import this table from the text file MaxStep.txt that is included in files of this exercise.

Set the limitation 50000 [W/m2] on the maximal energy flow transferred to the FEA program.

In the Solver tab, in properties of the element Advanced settings specify:

Computation of loads

    Energy flux max. = 50000 [W/m2]

6.5.3.9 Visualization

Specifying the visualization in FlowVision is described below in sections:
· Velocity distribution on a plane
· Pressure distribution on a plane
· Temperature distribution on the moving body
· Integral heat flux over the exchange surface

You can view the prepared visualization layers and plot in the Monitor window after starting the computation.

6.5.3.9.1  Velocity distribution on a plane

· In properties of Plane #0 specify:

Object

Reference point

X = 0

Y = 0

Z = 0

Normal
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X = 0

Y = 0

Z = 1

· Create a layer Vectors #0 on Plane #0.

· In properties of the layer Vectors #0 specify*):

On regular grid = No

Coloring

Variable

Variable = Velocity

Value range

Mode = Manual

Max = 50

Min = 0

*) The program automatically specifies the variable that is used to build vectors (as if you set Variable >
Variable = Velocity).

6.5.3.9.2  Pressure distribution on a plane

· Create a Color contours layer on Plane #0.

· In properties of the created layer Color contours #0 specify:

Variable

Variable = Pressure

Value range

Mode = Manual

Max = 69000000

Min = 68000000
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6.5.3.9.3  Temperature distribution on the moving body

· Create a Color contours layer on the Imported object #0.

· In properties of the created layer Color contours #1 specify:

Name = Temperature

Variable

Variable = Temperature

Value range

Mode = Manual

Max = 394

Min = 374
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6.5.3.9.4  Integral heat flux over the exchange surface

Convergence criterion for this problem is integral heat flux that is calculated on the exchange surface. When the
heat flux becomes constant, we can consider that the steady-state is obtained. This value will not be zero
because heat transfer from the part's wall to the environment is set, so FlowVision will show constant negative
value of the heat flux.

We can display this criterion in the Monitor window as a plot of the time dependance.

Follow these steps:
· On the boundary condition Inner wall create a Supergroup in Preprocessor.
· In the folder Characteristics in Preprocessor create Characteristics on the Supergroup on the Inner

wall.
· In properties of the just created element Characteristic #0 (Supergroup on "Inner wall") specify

Variable > Variable = HeatFlux.
· Open the Solver tab.
· From the context menu of the folder Stopping conditions > User values select the command Create and

create Stop criterion #0.
· In properties of the just created Stop criterion #0 specify:

o Name = <Heat Flux>

o Object = Characteristics #0 (Supergroup on "Inner wall")

o Variable = <f surf.>

6.5.4 Starting the joint computation

It doesn't matter, in which order the two programs will be started.

In APM Structure3D to control the joint computation use the Exchange Log block in the Calculation Server
dialog box of the APM Structure3D program. Here you can see all information about the current status of the
computation.

In FlowVision use windows Log and Monitor in Pre-Postprocessor.
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Starting the computation from FlowVision

In FlowVision starting the computation is done from Pre-Postprocessor, see description of the standard start in
the section "Detailed description of a simplest model > Laminar flow in a tube > Starting the computation".

You can stop the computation by clicking the  (Stop computation) button and resume it after changing the
project if required.

Starting the computation from APM Structure3D

In APM Structure3D select Tools > Analysis server > Analysis server TCP/IP. The Calculation Server
dialog box will open:

Specify the following settings:
· In the block Analysis specify, which computations will be done in APM Structure3D in the joint

computation. Specify here:
o Strength = Static

o Thermal = Transient

· In the block Server parameter you have to examine the value of the parameter Port. This value is to be
the same as the port number that is set in FlowVision in properties of the element "External Connections >
Abaqus Direct Coupling". By default Port=30945.

Parameters of linear and geometrically non-linear computations, steady-state and transient heat transfer
can be set in the Calculation > Calculation Options Panel menu.

You can find information about the calculation parameters in the user's manual of APM Structure3D.

Start or stop of the data exchange between the programs is done by clicking buttons Start or Stop in the
Calculation Server dialog box, in the Launch block:

Viewing results in FlowVision
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In Pre-Postprocessor watch the prepared before visualization layers and the plot:
· Velocity distribution on a plane
· Pressure distribution on a plane
· Temperature distribution on the moving body
· Integral heat flux over the exchange surface

Viewing results in APM Structure3D

When the computation is finished, select the command Result Map from the menu Results. In the Results
Options dialog box, which opens, select the required maps for the type of computation, in which you are
interested in:
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6.6 Optimization of an airfoil's orientation

In this example we we consider optimization of orientation of the NACA0012 profile.

The goal of the optimization (optimization criterion) is maximal lift force acting on the profile.

The adjustable parameter (the optimization parameter) is the angle between the profile and the flow direction
(angle of attack).

Parameters of the problem setting

Dimensions:

Length of the airfoil chord c = 0.256 [m]

Dimensions of the computational
domain

5.3 × 5 × 0.00254 [m × m × m]

Substance: Air

Inlet parameters:

Static pressure: P = 100000 [Pa]

Static temperature: T = 298 [K]

Velocity on inlet V
inl

= 103.83 [m s-1]

Mach number M = 0.3

Reynolds number Re = 1.68x 106

Geometry: NACA0012_opt.wrl

Project: NACA0012_opt

6.6.1 Preparing the project in FlowVision

6.6.1.1 Physical model

In the Properties window of the element General settings specify:

Reference values

Temperature = 298 [K]

Pressure = 100000 [Pa]

In the folder Substances:

· Create Substance #0.

· Load Substance #0 from the Standard substance database:
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o From the context menu of Substance #0 select Load from SD > Standard.

o In the new window Load from database, select:

Substances = Air

Phases = Gas (equilibrium)

In the folder Phases:

· Create a continuous Phase #0.

· Add the Air_Gas (equilibrium) substance into the folder Phase #0 > Substances.

· Specify in properties of the folder Physical processes:

Motion = Navier-Stokes model

Heat transfer = Heat transfer via H

Turbulence = KES *)

*) This means the Standard k-ε turbulence model.

In the folder Models:

· Create Model #0.

· Add Phase #0 into subfolder Model #0 > Phases.

· In the folder Init. data #0, specify:

Velocity

X = 103.83 [m s-1]

Y = 0 [m s-1]

Z = 0 [m s-1]

6.6.1.2 Moving bodies

In the Properties window of SubRegion #0, specify:

Model = Model #0

Create a Moving body:
· Download the geometry of the moving body from the file NACA0012_opt_Airfoil.wrl.

· In the folder SubRegion #0 > Modifiers create a Moving body modifier on Imported object #0.

· In the Properties window of the just created Moving body, specify:

Initial position

Rotation definition = Euler angles (Aviation)
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6.6.1.3 Boundary conditions

Specify the following boundary conditions:

Boundary 1

Type = Wall

Variables

Temperature(Phase #0) = Zero gradient

Velocity​​(Phase #0) = Logarithm law

TurbEnergy(Phase #0) = Value in cell near wall

TurbDissipation(Phase #0) = Value in cell near wall
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Boundary 2

Type = Symmetry

Variables

Temperature(Phase #0) = Symmetry

Velocity​​(Phase #0) = Slip

TurbEnergy(Phase #0) = Symmetry 

TurbDissipation(Phase #0) = Symmetry

Boundary 3

Type = Non-reflecting

Variables

Temperature(Phase #0) = Non-reflect.

Value = 0 [K]

Velocity​​(Phase #0) = Non-reflect.

Velocity at inf.

X = 103.83 [m s-1]

Y

Z

Pressure at inf. = 0 [Pa]

TurbEnergy(Phase #0) = Pulsations 

Value = 0

TurbDissipation(Phase #0) =Turbulent scale

Value = 0

6.6.1.4 Initial grid

In the Properties window of the Initial grid, click the button  to open the Initial grid editor.

Specify in the Initial grid editor:

for axis OX

Grid parameters

h_max = 0.634 [m]

h_min = 0.005 [m]

Insert a reference line with coordinate x=0 [m].

Specify Reference line parameters for the reference line with coordinate x=-2.54:

h =0.634 [m]

Specify Reference line parameters for the reference line with coordinate x=0:

h = 0.005 [m]

kh- = 1.001

kh+ = 0.95
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Specify Reference line parameters for the reference line with coordinate x=2.794:

h =0.634 [m]

for axis OY (click the button )

Grid parameters

h_max = 0.634 [m]

h_min = 0.005 [m]

Insert a reference line with coordinate y=0 [m].

Specify Reference line parameters for the reference line with coordinate y=-2.54:

h =0.634 [m]

Specify Reference line parameters for the reference line with coordinate y=0:

h = 0.005 [m]

kh- = 1

kh+ = 1

Specify Reference line parameters for the reference line with coordinate y=2.54:

h =0.634 [m]

Click OK to close the Initial grid editor with saving the entered data.

Specify in properties of the Initial grid:

Grid structure = 2D

Plane = XY

In the Properties window of the Initial grid click Apply.

The main purpose of this example is to show the possibility of optimizing the airfoil’s position of the profile by
value of lift force. You may achieve a detailed solution by using a fine computation mesh. This example is
simplified to increase speed of calculations. Therefore, the obtained results are not final for NACA0012 airfoil.
The statement of task requires finer computational mesh and decreasing the time step.

6.6.1.5 Parameters of calculation

Specify in the Solver tab:

· In the Properties window of the element Time step, specify:

Method = Via CFL number

Convective CFL = 50

Max step = 1 [s]

· In the Properties window of the element Stopping conditions > Time span, specify:

Start at = 0 [s]

Stop at = 0.05 [s]

6.6.1.6 Optimization parameters

In this simulation, the optimization parameter is the angle between the profile and the stream. In order to make
it changeable in IOSO, you have to define it as an external parameter.

In order to make the pitch angle external parameter.

To define the attack angle as external parameter, do the following:

· From the context menu of the parameter Initial position > Pitch angle (which locates in the Properties
window of Moving body #0) select  Add to exposed parameters table:
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· The Parameter identification window will open, enter Pitch angle there:

· After this you can disable updates of the Moving body. In the Properties window of the Moving body,
specify:

Update

Type = Disabled

6.6.1.7 Optimization criterion

In this problem, the optimization criterion is the lift force. Also, as additional information it is advisable to
display the drag component force of the profile. To make these values be readable by IOSO, it is necessary to
make them output parameters.

In the Preprocessor tab:

· Create Characteristics on Imported object #0.

· In the Properties window of Characteristics #0, specify:

Variable

Variable = Pressure

In the Solver tab:

· From the context menu of the folder Stopping conditions > User values, select Create.

· In the Properties window of the new just created Stop criterion #0, specify:

Name = Fx

Object = Characteristics #0 (Imported object #0)

Variable = F fluid

Component = X

· From the context menu of the folder Stopping conditions > User values, select Create.

· In the Properties window of the new just created Stop criterion #0, specify:

Name = Fy
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Object = Characteristics #0 (Imported object #0)

Variable = F fluid

Component = Y

In the Exposed parameters window, select the Generate result table checkbox:

6.6.2 Setting up connection to IOSO

· Do not close the project, which has been created in FlowVision, and from the Additions menu select
Optimization with IOSO:

· Log on Solver-Agent:

· Specify the parameters of running the IOSO's project and FlowVision's solver:

Optimization Select the version of IOSO, on which the computation will be done.

Timeout Specify the maximal calculation time of one FlowVision's project.

Solver Specify the startup mode of the FlowVision's solver.
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The header of this dialog box contains the name and parameters of the used Configuration for
connection to Solver-Agent.

· Click OK. After this the FlowVision's project will automatically close and the IOSO's project will open.

6.6.3 Preparing the project in IOSO

6.6.3.1 Optimization parameters

In the created project there is an already defined FlowVision's mathematical model with input and output files. It

is only required to set up the parameters and criteria for the optimization and their bounds.

Specify the optimization parameter and its limits of variations in IOSO:

· Switch to the Task Setting mode:

· In the Input Parameters tab, select Pitch angle and specify Type =Independent:

· Specify:

Lower bound = -90

Upper bound = 0

· Click Ok.
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6.6.3.2 Optimization criteria

In IOSO, on the Output parameters tab, the parameters are displayed, which will be available for reading from
FlowVision after the computation is finished:

FlowVision calculates the forces acting on the flow by the profile; these forces are equal in magnitude and
opposite in sign to the forces acting on the profile by the flow. In order to use the coefficient of the lift force
(acting on the profile by the flow) as an optimization criterion, it is necessary to add a synthetic parameter and
make it the optimization criterion:

· In the Synthetic Parameters tab, click .

· Specify the formula for the new parameter as -RS2/16.17 and click OK*).

· Specify:

Objective = Maximize

Name = Cy

In this task, it is also advisable to display, as additional information, the drag coefficient and the aerodynamic
efficiency ratio, which the ratio of lift force to drag force. To do this, you should create more synthetic
parameters:

· Click .

· Specify the formula for the new parameter as -RS1/16.17 and click OK*).

· Specify this parameter's name as Cx.

· Click .

· Specify the formula for the new parameter as RS2/RS1 and click OK*).

· Specify this parameter's name as k.

Note:

*) When you specify a synthetic parameter that depends on the output parameters, in the formula for the
calculation, as the variables corresponding to the output parameters, their IDs are used, which are displayed on
the Output Parameters tab.
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6.6.3.3 Setting up computations

· Switch to the Project Setting mode:

· In the tree of the IOSO's project, from the context menu of the item FlowVision Model, select Properties:

· In the IOSO NM. Mathematical model window, which opens, set the following tunings:

o select Run for each call from the Type of launch drop-down list (this replaces the initial default

option Run for the first call only)
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6.6.3.4 Running the optimization

· Switch to the Status mode:

· To start the optimization, click the button:

· After this, an the time when the of the FlowVision's projects were started for the computation and elapsed
time of these computations will be indicated:

· Optimization can be stopped by clicking the button:
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It is recommended to stop the optimization when the optimization results do not change much.

6.6.3.5 Viewung results

When about 10 computations are done, viewing the results will be available. To display the results of the
computation, switch to the Results mode and open the Search History tab.

In this tab, the results of all FlowVision's computations are displayed:

To display a plot with results of the optimization, do the following:
· At the bottom of the table, select Type of displaying as Table+Plot (click the appropriate button):

· Above the plot, which appears, click the Plot button ( ).
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· Specify:

X Axis = Pitch angle

Y Axis = Cy

· In the settings of displaying the result select Filtered only:

· In the IOSO window, a plot of the dependency of Cy on the pitch angle (the angle of attack) will be displayed:
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